
 
 

 
 
 
 
Administering MSP 3.3.1 



 
 

 

 



 
 

 
 
 
 
 
 
 
 
 
 
 

Administering MSP 3.3.1 

72E-128775-02 

Revision M 

September 2010 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 
 

 
 
 
 
© 2010 by Motorola, Inc. All rights reserved. 

No part of this publication may be reproduced or used in any form, or by any electrical or 
mechanical means, without permission in writing from Motorola.  This includes electronic or 
mechanical means, such as photocopying, recording, or information storage and retrieval 
systems.  The material in this manual is subject to change without notice. 

While every reasonable precaution has been taken in the preparation of this document, neither 
Symbol Technologies, Inc., nor Motorola, Inc., assumes responsibility for errors or omissions, or 
for damages resulting from the use of the information contained herein. 

The software is provided strictly on an “as is” basis. All software, including firmware, furnished to 
the user is on a licensed basis. Motorola grants to the user a non-transferable and non-exclusive 
license to use each software or firmware program delivered hereunder (licensed program). 
Except as noted below, such license may not be assigned, sublicensed, or otherwise transferred 
by the user without prior written consent of Motorola. No right to copy a licensed program in 
whole or in part is granted, except as permitted under copyright law. The user shall not modify, 
merge, or incorporate any form or portion of a licensed program with other program material, 
create a derivative work from a licensed program, or use a licensed program in a network without 
written permission from Motorola. The user agrees to maintain Motorola’s copyright notice on the 
licensed programs delivered hereunder, and to include the same on any authorized copies it 
makes, in whole or in part. The user agrees not to decompile, disassemble, decode, or reverse 
engineer any licensed program delivered to the user or any portion thereof. 

Motorola reserves the right to make changes to any software or product to improve reliability, 
function, or design. 

Motorola does not assume any product liability arising out of, or in connection with, the 
application or use of any product, circuit, or application described herein. 

No license is granted, either expressly or by implication, estoppel, or otherwise under any 
Motorola, Inc., intellectual property rights. An implied license only exists for equipment, circuits, 
and subsystems contained in Motorola products. 

MOTOROLA and the Stylized M Logo and Symbol and the Symbol logo are registered in the US 
Patent & Trademark Office. All other product or service names are the property of their respective 
owners. 

Motorola, Inc 
One Motorola Plaza 
Holtsville, New York 11742-1300 
http:/motorola.com/enterprisemobility 

 

 



Administering MSP 3.3.1 -- v 
 

 
 

 

 

 

Table of Contents 

About This Guide ................................................................................................1 
Related Documents ......................................................................................................................... 1 
Help ................................................................................................................................................. 1 
Service Information.......................................................................................................................... 1 

Chapter 1 – Understanding MSP .......................................................................3 
What is MSP?.................................................................................................................................. 3 

MSP System Components ..................................................................................................................... 3 
MSP Server.............................................................................................................................. 3 

The MSP Web Application............................................................................................ 4 
The MSP Services ........................................................................................................ 4 

The MSP Database.................................................................................................................. 4 
Microsoft SQL Server............................................................................................................... 5 
Relay Servers........................................................................................................................... 5 
MSP Client Software ................................................................................................................ 5 
Proxies ..................................................................................................................................... 5 
Packages ................................................................................................................................. 5 
MSP Console UI....................................................................................................................... 6 
Web Browser............................................................................................................................ 6 

Architecture for Scheduled Management ........................................................................................ 6 

Chapter 2 –Your Enterprise Requirements.......................................................7 
Your Enterprise Requirements ........................................................................................................ 7 
Your MSP Edition ............................................................................................................................ 7 

MSP Stage Edition ................................................................................................................................. 7 
MSP Provision Edition............................................................................................................................ 8 
MSP Control Edition ............................................................................................................................... 8 

Your Enterprise Locations ............................................................................................................... 8 
Server Locations .................................................................................................................................... 8 

MSP System ............................................................................................................................ 9 
A Single Centralized MSP System................................................................................ 9 



vi -- Administering MSP 3.3.1 
 

Multiple Disjoint MSP Systems ..................................................................................... 9 
SQL Server(s) .......................................................................................................................... 9 
Relay Server(s) .......................................................................................................................10 

Single Central Relay Server ........................................................................................10 
Multiple Central Relay Servers ....................................................................................10 
Locally-Distributed Relay Server..................................................................................11 
Regionally-Distributed Relay Servers ..........................................................................11 

Device Locations ...................................................................................................................................11 
Devices used at a Fixed Central Location ...................................................................11 
Devices used at a Fixed Remote Location ..................................................................11 

Devices at a variety of Fixed Locations...................................................................................12 
Devices used at no Fixed Location .........................................................................................12 

Personnel Locations..............................................................................................................................12 
From any Enterprise Facility ...................................................................................................12 
From Outside the Enterprise ...................................................................................................12 
From a Device Usage Location...............................................................................................13 

Your Enterprise Personnel ............................................................................................................ 13 
IT Administrators ...................................................................................................................................13 
MSP System Administrators..................................................................................................................13 
MSP Console UI Users..........................................................................................................................13 
Device Users .........................................................................................................................................14 

Your Enterprise Network ............................................................................................................... 14 
Your Wired Network(s) ..........................................................................................................................14 

Security ...................................................................................................................................14 
Bandwidth ...............................................................................................................................14 
Routing....................................................................................................................................15 

Your Wireless Network(s)......................................................................................................................15 
Security ...................................................................................................................................15 
Bandwidth ...............................................................................................................................15 
Routing....................................................................................................................................16 

Chapter 3 – MSP and Your Enterprise ............................................................17 
MSP Edition Installation Considerations ....................................................................................... 17 

All MSP Editions....................................................................................................................................17 
VMWare Considerations .........................................................................................................17 
Virtual Disk Properties.............................................................................................................17 
Virtual Memory and CPU Properties .......................................................................................18 
Site Considerations .................................................................................................................18 
Connectivity Considerations....................................................................................................18 
Relay Server Considerations ..................................................................................................18 
Browser Considerations ..........................................................................................................18 

MSP Stage Edition ................................................................................................................................18 
Server Considerations.............................................................................................................18 
SQL Server Considerations ....................................................................................................19 

MSP Provision Edition...........................................................................................................................19 
Server Considerations.............................................................................................................19 
SQL Server Considerations ....................................................................................................19 

MSP Control Edition ..............................................................................................................................19 
Server Considerations.............................................................................................................19 
SQL Server Considerations ....................................................................................................20 

Planning MSP for Your Enterprise................................................................................................. 20 
Scalability ..............................................................................................................................................20 

MSP Scalability Defined..........................................................................................................20 
Key MSP Scalability Factors ...................................................................................................21 
MSP Scalability Numbers........................................................................................................21 
Published MSP Scalability Numbers .......................................................................................22 
Deploying MSP to Meet the Scale of an Enterprise ................................................................24 

Use a More Capable Server ........................................................................................24 

 



Table of Contents  vii 
 

Avoid or Restrict the Use of Long Term Analysis ........................................................25 
Off-load Work from the MSP Server ............................................................................25 
Network Topology and Connectivity ............................................................................25 

Network Naming/Addressing and Accessibility......................................................................................26 
How Names or Addresses Connect MSP Components ..........................................................27 

User Access to MSP Console UI .................................................................................27 
MSP Server Access to Relay Server ...........................................................................27 
Device Access to Relay Server ...................................................................................27 
MSP Console UI to Device ..........................................................................................27 

Chapter 4 – MSP Security ................................................................................29 
Introduction .................................................................................................................................... 29 

Types of Security...................................................................................................................................29 
Physical Security.....................................................................................................................29 
Network Security .....................................................................................................................30 

MSP and Security..................................................................................................................................30 
Enterprise Network Security .......................................................................................................... 30 

Security Concerns .................................................................................................................................30 
Advertised Interfaces ..............................................................................................................30 
Interconnection Interfaces.......................................................................................................31 

Mitigation Techniques ...........................................................................................................................32 
Best Practices .......................................................................................................................................32 

MSP Server Security ..................................................................................................................... 33 
Security Concerns .................................................................................................................................33 

Advertised Interfaces ..............................................................................................................33 
Interconnection Interfaces.......................................................................................................34 

Interfaces and Ports.....................................................................................................35 
Distribution Options .....................................................................................................36 

Mitigation Techniques ...........................................................................................................................37 
Configuring MSP Console UI Access for HTTPS....................................................................37 

Obtaining a Certificate for the MSP Server..................................................................37 
Installing a Certificate into Microsoft IIS.......................................................................37 
Disabling Access to the MSP Console UI via HTTP ....................................................39 
Redirecting HTTP Access to HTTPS...........................................................................41 

Configuring MSP Console UI to use Non-Standard Ports .......................................................43 
Scanning and Hardening Windows Server..............................................................................44 

Best Practices .......................................................................................................................................44 
SQL Server Security...................................................................................................................... 45 

Security Concerns .................................................................................................................................45 
Integrated vs. External SQL Server.........................................................................................45 
Security Implications of an External SQL Server.....................................................................45 

Mitigation Techniques ...........................................................................................................................46 
Physical Isolation ....................................................................................................................46 
Logical Isolation ......................................................................................................................46 
Virtual Isolation........................................................................................................................47 

Best Practices .......................................................................................................................................47 
Relay Server Security.................................................................................................................... 48 

Security Concerns .................................................................................................................................48 
Integrated vs. External Relay Server.......................................................................................48 
Security Implications of an External Relay Server...................................................................48 

Mitigation Techniques ...........................................................................................................................50 
Use FTPS ...............................................................................................................................50 

Details of the FTPS Protocol .......................................................................................50 
Configuring a Relay Server to use FTPS.....................................................................51 
Troubleshooting the Use of FTPS................................................................................51 

Use Non-Standard Ports .........................................................................................................53 
Logical Isolation ......................................................................................................................53 
Virtual Isolation........................................................................................................................53 

 



viii -- Administering MSP 3.3.1 
 

Best Practices .......................................................................................................................................53 
MSP Console UI User Security ..................................................................................................... 54 

Security Concerns .................................................................................................................................54 
Variable User Locations ..........................................................................................................55 
Unconstrained Access ............................................................................................................55 

Mitigation Techniques ...........................................................................................................................55 
Define User Roles and User Scopes.......................................................................................55 

Best Practices .......................................................................................................................................55 
Device Security.............................................................................................................................. 56 

Security Concerns .................................................................................................................................56 
Device is a Constraint on the Wireless Network......................................................................57 
Device is a Gateway into the Enterprise Network ...................................................................57 
Device is a Source of Enterprise Data ....................................................................................57 
Device is a Valuable Asset......................................................................................................57 

Mitigation Techniques ...........................................................................................................................57 
Update Devices with Latest Firmware and Software...............................................................57 
Apply Appropriate Security Options to Devices.......................................................................58 
Control Access to Devices ......................................................................................................58 
Discourage Theft of Devices ...................................................................................................59 
Detect and Handling Missing Devices.....................................................................................60 
Protect Data Stored on Devices..............................................................................................60 

Chapter 5 – MSP and AAA ...............................................................................63 
What is AAA?................................................................................................................................. 63 

What is Authentication?.........................................................................................................................63 
What is Authorization? ..........................................................................................................................63 
What is Accounting?..............................................................................................................................64 

AAA in MSP................................................................................................................................... 64 
MSP Authentication...............................................................................................................................64 

Pre-defined MSP Users ..........................................................................................................64 
MSP Authentication Sources ..................................................................................................64 

MSP Authentication Database.....................................................................................65 
Lightweight Directory Access Protocol (LDAP)............................................................65 

MSP Authorization.................................................................................................................................68 
User Role ................................................................................................................................69 
User Access Prefixes ..............................................................................................................69 

MSP Accounting....................................................................................................................................69 
Viewing the Audit Log .............................................................................................................69 

Globally........................................................................................................................69 
By User........................................................................................................................69 
By Object .....................................................................................................................69 

Chapter 6 – MSP Security Objects ..................................................................71 
What are Security Objects?........................................................................................................... 71 
Authentication Source Objects ...................................................................................................... 72 
User Role Objects ......................................................................................................................... 72 

Pre-defined User Roles .........................................................................................................................72 
Security User Role ..................................................................................................................72 
Administrator User Role ..........................................................................................................73 
Operations User Role..............................................................................................................73 
Provisioning User Role............................................................................................................73 
Staging User Role ...................................................................................................................73 
Help Desk User Role...............................................................................................................74 
Guest User Role......................................................................................................................74 

Custom User Roles ...............................................................................................................................74 
User Objects .................................................................................................................................. 74 

 



Table of Contents  ix 
 

Chapter 7 – MSP Administrative Objects........................................................75 
What are Administrative Objects? ................................................................................................. 75 
Relay Server Objects..................................................................................................................... 76 
Network Settings Objects .............................................................................................................. 77 

Network.WLAN.FusionPublic ................................................................................................................77 
Network.WLAN.Fusion30Public ............................................................................................................77 
Network.WLAN.Legacy .........................................................................................................................78 
Network.WLAN.ZeroConfig ...................................................................................................................79 
Network.WWAN.GPRS .........................................................................................................................79 

Site Objects (Optional) .................................................................................................................. 79 
SMS Carrier Objects...................................................................................................................... 81 
Definition Document Objects ......................................................................................................... 81 
License Key Objects...................................................................................................................... 82 
Relationship Definition Objects...................................................................................................... 82 

Chapter 8 – Relay Server Administration .......................................................83 
Managing Relay Servers ............................................................................................................... 83 

Why Manage Relay Servers?................................................................................................................83 
MSP and Relay Servers ........................................................................................................................84 
MSP Responsibilities.............................................................................................................................84 

Folder Structure and Staging Content.....................................................................................84 
Provisioning and Action Content .............................................................................................85 
Package Removal ...................................................................................................................85 
Relay Server Optimization ......................................................................................................85 

Package Files as Sentinels..........................................................................................86 
Missing Package Detection .........................................................................................86 
Possible Reasons for Missing Packages .....................................................................86 
Unnecessary Package Detection.................................................................................87 
Possible Reasons for Unnecessary Packages ............................................................87 
Master Client of Relay Server ......................................................................................88 

Non-MSP Responsibilities .....................................................................................................................88 
Proactive Prevention ...............................................................................................................88 
Backup and Restore................................................................................................................88 

Relay Server Redundancy.....................................................................................................................88 
MSP and Certificates for FTPS ..................................................................................................... 90 

MSP Server vs. Device Access to an FTPS Server ..............................................................................90 
Configuring the MSP Server to Establish Trust of a Server Certificate..................................................90 
Configuring Devices to Establish Trust of a Server Certificate ..............................................................91 

FTP Server Reference................................................................................................................... 92 
FileZilla ..................................................................................................................................................92 

Configuring FileZilla as an MSP Relay Server ........................................................................92 
Using FileZilla with the FTPS Protocol ....................................................................................93 

Generating a Self-Signed Certificate ...........................................................................94 
Converting the Self-Signed Certificate for MSP and Device Use.................................96 
Configuring the MSP Server to Establish Trust of a Converted Certificate ..................97 

MSP Server vs. Device Access to an FTPS Server ................................Error! Bookmark not defined. 
Configuring Devices to use a Converted FileZilla Certificate .......................................97 

Microsoft IIS in Windows Server 2003...................................................................................................98 
Setting up the FTP Server in Microsoft IIS ..............................................................................98 
Configuring Microsoft IIS as an MSP Relay Server.................................................................98 

Microsoft IIS 7 in Windows Server 2008................................................................................................98 
FTP 7 or FTP 7.5 in IIS 7 in Window Server 2008.................................................................................99 
Microsoft IIS 7.5 in Windows Server 2008 R2 .......................................................................................99 
Creating and Configuring an FTP Site Manually ...................................................................................99 
Motorola WS-2000 Wireless Switch ....................................................................................................102 

Using a WS-2000 as an MSP Relay Server..........................................................................102 
Other FTP Servers ..............................................................................................................................103 

 



x -- Administering MSP 3.3.1 
 

Chapter 9 – Device Attribute Administration................................................105 
Manually Creating Device Attributes ........................................................................................... 105 
Editing Device Attributes ............................................................................................................. 108 
Clearing Device Attribute Values................................................................................................. 108 
Deleting Device Attributes ........................................................................................................... 109 

Chapter 10 – Object Administration ..............................................................111 
Exporting and Importing Objects ................................................................................................. 111 

Why Export Objects?...........................................................................................................................111 
How to Export Objects.........................................................................................................................112 
Creating MSP Objects in Bulk .............................................................................................................112 
How to Import Objects .........................................................................................................................114 
Export/Import and Object References .................................................................................................114 
Object Types that cannot be Exported/Imported .................................................................................114 

Bookmark Objects.................................................................................................................115 
Definition Document Objects.................................................................................................115 
Devices .................................................................................................................................116 
Device Attributes ...................................................................................................................117 
Device Attribute Values.........................................................................................................118 
File Set Objects.....................................................................................................................118 
License Key Objects .............................................................................................................119 
Package Objects ...................................................................................................................120 
SMS Staging Jobs.................................................................................................................121 
Staging Batch Objects...........................................................................................................122 

Object Types that can be Exported/Imported ......................................................................................123 
Action Objects .......................................................................................................................123 
Authentication Source Objects ..............................................................................................123 
Bundle Objects......................................................................................................................123 
Collection Category Object ...................................................................................................124 
Collection Metric Objects ......................................................................................................124 
Collection Request Objects...................................................................................................124 
Condition Objects..................................................................................................................125 
Custom/Global Views............................................................................................................125 
Device Saved Filter Objects..................................................................................................125 
Message Set Objects ............................................................................................................125 
Provisioning Policy Object.....................................................................................................125 
Relationship Definition Objects .............................................................................................126 
Relay Server Objects ............................................................................................................126 
Settings Objects and Settings Family Objects ......................................................................126 
Site Objects...........................................................................................................................126 
SMS Carrier Objects .............................................................................................................127 
SMS Device Objects .............................................................................................................127 
Staging Profile Objects..........................................................................................................127 
User Objects .........................................................................................................................127 
User Role Objects .................................................................................................................127 
Widgets Configuration...........................................................................................................128 

Chapter 11 – The MSP Administration Program ..........................................129 
Introduction .................................................................................................................................. 129 
Operational Context and Accounts.............................................................................................. 129 

Windows Server User Account............................................................................................................129 
The MSP_SERVICE_ACCOUNT ........................................................................................................129 
Launching the MSP Administration Program.......................................................................................130 
MSP Administration Program Authentication.......................................................................................130 
Transfer Subfolders.............................................................................................................................131 

Interface Overview....................................................................................................................... 132 

 



Table of Contents  xi 
 

Menu Bar Options ...............................................................................................................................132 
Services View Functionality......................................................................................................... 132 

Service Icon Meanings ........................................................................................................................132 
Start/Stop All Services.........................................................................................................................133 
Stop/Start Individual Services..............................................................................................................133 
Service Information and Service Logging............................................................................................133 

Service Information ...............................................................................................................133 
Service Logging ....................................................................................................................133 

Configuration View Functionality ................................................................................................. 133 
Retention Settings ...............................................................................................................................134 

Database Record Retention..................................................................................................134 
Relay Server File Retention ..................................................................................................135 

Analysis and Troubleshooting Settings ...............................................................................................135 
Cubing Settings.....................................................................................................................135 

Enable/Disable Complete Data Option ......................................................................136 
Set the Interval Mode of Data Collection ...................................................................136 

Metric Data – Adding a New Metric Column .........................................................................137 
MSP Services Configuration Settings..................................................................................................137 

Thread Count ........................................................................................................................138 
Polling Only? .........................................................................................................................138 
Wake-up Interval ...................................................................................................................139 

Network Connections Settings ............................................................................................................139 
Relay Server Connections Settings.......................................................................................139 
SMS Connections Settings ...................................................................................................139 

Features ..............................................................................................................................................139 
Reporting ..............................................................................................................................139 
Analysis.................................................................................................................................140 
Authentication .......................................................................................................................140 
Audit......................................................................................................................................140 
Dynamic Content...................................................................................................................141 
GPS Data..............................................................................................................................141 

Web Settings .......................................................................................................................................141 
Device Filter Options.............................................................................................................141 
Change MSP Web Server IP Address ..................................................................................142 

Utilities.................................................................................................................................................142 
Import XML ...........................................................................................................................142 
Import CSV ...........................................................................................................................142 
Import Add-On.......................................................................................................................142 
Export XML ...........................................................................................................................143 
Export Diagnostic ..................................................................................................................143 

Chapter 12 – MSP Server Troubleshooting ..................................................145 
Performance Monitoring .............................................................................................................. 145 
Using the Windows Event Log..................................................................................................... 145 
Using Staging Logs from MSP Console UI ................................................................................. 146 
Using Staging Logs on Devices................................................................................................... 146 

Chapter 13 – MSP Server Maintenance.........................................................147 
Backing up the MSP Database.................................................................................................... 147 

Introduction..........................................................................................................................................147 
Using Microsoft SQL Server Management Studio to Back Up the MSP Database..............................147 

Performing a Manual or Unscheduled Backup......................................................................147 
Create a Database Backup Script .........................................................................................148 
Test the Backup Script ..........................................................................................................148 
Schedule the Backup with Windows Task Scheduler............................................................148 
Restoring a Database Backup...............................................................................................149 
Test the Database Backup and the Database Restore .........................................................149 

 



xii -- Administering MSP 3.3.1 
 

 

Chapter 14 – MSP Add-On Kits......................................................................151 
What is an MSP Add-On Kit? ...................................................................................................... 151 
What MSP Add-On Kits are included with MSP?........................................................................ 151 
How to Import an MSP Add-On Kit.............................................................................................. 151 

Chapter 15 – Asset Reporting........................................................................153 
What is Asset Reporting? ............................................................................................................ 153 
MSP Asset Reporting Tables ...................................................................................................... 153 

Limitations ...........................................................................................................................................153 
Schemas .............................................................................................................................................154 

Device Table Schemas .........................................................................................................154 
tDeviceAssetsReport .................................................................................................154 
tFacts.........................................................................................................................155 
tComplianceMatrix .....................................................................................................155 

Device Look-up Table Schemas ...........................................................................................156 
bDcm .........................................................................................................................156 
sComplianceStatus....................................................................................................156 
sComplianceSubStatus .............................................................................................156 

Configuration and Setup.............................................................................................................. 157 
Enabling and Disabling Asset Reporting .............................................................................................157 
Creating an SQL Login for Asset Reporting ........................................................................................157 

Performing Asset Reporting ........................................................................................................ 159 
Using Microsoft Excel™ 2003 .............................................................................................................160 
Using Microsoft SQL Server 2008 Report Builder 2.0 .........................................................................160 
Using Crystal Report Writer™ 2008 ....................................................................................................163 

 
 



Administering MSP 3.3.1 -- 1 
 

 
 

 

About This Guide 

This document provides information on Administering MSP and Using the MSP 3.3.1 
Administration Program.  Newer versions of this document may be available for download at: 

http://support.symbol.com/support/product/softwaredownloads.do. 

Related Documents 
 MSP 3.3.1 Release Notes, p/n 72E-100160 

 Understanding Mobility Services Platform 3.3.1, p/n 72E-128712 

 Using Mobility Services Platform 3.3.1, p/n 72E-128802 

 MSP 3.3.1 Software Installation Guide, p/n 72E-100159 

 MSP Client Software Guide, p/n 72E-128805 

Help 
You can access page-specific help in the MSP Administration Program by clicking Help on the 
Menu bar. 

Note: 

Some configurations may require a second click of the Help link in the Menu bar. This is due to 
some minor conflicts caused by a Microsoft Security update. 

Service Information 
If you have a problem with your software, contact Motorola Enterprise Mobility support for your 
region. Contact information is available at: http://www.symbol.com/contactsupport.  

When contacting Enterprise Mobility support, please have the following information available: 

 Serial number of the software 

http://support.symbol.com/support/product/softwaredownloads.do
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 Model number or product name 

 Software type and version number 

 Software license information 

Motorola responds to calls by email, telephone or fax within the time limits set forth in support 
agreements.   

If you purchased your Enterprise Mobility business product from a Motorola business partner, 
contact that business partner for support. 
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Chapter 1 – Understanding MSP 

What is MSP? 
The Motorola Mobility Services Platform (MSP) is a scalable software solution that provides a 
single point of control for managing large numbers of devices within your Enterprise. 

MSP System Components 
An MSP System is made up of a set of components that all work together to implement a scalable 
software solution.  An MSP System is typically comprised of some or all of the following: 

MSP Server 
The MSP Server consists of a collection of Motorola-supplied software components that must be 
installed on one or more customer-supplied Servers running supported Microsoft Server 
Operating System(s). 

For Information on the installation requirements and installation process for the MSP Server, see 
the MSP 3.3.1 Install Guide. 

The software components that make up the MSP Server are described in the following 
subsections. 
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The MSP Web Application 

The MSP Console UI is implemented by the MSP Web Application which is registered with the 
Internet Information Services (IIS) subsystem of the Windows Server Operating System.  This 
occurs when the MSP Web Application is installed on a Server.  The MSP Web Application is 
often installed on the same Server as the MSP Services, but this is not required.  In some cases, 
it might be desirable to install the MSP Web Application on a separate Server to improve the 
performance and responsiveness of an MSP System, especially when a very large number of 
devices will be managed. 

The MSP Services 

The MSP Services are a collection of Windows services that are installed and registered with the 
Windows Server Operating System.  The MSP Services perform the tasks necessary to manage 
devices, based on requests issued from the MSP Console UI.  The MSP Services are often 
installed on the same Server as the MSP Web Application. MSP Services can be administered 
from the MSP Administration Program interface. 

Logging into the MSP Administration Program 
 

1. On the MSP Server, click the MSP Admin shortcut in the Start Menu. 

2. On the Administration Program Login dialog box, type your user name and password. 

3. Click Sign-in. 

Important: 

For specific information on how to use the Administration Program interface, access 
page-specific help once you login by clicking Help on the Menu bar. 

 

The MSP Database 
The MSP Console UI and the MSP Services communicate via the MSP Database.  All information 
about the current configuration and state of an MSP System is stored in the MSP Database.  All 
information about managed devices is stored in the MSP Database. 

Important: 

The MSP Database is intended for use only by the MSP Services and the MSP Web Application.  
Consequently, the MSP Database schema is not published (is generally changes with every 
release of MSP) and no information about or support for accessing data in the MSP Database will 
be provided. 

Direct modification to the MSP Database is unsupported.  Any direct modifications made to the 
MSP Database could cause failures or undesired operation of the MSP Console UI and/or the 
MSP Web Application.  Any such modification will void all warranties and support contracts 
related to MSP. 

The only exception is the use of the optional MSP Asset Reporting Tables.  The schema for 
these tables is published and these tables can safely be used to provide read-only access to 
selected information as described in Chapter 15 – Asset Reporting. 
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Microsoft SQL Server 
The MSP requires the support of a supported version of Microsoft SQL Server to host the MSP 
Database. 

For more information on the requirements for and installation of Microsoft SQL Server, see the 
MSP 3.3.1 Install Guide. 

Relay Servers 
MSP relies on intermediate servers, called Relay Servers, to serve as interconnection points 
between the MSP Server and managed devices.  At least one Relay Server must be installed 
somewhere within the Enterprise in order for MSP to be used to manage devices.  Depending on 
the organization of the network used in an Enterprise and the number and locations of devices to 
be managed, additional Relay Servers might also be required. 

Important: 

No FTP Server software is included with MSP, although FTP Server software is generally part of 
all Windows Operating Systems, as part of Windows Internet Information Services (IIS).  FTP 
Server software can also obtained from a variety of sources and installed on a variety of 
hardware within an Enterprise. 

For more information on Relay Servers, see Chapter 8 – Relay Server Administration. 

The MSP Server and managed devices can communicate with Relay Servers using either the 
FTP protocol or the secure FTP over TLS (FTPS) protocol.  Any computer can function as a 
Relay Server so long as it properly supports these protocols. 

For more information on Relay Server Protocols, see Chapter 4 – MSP Security. 

MSP Client Software 
The MSP Client Software is a set of software components that run locally on a managed device 
to implement the management interface between that managed device and the MSP Server.  
There can be many varieties of MSP Client Software to meet the needs of the various types of 
devices that need to be Directly Managed by MSP. 

For information on the MSP Client Software, refer to the MSP Client Software Guide. 

Proxies 
A Proxy is a software component that acts on behalf of otherwise unmanageable devices to allow 
them to be managed by MSP.  A device that is managed by MSP via a Proxy is called an 
Indirectly Managed device. 

For more information on Proxies, see Understanding MSP 3.3.1 – Understanding Device Classes 
and Proxies.  For information on a specific Proxy, refer to the document that accompanies that 
Proxy. 

Packages 
Packages are the basic unit of Content in MSP.  Simple Packages can be created within the MSP 
Console UI, while more complex Packages require the use of the stand-alone MSP Package 
Builder Program. 
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For more information on Packages, see Understanding MSP 3.3.1 – Understanding Objects. 

MSP Console UI 
The MSP Console UI is the interface used to control the management of devices by an MSP 
Server and to administer an MSP Server.  The MSP Console UI is implemented by the MSP Web 
Application. 

Web Browser 
Motorola has tested and formally supports accessing all functions of the MSP Console UI using 
Microsoft Internet Explorer™ versions 6, 7, and 8, Google Chrome™, or Mozilla Firefox™ version 
3.  Beginning with MSP 3.3.1, support for Microsoft Internet Explorer™ version 6 is officially 
deprecated, it is still supported and may be used, but certain limitations may exist, as 
documented in the MSP 3.3.1 Release Notes. 

Important: 

Because it has been officially deprecated, support for Internet Explorer version 6 may be 
discontinued and no longer supported in any future MSP release.  It is therefore highly 
recommended that customers migrate to a newer version of Internet Explorer, or another 
supported Web Browser, as soon as it is practical to do so. 

Prior to MSP 3.3.1, MSP supported accessing all functions of the MSP Console UI using 
supported versions of Microsoft Internet Explorer™ and supported accessing all functions except 
On-Demand Staging using other Web Browsers.  This was because the On-Demand Staging 
Server was implemented using Microsoft ActiveX technology, which was problematic to support in 
non-Microsoft Web Browsers. 

Beginning with MSP 3.3.1, the On-Demand Staging Server is implemented using Java 
technology.  As a result, MSP can support accessing all accessing functions of the MSP Console 
UI, including On-Demand Staging, using all supported Web Browsers, so long as a suitable Java 
Runtime Environment (JRE) is installed. 

Important: 

The On-Demand Staging Server functionality requires Sun Java Runtime Environment (JRE) 
version 1.6 Update 13 or higher. 

Architecture for Scheduled Management 
MSP is primarily designed to provide a robust, scalable Scheduled Management Solution.  
Scheduled Management, also referred to as Strategic Management focuses on efficiently 
managing hundreds of thousands of devices from a single central server while controlling the 
impact on an Enterprise network.  To accomplish this, the design of MSP is optimized to perform 
in a scheduled manner through the use of a Three-Tier Distribution Model, as described in 
Understanding MSP – Understanding MSP. 
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Chapter 2 –Your Enterprise 
Requirements 

Your Enterprise Requirements 
To get the most from MSP, it is important to assess and understand the requirements you have 
for device management within your Enterprise.  This chapter is intended to help identify and 
understand your Enterprise Requirements, establish realistic expectations for how MSP will fulfill 
those requirements within your Enterprise, and determine the most effective way to install and 
configure MSP within your Enterprise. 

Your MSP Edition 
MSP is available in three editions: MSP Stage Edition, MSP Provision Edition, and MSP Control 
Edition.  MSP Provision Edition also includes all the functionality of MSP Stage Edition.  MSP 
Control Edition includes all the functionality of MSP Provision Edition. 

Choosing the proper MSP Edition to use within an Enterprise requires a careful assessment of 
the capabilities of each MSP Edition and their ability to satisfy your Enterprise Requirements.  
The following subsections discuss each MSP Edition and the most common reasons why it would 
be selected. 

MSP Stage Edition 
MSP Stage Edition provides initial deployment and re-deployment of content to devices.  When 
using MSP Stage Edition, all deployment and re-deployment operations must be manually 
initiated from each device. 
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MSP Stage Edition would most commonly be selected if manual deployment of devices is 
considered to be sufficient.  MSP Stage Edition would generally not be suitable if there is a need 
for remote deployment or remote management of devices. 

Note: 

MSP Stage Edition can be upgraded to MSP Provision Edition or MSP Control Edition through 
the installation of an appropriate MSP License Key. 

MSP Provision Edition 
MSP Provision Edition expands upon MSP Stage Edition by providing remote deployment, limited 
Asset Management, and Remote Control and Remote Troubleshooting of individual devices. 

MSP Provision Edition would most commonly be selected when remote deployment of devices is 
considered critical and/or when the ability to remotely manage individual devices is considered 
important.  MSP Provision Edition would generally not be suitable if there is a strong need for a 
comprehensive remote device management solution. 

Note: 

MSP Provision Edition can be upgraded to MSP Control Edition through the installation of an 
appropriate MSP License Key. 

MSP Control Edition 
MSP Control Edition expands upon MSP Provision Edition by providing enhanced Asset 
Management, Actions, Data Collection, Long Term Analysis, and Short Term Troubleshooting. 

MSP Control Edition would most commonly be selected when there is a strong need for a 
comprehensive remote device management solution. 

Note: 

To utilize 100% of the functionality of MSP Control Edition, Microsoft SQL Server 2008 
(Enterprise or Standard Edition) with SQL Server Analysis Services (SSAS) must be installed.  
For more information on the requirements and installation process for MSP, see the MSP 3.3.1 
Software Installation Guide. 

Your Enterprise Locations 
The number and variety of locations within your Enterprise are an important aspect of your 
Enterprise Requirements that will frequently have a significant impact on the nature of the MSP 
Solution that will be required to meet those requirements.  This section details some of the 
location within your Enterprise that may require special consideration. 

Server Locations 
The components of every MSP System will included one or more servers that must be installed, 
configured, and maintained to ensure the reliability, availability, and scalability of your MSP 
System.  In some cases, all the various server components might be located in a single location, 
such as a Data Center or Network Operations Center.  In other cases, these server components 
may be distributed into a variety of locations throughout the Enterprise.  The following 
subsections list some of the locations where servers might be located and the reasons why. 
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MSP System 

A Single Centralized MSP System 

In the majority of cases, a single centralized MSP System is commissioned to manage all the 
devices throughout an Enterprise.  This is most appropriate when there is a need for visibility and 
control of all the devices throughout the Enterprise from a centralized location and when the total 
number of devices to be managed is within the scalability limits of a single MSP System.  In such 
cases, one or more servers that collectively implement the MSP Server would typically be located 
in a centralized data center or network operations center. 

Multiple Disjoint MSP Systems 

In some cases, multiple MSP Systems may be commissioned to manage the devices within an 
Enterprise.  This is most appropriate when visibility and control of all devices throughout the 
Enterprise from a centralized location is not required or not desired.  Whenever it is necessary or 
desirable to have total separation of domains within an Enterprise, then a single MSP System per 
domain may be the most appropriate solution.  Some examples could be: 

 Privacy Requirements 

An Enterprise might have different privacy requirements across different domains.  For 
example, a domain might need to protect trade secrets or intellectual property from disclosure 
to other domains. 

 Legal or Financial Separation 

An Enterprise might have a need to separate domains for legal or financial reasons.  For 
example, a domain might need to account for assets or license fees separately from other 
domains. 

 Security or Safety 

An Enterprise might have a need to enforce security or safety regulations across domains.  
For example, a domain that performs mission critical operations might need to be immunized 
against accidental impact by another domain. 

SQL Server(s) 
Each MSP System requires an instance of SQL Server to host its MSP Database.  The location of 
the SQL Server on which the MSP Database for a given MSP System is hosted may for some or 
all of the following reasons. 

 Simplicity 

When an Enterprise is installing SQL Server solely for the purpose of hosting the MSP 
Database, installing SQL Server on the same physical hardware as the MSP Server may 
result in a system that is simpler to installed and easier to manage.  In a small-scale 
Enterprise, there may not be a dedicated IT support staff and the task of managing SQL 
Server may fall to the MSP System Administrators.  In such cases, having everything co-
located may be seen as an advantage. 
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 Cost-Effectiveness 

When an Enterprise is already using SQL Server to support tasks other than MSP, it may be 
more cost effective to use an existing installation of SQL Server than to install a new version 
of SQL Server just for the MSP Server.  In particular, if the Microsoft SQL Server Processor 
License Model is being used, then hosting the MSP Database might be accomplished without 
the need for any additional SQL Server licensing.  Or, if additional licensing is required, it may 
be available under a most cost-effective volume license discount. 

 Performance and Scalability 

When an Enterprise is already using SQL Server to support tasks other than MSP, then a 
high performance and highly scalable may already be in place.  Such a solution might be 
based on a single large server, with room for growth and explanation, or might be based on a 
“server farm” that can be scaled at need.  Leveraging such an existing solution could provide 
superior performance and scalability over a dedicated SQL Server just for MSP. 

 Reliability and Availability 

When an Enterprise is already using SQL Server to support tasks other than MSP, then a 
SQL Server solution that provides high reliability and availability may already be in place.  
Such a solution might be based on automated backup and restore, redundancy and failover, 
etc.  Leveraging such an existing solution could provide superior reliability and availability 
over a dedicated SQL Server just for MSP. 

Relay Server(s) 
The purpose of a Relay Server in an MSP System is to act as an intermediary between an MSP 
Server and a set of managed devices in a location or a set of locations.  Every MSP System 
requires at least one Relay Server, but may have many Relay Servers, distributed throughout an 
Enterprise, to better serve the needs of that Enterprise.  The following subsections describe some 
common scenarios that might drive the need for a variety of different numbers of Relay Servers 
distributed in a variety of ways.  In some Enterprises, a combination of more than one method 
might also make sense. 

Single Central Relay Server 

In a small MSP System, it may frequently be acceptable and desirable to have a single central 
Relay Server to manage all devices.  Such a solution is typically most suitable when the total 
number of managed devices is relatively small (e.g. 5,000 or less).  In addition, such a solution is 
generally viable only when there is good connectivity from the locations where managed devices 
are used to the central Relay Server.  If bandwidth, cost, or reliability issues are serious concerns, 
then such an approach may not be appropriate, 

Multiple Central Relay Servers 

In some cases the connectivity available from the locations where managed devices are used to 
a central facility, such as a Network Operations Center or Data Center might be considered 
adequate to permit a centralized approach.  But if the total number of devices to be managed by 
the MSP System exceeds the practical capacity of a single Relay Server, then multiple Relay 
Servers might be co-located at that same central facility.  For example, all Relay Servers might be 
in a common server rack. 
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Locally-Distributed Relay Server 

In some cases, connectivity from managed devices to a central facility might be poor or might be 
considered a resource that must be tightly controlled.  In such cases, it may be preferable to 
distribute Relay Servers out to the locations where the managed devices are used.  Such a 
solution can be especially appropriate when there are a number of devices at each location that 
could access a local Relay Server over a local network, such as a WLAN.  The MSP Server, 
located at a central facility, would need to access the remote Relay Servers, but such traffic could 
be more easily controlled and could leverage the fact that common content for multiple devices 
can be sent once and shared by all devices at a common location. 

Regionally-Distributed Relay Servers 

In some cases, distribution of Relay Servers might be required, but it may not make sense to 
distribute Relay Servers all the way to the locations where managed devices are used.  This 
might be the case when the number of devices at each such location is small and the cost of a 
Relay Server at each such location would be prohibitive.  Instead, it might make sense to locate a 
smaller number of Relay Servers at some location between the central facility and the locations 
where managed devices are used and allow multiple locations to share the Relay Server at their 
closest “region”. 

Device Locations 
The number and types of locations at which managed devices will be used will tend to vary with 
the Enterprise.  In some cases, a single Enterprise might have multiple different types of locations 
and/or might have devices that could be located at different types of locations at different times.  
The following subsections describe some of the types of locations at which managed devices 
might be used within an Enterprise and the potential implications to an MSP System that is 
required to manage devices at such locations. 

Devices used at a Fixed Central Location 

In some cases, there may be some devices that are used at locations that are in near proximity to 
the central facility where the MSP Server is located.  For example, devices might be used to 
perform tasks in the Network Operations Center or might be used in a Lab that is adjacent to the 
Network Operations Center. 

Due to their proximity to the central facility, such devices might be configured to access a Relay 
Server located at that central facility that would not be appropriate for use by devices in more 
remote locations.  Such devices might be configured to check-in frequently, collect a lot of data, 
etc. 

Devices used at a Fixed Remote Location 

In many cases, many devices may be located at remote locations, far from the central facility 
where the MSP Server is located.  Such devices may utilize local or regional Relay Servers or 
might have to communicate all the way back to a Relay Server located at the central facility. 

Depending on the decisions made about the number and locations of Relay Servers, and the 
available connectivity, devices may various different configurations to optimize them to perform 
suitably.  Some devices might be configured to check-in fairly frequently and collect a lot of data, 
whereas other devices might need to be configured in a more constrained manner. 
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Devices at a variety of Fixed Locations 
In some cases, there may be devices that roam amongst a variety of fixed locations.  For 
example, a device might be a “floater” that is sent from location to location based on demand.  Or, 
a device might be in the possession of a Device User that has a flexible schedule and works at a 
variety of locations, as needed. 

Depending on the nature of the locations at which a device might be used, it might be important 
to detect the location at which a device is being used and automatically reconfigure it as needed 
to perform appropriately for that location. 

Devices used at no Fixed Location 
In some cases, there may be devices that roam freely within the Enterprise and may or may not 
ever be used at any fixed location.  This might well be the case for devices that were WWAN 
enabled and assigned to mobile Device Users who have no fixed work location.  Such devices 
might sometimes be used at fixed locations, but might also be used at locations that are 
unknowable.  When used at fixed locations, it might or might not be desirable to leverage 
knowledge about those locations, such as to use the higher performed WLAN at a fixed location 
in preference to the lower performance WWAN. 

Depending on the nature of the locations at which a device might be used, it might be important 
to detect the location at which a device is being used and automatically reconfigure it as needed 
to perform appropriately for that location.  Or, it might be preferable to ignore such incidental co-
location and treat the device as permanently mobile. 

Personnel Locations 
The number and types of locations at which personnel within the Enterprise may be located may 
also implications for an MSP System that is required to be used by some or all of those personnel 
to manage devices within the Enterprise.  The following subsections describe some of the types 
of locations from which Enterprise personnel might interact with an MSP System and the 
implications such usage might have on that MSP System.  In some cases, a single person might 
perform multiple tasks and/or perform a single task from a variety of locations within the 
Enterprise at different times. 

From any Enterprise Facility 
Enterprise personnel might directly interact with an MSP System from the Network Operations 
Center, from a support center help desk, from a branch office, or from a factory floor.  In short 
Enterprise personnel might directly interact with an MSP System from any Enterprise facility 
where a Workstation PC might be located such that it could reach the MSP System. 

From Outside the Enterprise 
Enterprise personnel might sometimes need to travel and hence may need to interact with MSP 
from wherever they may find themselves.  This might be accomplished via remote access to the 
Enterprise network (e.g. dial-up, VPN, etc.) or might be accomplished via direct interaction with 
the MSP System (e.g. internet-based login to the MSP Console UI). 

 



Chapter 2 –Your Enterprise Requirements -- 13 
 

From a Device Usage Location 
Enterprise personnel might indirectly interact with MSP via any device that is managed by MSP.  
This could happen from any location within the Enterprise where a managed device might be 
used. 

Your Enterprise Personnel 
The number and variety of personnel within your Enterprise that may interact with the MSP 
System, directly or indirectly, is an important aspect of your Enterprise Requirements that will 
frequently have a significant impact on the nature of the MSP Solution that will be required to 
meet those requirements.  This section details some of the types of personnel that may require 
special consideration.  In some cases, a single person might perform multiple tasks hence fail into 
more than one of these categories. 

IT Administrators 
IT Administrators are typically those Enterprise personnel that install, configure, and maintain the 
information technology (IT) infrastructure and services of the Enterprise.  Such personnel 
generally are privy to sensitive information and have privileged access to systems to allow them 
to perform their assigned tasks.  For example, such personnel often physically maintain 
hardware, install and configure software, perform backups and restores, manage security 
policies, etc. 

The services of a knowledgeable IT Administrator with Super-Administrator privileges will be 
required during the installation of MSP.  The IT Administrator would also ideally interact with MSP 
System Administrators thereafter to ensure that Enterprise IT Policies and the needs of the MSP 
System are being met, both initially, and over the lifetime of the system. 

MSP System Administrators 
MSP System Administrators are typically those Enterprise personnel that install, configure, and 
maintain the MSP Server itself, including the definition of Security and Administrative Objects that 
define the connection points between that MSP Server and the IT infrastructure and between the 
MSP Server and the MSP Console Users. 

MSP System Administrators typically interact with IT Administrators to ensure that the MSP 
System is complying with Enterprise IT Policies.  MSP System Administrators typically interact 
with MSP Console UI Users to ensure that their needs are being met. 

MSP Console UI Users 
MSP Console UI Users are those Enterprise personnel that utilize an MSP System, via the MSP 
Console UI, to perform management of devices within the Enterprise. 

MSP Console UI Users may need to interact with MSP System Administrators to acquire the 
information they need to perform their assigned tasks and to request help in the event that issues 
arise with their use of MSP.  MSP Console UI Users may interact with Device Users.  This is 
especially true for the special class of MSP Console UI Users known as Help Desk Users, who 
specialize in using MSP to provide support directly to Device Users. 
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Device Users 
Device Users are those Enterprise personnel that utilize devices that are managed by MSP.  
Such personnel may or may not be aware of MSP or that the device they are using is managed 
by MSP. 

Your Enterprise Network 
The nature of your Enterprise network and the potential limitations and or demands it may make 
upon the MSP System is an important aspect of your Enterprise Requirements that will frequently 
have a significant impact on the nature of the MSP Solution that will be required to meet those 
requirements. 

Your Wired Network(s) 
A wired network is typically the backbone of an Enterprise network.  The capabilities of a wired 
network and the policies defined for it will generally have a significant impact on an MSP System 
that must operate within that Enterprise network.  Some of the key aspects of a wired network 
that may impact an MSP System are described in the following subsections. 

Security 
Security is an important concern in every Enterprise network since the Enterprise information 
stored within and accessed via the Enterprise network is only as secure as the network.  Most 
Enterprises define Enterprise Security Policies that apply to any server that will operate within the 
Enterprise network.  All servers that comprise components of the MSP System will likely have to 
comply with a variety of security requirements that are mandated by the Enterprise Security 
Policies. 

The following are some of many possible security requirements related to wired networks that 
may need to be met as a mandate of various Enterprise Security Policies: 

 Approved Server Hardware, Operating Systems, and Protocols 

 Scanning for Vulnerabilities and Applying Remediation 

 Anti-Virus and Malware Protection 

 Password Strength and Rotation 

 Remote Access Controls 

It is important to identify and understand any Enterprise Policies related to Enterprise network 
security that apply to an MSP System and to create a plan for how the MSP System will achieve 
its goals while operating within any necessary constraints. 

Bandwidth 
Bandwidth is often an important concern in an Enterprise network since it is typically a limited and 
valuable resource.  Many different conflicting demands will likely be made upon the available 
bandwidth of on Enterprise network and not may b deemed of equal importance.  Enterprise 
Policies may be defined to establish rules for Enterprise network bandwidth usage and those 
rules may be enforced by Quality of Service (QoS) controls. 
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It is important to identify and understand any Enterprise Policies related to Enterprise wired 
network bandwidth usage that apply to an MSP System and to create a plan for how the MSP 
System will achieve its goals while operating within any necessary constraints. 

Routing 
Routing is often an important concern in an Enterprise wired network since it is can severely limit 
the placement of system components due to constraints placed on the protocols used to 
interconnect them.  Two common types of routing issues are created by Firewalls and Network 
Address Translation.  Firewalls are generally installed to enforce aspects of Enterprise Security 
Policy by restricting the types of traffic that can pass across selected routes.  Network Address 
Translation may be installed to enforce aspects of Enterprise Security Policy and/or to overcome 
network limitations, such as address space limitations, especially on IPv4 networks. 

It is important to identify and understand any Routing issues related to wired networks that may 
constrain the operation of an MSP System and to create a plan for how the MSP System will 
achieve its goals while operating within those constraints. 

Your Wireless Network(s) 
A wireless network is typically the extension of a wired network to provide access from locations 
where connecting a wire is impractical.  While any type of entity that could reside on a wired 
network might also reside on a wireless network, the most important of these, from the point of 
view of an MSP System are wireless devices that need to be managed by MSP.  The capabilities 
of a wireless network and the policies defined for it will generally have a significant impact on an 
MSP System that will be called upon to manage devices on that wireless network.  Some of the 
key aspects of a wired network that may impact an MSP System are described in the following 
subsections. 

Security 
Security is generally even more important in a wireless network than in a wired network since a 
wireless network is inherently less physically secure.  While access to a wired network can, to at 
least some degree, be controlled by limiting access to physical connections, access to a wireless 
network is much harder to secure physically.  It is therefore typically of paramount importance to 
define and carefully follow Enterprise Security Policies related to wireless networks. 

The following are some of many possible security requirements related to wireless networks that 
may need to be met as a mandate of various Enterprise Security Policies: 

 Approved Authentication and Encryption Standards 

 Passphrase Strength and Rotation 

 Certificate Rotations 

It is important to identify and understand any Enterprise Policies related to Enterprise wireless 
network security that apply to an MSP System and to create a plan for how the MSP System will 
achieve its goals while operating within any necessary constraints.  In addition, it is important to 
understand the role MSP may need to play in helping to implement and enforce Enterprise 
Policies related to Enterprise wireless network security for devices managed by MSP. 

Bandwidth 
Bandwidth is often even more important in a wireless network than in a wired network since a 
wireless network may have significantly less total available bandwidth. 
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It is important to identify and understand any Enterprise Policies related to Enterprise wireless 
network bandwidth usage that apply to an MSP System and to create a plan for how the MSP 
System will achieve its goals while operating within any necessary constraints.  In particular, it is 
important to establish the degree to which device management will be allowed to impact wireless 
network bandwidth and to create a plan for how the MSP System will achieve its goals while 
operating within any necessary constraints. 

Routing 
Routing can often be more limiting in an Enterprise wireless network since wireless network 
infrastructure is often intentionally constrained to improve security. 

It is important to identify and understand any Routing issues related to wireless networks that 
may constrain the operation of an MSP System and to create a plan for how the MSP System will 
achieve its goals while operating within those constraints. 
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Chapter 3 – MSP and Your Enterprise 

MSP Edition Installation Considerations 

All MSP Editions 

VMWare Considerations 
MSP is supported for use in a VMWare environment.  VMWare can be installed and run on any 
“host” Operating System (the one on which VMWare itself is running) that is supported by 
VMWare.  But the “guest” Operating System (the one running inside the virtual machine and on 
which MSP is directly installed) must be a supported Microsoft Operating Systems as described 
in the MSP 3.3.1 Install Guide. 

MSP is designed and tested to correctly function on a correctly-installed, fully-functional, 
supported Microsoft Operating System.  Impairments to the correct functioning of the Operating 
System, the physical or virtual Server, or any supporting components (e.g. SQL Server, Relay 
Servers, etc.) could cause impaired functioning of MSP and would not be considered a supported 
environment.  Such impairments might arise from the use of virtualization, damaged operating 
system components, or any interference with normal operation caused by virtual machine activity 
such as “pauses”, impaired startup of services from an abnormal shutdown or startup, inter-
system communications delays, etc. 

Virtual Disk Properties 
The virtual disk(s) on which the OS is installed should be created with the following properties: 

The .vmdk file should be configured as thick provisioned (using either “zeroedthick” or 
“eagerzeroedthick”). 

The virtual disk(s) on which SQL Server is installed should be created with the following 
properties: 

VMware: The .vmdk file should be configured as thick provisioned (using only 
“eagerzeroedthick”). 
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Virtual Memory and CPU Properties 
The memory and CPU resources for all virtual machines hosting MSP and/or SQL should be 
configured with the following properties: 

 Reserve at least the minimum amount of RAM required for your desired MSP 
configuration (see the MSP Install Guide). This reservation should be assigned to the 
MSP virtual machine exclusively. Carefully monitor available host memory shares and 
avoid over-commit of RAM resources.  

 Reserve at least the minimum number of CPUs required for your desired MSP 
configuration (see the MSP Install Guide). Carefully monitor available host processor 
shares and avoid over-commit of CPU resources. 

Site Considerations 
In MSP, the use of Sites is optional; but the use of Sites can often greatly improve manageability 
when devices are used at multiple locations within the Enterprise.  Sites allow you to configure 
and manage devices based on the locations within the Enterprise where they are used.  Using 
Sites, you can also limit access to devices by different Users of the MSP Console UI based on 
the Sites where those devices are being used. 

Connectivity Considerations 
MSP requires TCP/IP-based network connectivity between the MSP Server, Relay Servers, and 
devices within the Enterprise.  Possible types of connectivity to devices include Wireless LAN, 
Wireless WAN, wired Ethernet, Ethernet Cradle, and Microsoft ActiveSync™. 

Relay Server Considerations 
At least one Relay Server is required to use MSP.  A Relay Server might be run on the same 
physical hardware as the MSP Server Software, in some cases.  In others cases, one or possible 
many Relay Servers might be located centrally or might be distributed throughout an Enterprise. 

Browser Considerations 
A Web Browser is required to access the MSP Console UI.  A Web Browser can be run on the 
MSP Server, if desired, or can be run on any Workstation PC running a supported Web Browser, 
as described in MSP Console (above). 

MSP Stage Edition 

Server Considerations 
The Server requirements to run MSP Stage Edition are relatively lightweight. Stage Edition could 
be installed on a very low-end Server or even a desktop PC, so long as the PC is running one of 
the supported Operating Systems listed in the MSP 3.3.1 Install Guide. 
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SQL Server Considerations 
Since an MSP Stage Edition installation may be used only occasionally, its hardware 
requirements may be quite light.  As a result, the license-free Microsoft SQL Server Express 
Edition may be adequate in some cases to support installations of MSP Stage Edition.  It should 
be understood that since Microsoft SQL Server Express Edition is free, it comes with no warranty 
or support from Microsoft.  Further, Microsoft SQL Server Express Edition has significant limits on 
database size. 

Note: 

In many MSP Stage Edition installations, Microsoft SQL Server can reasonably be installed on 
the same Server as the MSP Server Software, although it could also be installed on a separate 
Server if desired. 

MSP Provision Edition 

Server Considerations 
The requirements to run MSP Provision Edition are more extensive than those for Stage Edition.  
Provision Edition generally requires at least a modest dedicated Server to provide a robust, 
reliable, and continuously available Provisioning solution.  The MSP Server Software must be 
installed on a customer-supplied Server running a supported Microsoft Operating System as 
described in the MSP 3.3.1 Install Guide. 

SQL Server Considerations 
Motorola generally does not recommend the use of Microsoft SQL Server Express Edition for 
most installations of MSP Provision Edition.  The Microsoft SQL Server Standard and Enterprise 
Editions are fully supported products that must be purchased from and licensed from Microsoft.  
Since they are fully supported products, they are suitable for use in a solution where the database 
is used “around the clock” and where reliability, availability, and scalability (RAS) are of key 
concern.  For more information on installation requirements, refer to the MSP 3.3.1 Install Guide. 

Note: 

In some MSP Provision Edition Installations, it may be advisable to install Microsoft SQL Server 
Standard and Enterprise Edition on a separate physical Server from the Server on which the MSP 
Server Software is installed.  This depends on the capacity of the chosen Server and the 
scalability and performance requirements for the MSP System.  For more information on 
installation requirements, refer to the MSP 3.3.1 Install Guide. 

MSP Control Edition 

Server Considerations 
If any Data Collection Solution is used, then the requirements to run MSP Control Edition are 
more intensive than those for Provision Edition.  If Long Term Analysis functionality will be used, 
then the requirements to run MSP Control Edition are even more intensive. 

 



20 -- Administering MSP 3.3.1 
 

Note: 

For more information on Data Collection Solutions, see Understanding MSP 3.3.1 – 
Understanding Data Collection Solutions and MSP. 

SQL Server Considerations 
Motorola never recommends the use of Microsoft SQL Server Express Edition for installations of 
MSP Control Edition.  The Microsoft SQL Server Standard and Enterprise Editions are fully 
supported products that must be purchased from and licensed from Microsoft.  Since they are 
fully supported products, they are suitable for use in a solution where the database is used 
“around the clock” and where reliability, availability, and scalability (RAS) are of key concern.  For 
more information on installation requirements, refer to the MSP 3.3.1 Install Guide. 

Note: 

In many MSP Control Edition Installations, it may be advisable to install Microsoft SQL Server 
Standard and Enterprise Edition on a separate physical Server from the Server on which the MSP 
Server Software is installed.  This depends on the capacity of the chosen Server and the 
scalability and performance requirements for the MSP System.  For more information on 
installation requirements, refer to the MSP 3.3.1 Install Guide. 

Important: 

If you intend to use Long Term Analysis functionality, then you must use Microsoft SQL Server 
Standard or Enterprise Edition.  Further, SQL Server Analysis Services (SSAS) must also be 
installed, and is not compatible with Microsoft SQL Server Express Edition.  Microsoft SQL Server 
Express Edition therefore cannot be used. 

Planning MSP for Your Enterprise 

Scalability 
When planning a deployment of MSP, you should consider the following questions: 

 Can a single physical Server running the MSP Server Software manage the entire population 
of devices within my Enterprise? 

 How many Relay Servers will be required to manage the devices within my Enterprise and 
where should those Relay Servers be located? 

 Can MSP handle the number of Relay Servers I will need to manage the devices within my 
Enterprise? 

MSP Scalability Defined 
Scalability concerns the ability of a hardware or software system to keep pace with changes and 
adapt to increased demands to handle increasing workloads in a graceful manner and/or to be 
readily expanded at need without total replacement.  MSP is designed to be highly scalable and 
can be deployed in various ways to handle Enterprises of varying size.  In most cases, the scale 
of an Enterprise is measured in terms of the number of devices managed and/or the number of 
Relay Servers used to manage those devices. 
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Key MSP Scalability Factors 
The maximum scale that can be achieved practically by an installation of MSP depends on 
several factors, including: 

 The degree of MSP functionality being used, including whether or not a Data Collection 
Solution will be used and especially whether or not the Long Term Analysis functionality of 
MSP Control Edition will be used. 

 The capacity of the Server hardware on which the MSP software is installed and any other 
software running on that Server. 

 The number of Relay Servers that are used and the hardware on which those Relay Servers 
are running. 

 The bandwidth and reliability of the connections from the MSP Server to the Relay Servers 
and from the devices to the Relay Servers. 

When assessing MSP Scalability, you should determine whether MSP can support a given scale 
with adequate performance.  MSP is designed to function at a very high scale without failing.  
However, on any given Server hardware, the performance of an MSP System will generally 
degrade as the scale is increased.  A key goal of deploying an MSP System is to balance scale 
and performance to meet the needs of a particular Enterprise. 

MSP Scalability Numbers 
Motorola publishes scalability numbers for MSP based on scalability testing performed during 
product validation.  These numbers are based on measured results while running specific tests 
on specific hardware configurations under specific test conditions.  The published numbers 
represent the maximum scale at which MSP was found to operate with generally acceptable 
performance on the specified hardware under the specified conditions. 

While the published numbers can, and do, provide invaluable information about how MSP may be 
expected to perform under similar conditions, they should be used with caution.  Variations in one 
or more of the key scalability factors could produce significant changes in actual or perceived 
performance. 
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Published MSP Scalability Numbers 
The published MSP Scalability test results, shown in Table 1 below, are segregated based on 
whether a Data Collection Solution will be used and/or Long Term Analysis functionality of MSP 
Control Edition will be used.  Long Term Analysis functionality requires significantly greater 
processing power than all other MSP functionality and hence demands a much more capable 
Server or Servers. 

MSP Functionality Tested Hardware 
Configuration 

Tested Software 
Configuration 

Deemed to provide 
acceptable performance 
when managing up to 

WITHOUT a Data 
Collection Solution 

 A single 3 GHz 
processor 

 4 GB of 
memory 

 40 GB of 
available hard 
drive space 

 Microsoft 
Windows Server 
2003 

 MSP Provision 
Edition 

 Microsoft SQL 
Server 2005 
Express Edition 

 A single internal 
Relay Server 

5,000 total devices 

WITHOUT a Data 
Collection Solution 

 A single 3 GHz 
processor 

 4 GB of 
memory 

 40 GB of 
available hard 
drive space 

 Microsoft 
Windows Server 
2003 

 MSP Provision 
Edition 

 Microsoft SQL 
Server 2005 
Express Edition 

 20 external Relay 
Servers 

100,000 total devices (5,000 
per Relay Server) 

WITHOUT a Data 
Collection Solution 

 A single 3 GHz 
processor 

 4 GB of 
memory 

 40 GB of 
available hard 
drive space 

 Microsoft 
Windows Server 
2003 

 MSP Provision 
Edition 

 Microsoft SQL 
Server 2005 
Express Edition 

 10,000 external 
Relay Servers 

100,000 total devices (10 per 
Relay Server) 

WITH a Data Collection 
Solution and Long 
Term Analysis 

 Dual 2.33 GHz 
dual-core 
processors 

 4 GB of 
memory 

 40 GB of 
available hard 
drive space 

 Microsoft 
Windows Server 
2003 

 MSP Control 
Edition 

 Microsoft SQL 
Server 2005 
Standard Edition 
and SQL Server 
Analysis Services 
(SSAS) 

 A single internal 
Relay Server 

5,000 total devices 
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MSP Functionality Tested Hardware Tested Software Deemed to provide 
Configuration Configuration acceptable performance 

when managing up to 

WITH a Data Collection 
Solution and Long 
Term Analysis 

 Dual 2.33 GHz 
dual-core 
processors 

 4 GB of 
memory 

 40 GB of 
available hard 
drive space 

 Microsoft 
Windows Server 
2003 

 MSP Control 
Edition 

 Microsoft SQL 
Server 2005 
Standard Edition 
and SQL Server 
Analysis Services 
(SSAS) 

 2 external Relay 
Servers 

10,000 total devices (5,000 
per Relay Server) 

WITH a Data Collection 
Solution but WITHOUT 
Long Term Analysis 

 Dual 2.33 GHz 
dual-core 
processors 

 4 GB of 
memory 

 40 GB of 
available hard 
drive space 

 Microsoft 
Windows Server 
2003 

 MSP Control 
Edition 

 Microsoft SQL 
Server 2005 
Standard Edition 

 10,000 external 
Relay Servers 

50,000 total devices (5 per 
Relay Server) 
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MSP Functionality Tested Hardware Tested Software Deemed to provide 
Configuration Configuration acceptable performance 

when managing up to 

WITH a Data Collection 
Solution and Long 
Term Analysis 

 SQL Server and 
SQL Server 
Analysis 
Services 
installed on 
dedicated 
Server as 
follows: (4) 4-
Core Intel® 
Xeon® X7460 
Processors 88 
GB memory, 
1000 GB hard 
drive 

 MSP installed 
on a dual 2.33 
GHz dual-core 
processors, 
4GB of 
memory, 120 
GB of hard 
drive space. 

 Microsoft 
Windows Server 
2003 

 MSP Control 
Edition 

 Microsoft SQL 
Server 2005 
Standard Edition 
and SQL Server 
Analysis Services 
(SSAS) 

 10,000 external 
Relay Servers 

250,000 total devices (25 per 
Relay Server) 

Table 1 – MSP Server Scalability Test Results 

Deploying MSP to Meet the Scale of an Enterprise 
If the number of devices to be managed and the number of Relay Servers deployed within your 
Enterprise are comfortably within the published numbers, deployment of a solution likely can 
proceed with reasonable confidence of success on hardware comparable to the hardware on 
which scalability testing was performed. 

If the number of devices to be managed or the number of Relay Servers deployed within your 
Enterprise exceed the published numbers, additional planning will be required.  Achieving 
acceptable performance from MSP at scales beyond the published numbers will typically require 
the application of one or more of the following compensating measures: 

Use a More Capable Server 

The published scalability numbers were generally not tested on top-of-the-line Server hardware.  
If you need to support more than the published number of devices, one compensating measure is 
to get a more capable Server.  While there are no hard-and-fast rules for estimating Server size, 
you can generally figure that a Server that is twice as capable can be expected to support 
approximately twice as many devices with comparable performance, if used under otherwise 
comparable conditions. 
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Avoid or Restrict the Use of Long Term Analysis 

As previously described, Long Term Analysis significantly increases the capacity of the hardware 
required and reduces the scale of the Enterprise that is supportable using that hardware.  If the 
required scale of the Enterprise exceeds the published numbers, one compensating measure 
would be to choose not to use Long Term Analysis or to significant limit how Long Term Analysis 
is used.  For example, if Long Term Analysis was used on only subsets of the population of 
devices, or if the retention of Collected Data was reduced significantly, then the impact of Long 
Term Analysis could be reduced. 

Off-load Work from the MSP Server 

In many cases, the published scalability numbers were measured with several components 
running on the same Server hardware.  If the required scale of the Enterprise exceeds the 
published numbers, one compensating measure could be to move such components onto 
separate Servers.  For example: 

 Relay Servers 

If a Relay Server is located on the same physical Server as the MSP Software, the physical 
Server must expend computing resources to service FTP and FTPS requests.  By using one 
or more external Relay Servers, the MSP Server can be freed from having to service 
asynchronous requests from devices.  This could provide a significant advantage, especially 
when the number of devices is high. 

If an internal Relay Server is located on the same physical Server as the MSP Software, that 
Server experiences a double hit since the MSP Software issues requests that must be 
serviced by the same Server.  By using one or more external Relay Servers, the load is 
distributed; requests will be generated by one Server and serviced by another. This can help 
scale higher while maintaining adequate performance. 

 Microsoft SQL Server 

When Microsoft SQL Server is located on the same physical Server as the MSP Software, 
both the database client and Server are resident on the same hardware and hence the 
overall performance of that Server may suffer.  This is especially true when using Long Term 
Analysis, where a substantial amount of the processing is performed by and within SQL 
Server itself. 

By running Microsoft SQL Server on a separate Server, the processing load can be better 
balanced.  Many customers may already have SQL Server “farms” that use high-end Servers 
and/or clustered configurations.  Such configurations can be used to off-load Analysis 
processing from the Server running the MSP Software.  This can help scale higher while 
maintaining adequate performance.  It may also have the side-benefit of allowing MSP 
Backups to be performed as part of existing Backup procedures that are in place for the 
existing SQL Server “farms”. 

Network Topology and Connectivity 

The locations at which devices will be used within your Enterprise need to be identified, along 
with the kinds of device usage expected at each location.  The connectivity that will be available 
to devices at various locations should be considered to determine how best to configure an MSP 
system to manage the devices. 

Every device that will be managed by MSP must be capable of contacting a Relay Server.  This is 
generally accomplished by using one or more device network adapters to provide access to one 
or more networks, which may have different types of availability, such as: 
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 In WLAN environments, connectivity to a private LAN is typically expected to be nearly 
continuous. 

 In WWAN environments, connectivity to a public or private network may be sporadically 
available and/or intentionally restricted based on cost and/or bandwidth issues. 

 If cradles are used, connectivity to a private LAN will be available only during periods when 
the device is in the cradle. 

The type of connectivity available from a device to a Relay Server can have a significant impact 
on the best way to organize the MSP System.  For example, a retail store might have only a very 
low-bandwidth connection to its central headquarters.  In such a case, having devices at the store 
contact a Relay Server at the central headquarters, over that slow link, might be a poor choice.  
Instead, having a Relay Server located at each retail store could be the best solution. 

Relay Servers can be located anywhere within the Enterprise to meet the needs of devices and to 
compensate for any connectivity issues or limitations that may exist.  In many cases, locating a 
Relay Server at a remote location may be the best way to avoid unnecessary traffic over slow 
links.  In other cases, regional Relay Servers might be used to manage multiple locations that 
share higher-bandwidth regional networks.  In other cases, wide area connectivity may be 
adequate to allow fully centralized management. 

MSP is always a 3-tier system.  An MSP Server talks to one or more Relay Servers and devices 
also talk to those Relay Servers.  This means that MSP Servers and Relay Servers need to be 
located in places where connectivity is reliable for the communications they will interchange.  As 
circumstances warrant, a Relay Server can be located anywhere between the MSP Server and 
the devices it is used to manage. 

Note: 

Unreliable connectivity between the MSP Server and the Relay Servers can significantly degrade 
the overall performance of an MSP System. 

Network Naming/Addressing and Accessibility 
Since the MSP system consists of 3 tiers, the tiers must be connected together for proper 
operation.  The necessary connections are made using network names and/or addresses.  Some 
possible approaches include: 

 Static IP Addressing, where there may be little or no change in network addresses used over 
time.  

 Dynamic IP Addressing, where there may be periodic changes in network addresses used 
over time. 

 Naming (e.g., DNS, WINS), where there is built-in Indirection and little or no change in 
network names used over time. 

 Network Address Translation (NAT) to extend or “compartmentalize” the Enterprise network 
address space. 

 Firewalls to limit certain kinds and directions or traffic.  

Notes: 

When network names or addresses change, components of an MSP System may need to be 
reconfigured to compensate. 
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NATs and/or Firewalls could have implications on where Servers can be located with the 
Enterprise and/or how they are addressed and/or may require reconfiguration of the NATs and/or 
Firewalls to enable proper operation of an MSP System.  This is discussed in more detail in this 
document in Understanding MSP Security in this document. 

How Names or Addresses Connect MSP Components 

User Access to MSP Console UI 

Since the MSP Console UI is accessed via a Web Browser, Users will need to know the network 
name or address of each MSP Server they will access in order to direct their Web Browser to the 
proper URL.  Frequently, Users will create shortcuts within their Web Browser to simplify 
repeated access to commonly used pages.  If dynamic addressing is used without naming, such 
shortcuts will become invalid if there is a change to a referenced MSP Server address. In such a 
case, the User would need to manually update any affected shortcuts. 

MSP Server Access to Relay Server 

Each MSP Server needs to access one or more Relay Servers via the FTP or secure FTP 
protocol.  An MSP Relay Server Object must be created within MSP that specifies the Public 
name or address of the Relay Server by which MSP will access that Relay Server. 

If an address is used, the address must be contactable from the location where the MSP Server 
resides (despite any NATs or Firewalls).  In the event that the address of a Relay Server 
changes, the corresponding MSP Relay Server Object will need to be modified to match the new 
address. 

Device Access to Relay Server 

Each device needs to access exactly one Relay Server in order to be managed by MSP.  For 
Staging, the information about the Relay Server is obtained from the Staging Profile.  For 
Provisioning or Actions, the information about the Relay Server is generally configured by a 
Staging Profile and/or is updated by a Job initiated by a Provisioning Policy or an Action. 

In addition to the Public name or address defined for use by MSP, each MSP Relay Server 
Object also must specify a Private name or address of the Relay Server for devices that will 
access that Relay Server.  The Public and Private names or addresses could be defined to be the 
same or different, depending on the situation. 

If an IP Address is used, the IP Address must be contactable from the location where the device 
resides (despite any NATs or Firewalls).  In the event that the Private address of a Relay Server 
changes, the corresponding MSP Relay Server Object will need to be modified to match.  Once 
the MSP Relay Server Object has been updated, new Relay Server Settings would need to be 
delivered to all affected devices.  If the Relay Server is not contactable at the old address being 
used by a device, Provisioning cannot be used to update the Relay Server address, and the 
device would need to be Staged to perform the update.  This might be avoided by updating the 
Relay Server Settings to all devices; if possible, before the address of the Relay Server itself is 
actually changed. 

MSP Console UI to Device 

Remote Control functionality requires an IP Address or network name (e.g. DNS, etc.) via which 
the MSP Console UI can contact a device.  A device must be contactable at this IP Address or 
name or Remote Control functionality cannot function. 
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Since MSP Stage Edition is NOT an Asset Management solution, it provides no means to 
automatically collect the information required to remotely contact devices.  When using Remote 
Control functionality with MSP Stage Edition, the IP Address or name would need to be 
determined (typically by cooperation between the Device User and the MSP Console UI User that 
seeks to control the device) and manually entered by the User of the MSP Console UI. 

MSP Provision and Control Editions do offer Asset Management functionality and hence do 
provide a means to collect the information about devices required to automatically launch Remote 
Control functionality for them. 

One common reason for a lack of contactability with devices is the use of Network Address 
Translation (NAT) Routers and Firewalls.  Both of these can effectively block certain network 
traffic and interfere with requisite contactability.  More information on dealing with NAT and 
Firewall issues can be found in this document in Understanding MSP Security in this document. 
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Chapter 4 – MSP Security 

Introduction 
Security can be defined as the establishment and maintenance of protective measures to ensure 
a state of inviolability from accidental or hostile acts or influences.  The Security of a system is 
often evaluated in terms of the size of the “attack surface” presented by the system.  The attack 
surface is the number and accessibility of paths potentially available for an entity to accidentally 
or maliciously interact with the system to cause harm. 

Types of Security 
There are two main types of Security of interest in a computing system: Physical Security and 
Network Security.  These are described in the following sections. 

It should be understood, however, that nothing is ever perfectly secure.  Security is a spectrum 
and each Enterprise must ensure that the systems employed and the methods used to secure 
them provide an acceptable level of overall Security.  A good balance of Physical and Network 
Security is generally the best way to accomplish this. 

Physical Security 
Physical Security of an entity is achieved by controlling the access to the entity via physical 
means and is a general recognition of the fact that in most cases the task of compromising an 
entity is made simpler if one can physically access the entity. 

For example, a Server located in a locked closet is clearly more secure than a Server sitting out 
in the middle of a warehouse floor.  This is because the Server in the warehouse is potentially 
subject to physical attempts to breach its Security.  Note however, that the Server in the locked 
closet is just as vulnerable to an offender with a stolen key as the Server in the warehouse is to 
an offender with a simple screwdriver. 

There are often valid and necessary reasons why certain entities of which a system is comprised 
cannot be Physically Secured as well as might be wished.  For example, Mobile Devices used in 
an Enterprise would be much more secure if they were always locked in a bank vault.  Of course, 
they would also be unlikely to achieve their intended result as well. 



30 -- Administering MSP 3.3.1 
 

Network Security 
Network Security becomes necessary when two related entities are separated from each other 
physically but are connected logically via a network.  In such cases, the network connecting the 
two entities becomes part of the “attack surface” of the system comprised of those entities. 

For example, a device used at a remote location may be physically separated from a Server 
located at a data center.  There may be many different network segments, possibly even wireless 
ones, in between these two entities.  In such a case, the entire path between the device and the 
Server becomes part of the “attack surface” of the overall system. 

There are often valid and necessary reasons why a system must be distributed.  For example, 
devices used on a WiFi network may need to be managed from a central management system.  
The connection between the two is a potential Security Risk that must be mitigated to ensure that 
it does not become an actual Security Vulnerability. 

MSP and Security 
From an MSP perspective, Security can be considered from various points of view, including the 
Enterprise Network, the MSP Server, other Servers, MSP Console UI Users, and the devices 
being managed. 

The following sections in this chapter focus on various points of view.  Each section will identify 
and discuss the most important concerns related to Security, describe techniques that can be 
used to mitigate potential Security Risks, and present best practices that may be employed to 
help achieve an acceptable level of Security. 

Enterprise Network Security 
Enterprise Network Security considers the impact of the Servers that comprise an MSP system, 
the communications between these Servers over the Enterprise Network, and examines 
approaches to minimize their impact on the Security of the Enterprise Network. 

Security Concerns 
This section covers the most common Security concerns that may be important to consider when 
an MSP system is introduced into an Enterprise Network. 

Advertised Interfaces 
Advertised Interfaces are interfaces that are intentionally published and documented and which 
are considered essential to the successful delivery of the results of a system.  Just because 
Advertised Interfaces are intentionally published and documented does not mean that they do not 
pose potential risks to the Security of the Enterprise Network in which a system is deployed. 

Most Enterprises define Security Policies to limit the types of interfaces that are exposed by 
systems being considered for deployment into an Enterprise Network.  This is done to help 
manage the impact such systems may have on the Security of the Enterprise Network.  If the 
Advertised Interfaces of a system conflict with defined Enterprise Security Policy, then some sort 
of adjustment or mitigation will generally be required before the system will be allowed to be 
deployed into the Enterprise Network. 
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The following are some of the ways in which an Advertised Interface that conflicts with defined 
Enterprise Security Policy might be mitigated: 

 Disable the offending Advertised Interface 

This might be an acceptable solution if the feature exposed by the Advertised Interface is not 
critical to the intended use of the system.  For example, use of HTTP might be prohibited and 
the system might be configured to only allow use of HTTPS. 

 Move the offending Advertised Interface to an alternate port 

This might be possible if the system allows the reconfiguration of the port used.  For example, 
an FTP interface might be moved to a non-standard port that is considered less vulnerable to 
attack. 

 Control access to the Advertised Interface 

This might accomplished by special setup of routers or Firewalls.  For example, an Access 
Control List (ACL) might be used restrict access to an HTTP interface strictly from 
Workstations with specifically identified MAC Addresses. 

The Advertised Interfaces exposed by various MSP components are discussed in later sections 
of this chapter. 

Interconnection Interfaces 
Interconnection Interfaces are those interfaces that are intentionally introduced to interconnect 
multiple entities in a system when those entities are physically separated and connected to each 
other via an Enterprise Network.  Just because Interconnection Interfaces are intentionally 
introduced does not mean that they do not pose potential risks to the Security of the Enterprise 
Network in which a system is deployed. 

Enterprises Security Policies generally are not concerned with the reason why an interface is 
needed.  If the Interconnection Interfaces of a system conflict with defined Enterprise Security 
Policy, then some sort of adjustment or mitigation will generally be required before the system will 
be allowed to be deployed into the Enterprise Network. 

The following are some of the ways in which Interconnection Interfaces that conflict with defined 
Enterprise Security Policy might be mitigated: 

 Physically secure the entities using the Interconnection Interface and the network segment 
between them 

This might acceptable if two entities can be physically co-located and connected via a 
dedicated link.  For example, if two Servers might be located in the same rack, and might be 
connected via a private sub-net. 

 Disable the offending Interconnection Interface 

This might be an acceptable solution if the feature used by the Interconnection Interface is 
not critical to the intended use of the system.  For example, use of an SMTP interface might 
be prohibited and the loss of the system features enabled by that interface might be deemed 
acceptable. 

 Move the offending Interconnection Interface to an alternate port 

This might be possible if the system allows the reconfiguration of the port used.  For example, 
an FTP interface might be moved to a non-standard port that is considered less vulnerable to 
attack. 
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 Control access to the Interconnection Interface 

This might accomplished by special setup of routers or Firewalls.  For example, an Access 
Control List (ACL) might be used restrict access to an SNI interface to the specific MAC 
Addresses of the entities that need it. 

The Interconnection Interfaces used between various MSP components are discussed in later 
sections of this chapter. 

Mitigation Techniques 
MSP is highly configurable in terms of how it is deployed.  An MSP system can be comprised of a 
solution as compact as a single Server managing a collection of close-proximity devices.  MSP is 
also highly scalable and can be distributed to expand its scale and reach.  An MSP system might 
be comprised of many Servers distributed throughout an Enterprise managing a collection of 
devices distributed to many disparate remote locations. 

To meet the Security needs of a given Enterprise, the following may need to be adjusted: 

Control the Degree of Distribution 

If scalability does not require components to be distributed, then co-locating components on the 
same Server can prevent the need to expose Interconnect Interfaces between those components.  
In such cases, a Firewall can be used to block those interfaces without impacting the operation of 
the MSP system. 

Move Selected Interfaces to Non-Standard Ports 

Many Interconnecting Interfaces can be reconfigured to use non-standard ports.  In such cases, a 
Firewall can be used to block the standard ports without impacting the operation on the non-
standard ports, so long as the Firewall does not block the non-standard ports used. 

Disable Selected Interfaces 

Many MSP features are optional and will not be used if they are not configured.  In such cases, a 
Firewall can be used to block those interfaces without impacting the operation of the MSP 
system. 

Best Practices 
 Deploy MSP components on as few Servers as needed to meet the requirements of the 

system. 

The more Servers are used, the more complicated it will be to ensure that all the interfaces 
between them are appropriately secured. 

 Carefully review the Advertised Interfaces and Interconnect Interfaces used by the MSP 
components being deployed for violations of Enterprise Security Policy. 

If violations are found, apply appropriate mitigations before deploying the MSP system into 
the Enterprise Network. 

 Perform Security assessments and scans of the Enterprise Network before and after the 
deployment of MSP. 

By keeping abreast of the state of the Enterprise Network, surprises can be minimized.  It is 
desirable to avoid missing Security violations that may be caused by MSP or blaming MSP 
for Security violations for which it is not the cause. 
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MSP Server Security 
MSP Server Security considers the Security of the MSP Server itself and examines approaches 
to maximize the Security of the MSP Server, the data it generates, and the devices it manages. 

Security Concerns 
This section considers the most common Security concerns that may be important to consider 
when an MSP Server is deployed into an Enterprise Network. 

Advertised Interfaces 
The only Advertised Interface used by the MSP Server is the HTTP or HTTPS interface used to 
access the MSP Console UI from a Web Browser on a Workstation PC. 

The HTTP Protocol is defined by approved RFC 2616, titled “Hypertext Transfer Protocol -- 
HTTP/1.1”, which defines the current accepted standard for non-secure HTTP Protocol. 

  HTTP is generally considered non-secure for the following reasons: 

 No authentication of the identity of the Server is supported, making HTTP subject to “man in 
the middle” attacks where a malicious entity pretends to be the HTTP Server. 

 While client login is supported, credentials are transferred in clear text, making HTTP subject 
to credential interception by any entity that is capable of “sniffing” the network connection 
between the client and the Server. 

 All data is transferred unencrypted, making HTTP subject to interception of any data 
transferred using this protocol. 

The HTTPS Protocol is not actually defined by an approved RFC.  HTTPS uses the standard 
HTTP protocol and directs it over a Secure Sockets Layer (SSL) tunnel.  It is customary to initiate 
HTTPS sessions over the default port of 443 instead of the default port of 80 used for standard 
non-secure HTTP.  While other variations of secure HTTP protocols have been developed and 
proposed none have breadth of support of HTTPS, making HTTPS the de-facto, although not 
official, standard for secure HTTP protocol.   

HTTPS is generally considered secure for the following reasons: 

 Authentication of the identity of the Server is supported, making HTTPS defensible against 
“man in the middle” attacks so a malicious entity cannot successfully pretend to be the 
HTTPS Server. 

 Client login credentials, if used, are transferred over an encrypted Transport Layer Security 
(TLS) tunnel, protecting HTTPS against credential interception by any entity that is capable of 
“sniffing” the network connection between the client and the Server. 

 All data is transferred over an encrypted TLS tunnel, protecting HTTPS from interception of 
any data transferred using this protocol. 

For the above reasons, the HTTPS protocol is generally considered suitable even for security-
conscious environments and environments where the underlying network is not “intrinsically 
secure”.  HTTPS is, for example, used to implement uncountable numbers of secure transaction 
daily over the entirely non-secure public Internet.  In particular, the HTTPS protocol is generally 
suitable for use in a network where compliance to the requirements set forth in the Payment Card 
Industry (PCI) security standards is required. 
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It is important to understand how the MSP Console UI will be used and what Enterprise Security 
Policies may apply, in order to determine whether to use HTTP, HTTPS, or both and whether any 
mitigations are required to prevent the interfaces used from representing a real Security 
Vulnerability to the Enterprise Network. 

The following should be considered: 

 Where will Users be located when they access the MSP Console UI from Workstation PCs? 

Since authentication credentials used to log into the MSP Console UI and all data displayed 
on and entered via a Workstation PC are sent in the clear over HTTP, the Security of the link 
between Workstation PCs and the MSP Server must be carefully considered.  When using 
HTTPS, all data, including authentication credentials would be exchanged over an encrypted 
SSL tunnel, ensuring they cannot be compromised. 

If all Workstation PCs from which the MSP Console UI will be accessed are located within the 
same fully secure network as the MSP Server, then using HTTP may be acceptable. 

Note: 

Any use of HTTP, even within a network that is fully secured from external 
intrusion, provides the opportunity for data, including authentication 
credentials to be compromised by anyone with access to that network. 

If any Workstation PCs from which the MSP Console UI will be accessed are located at less 
secure locations, then it would likely be necessary to prevent the use of HTTP from those 
locations.  This could be achieved by configuring routers to block HTTP traffic from such 
locations.  Or, it might be desirable to disable HTTP and require that only HTTPS be used 
from all locations. 

 Are there any Enterprise Security Policies that limit the use of HTTP? 

If Enterprise Security Policy precludes the use of HTTP, then it may be necessary to disable 
HTTP and require that only HTTPS be used. 

 Are there any Enterprise Security Policies that limit the use of standard ports for HTTP and/or 
HTTPS? 

If Enterprise Security Policy precludes the use of standard ports for HTTP and/or HTTPS, 
then it may be necessary to reconfigure the ports used. 

Note: 

Using non-standard ports does not actually increase the inherent Security, since the same 
functionality is available and could be discovered by a detailed port scan.  But it can help reduce 
the incidence of casual misuse since the commonly known and accessed ports are not used. 

Interconnection Interfaces 
Depending on how an MSP system is deployed, some system components may be physically 
distributed within the Enterprise Network.  In such cases, the Interconnection Interfaces used to 
connect these components will need to be assessed to determine if they represent a potential 
Security Risk and if any mitigation is required to prevent them from representing a real Security 
Vulnerability to the Enterprise Network. 
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Interfaces and Ports 

Table 2 below shows the various Interconnection Interfaces that might be used by MSP system 
components if they are distributed throughout an Enterprise Network. 

Interface 
Name 

Description/Purpose Default
Port 

Can 
Change? 

FTP Normal (unsecure) File Transfer Protocol 

Used to communicate between the MSP Server 
and external Relay Servers and between devices 
and external Relay Servers. 

TCP 
21 
 

Yes 

FTPS Secure File Transfer Protocol (FTP over TLS)  

Used to communicate between the MSP Server 
and external Relay Servers and between devices 
and external Relay Servers. 

TCP 
21 
 

Yes 

SMTP Simple Mail Transport Protocol 

Used to deliver SMS messages for SMS Staging 
via Email gateways. 

TCP 
25 

Yes 

SMPP Short Message Peer to Peer Protocol 

Used to deliver SMS messages for SMS Staging 
via SMPP gateways. 

TCP 
2775 

Yes 

SNI SQL Network Interface 

Used to communicate between the MSP Server 
and an external SQL Server. 

TCP 
1433 

No 

SSRP SQL Server Resolution Protocol 

Used by the MSP Server to obtain the information 
required to connect to a named instance on an 
external SQL Server. 

UDP 
1434 

No 

HTTP Normal (unsecure) MSP Console UI 

Used from a Web Browser on a Workstation PC to 
access the MSP Console UI on the MSP Server. 

TCP 
80 

Yes 

HTTPS Secure MSP Console UI 

Used from a Web Browser on a Workstation PC to 
access the MSP Console UI on the MSP Server. 

TCP 
443 

Yes 
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Interface Default Can Description/Purpose 
Name Port Change? 

Athena 
RC Port 

Athena Remote Control RC Port 

Used to implement the UI Control function from a 
Workstation PC as part of the Athena Remote 
Control Solution. 

TCP 
7777 

No 
 

Athena 
Web Port 

Athena Remote Control Web Port 

Used to implement Remote Troubleshooting 
functions from a Workstation PC as part of the 
Athena Remote Control Solution. 

TCP 
8080 

No 
 

Motorola 
Remote 
Control 
Port 

Motorola Remote Control Port 

Used to implement Remote Troubleshooting 
functions from a Workstation PC as part of the 
Motorola Remote Control Solution. 

TCP 
7775 

No 
 

Table 2 – Interconnection Interfaces and Ports 

 This is the FTP command port.  Depending on the FTP Mode used (Active vs. 
Passive), additional ports are required. 

 While the port used by the device cannot be changed, the port used by the 
Workstation PC can be remapped for NAT Traversal.  For more information, see 
Chapter 11 – Using Remote Control Functionality. 

Distribution Options 

As shown in Table 2 – Interconnection Interfaces and Ports, there are many choices to be made 
about how and whether to distribute components of an MSP system within the Enterprise 
Network.  The decisions made will impact the potential Security Risks that need to be evaluated 
to determine if mitigations are required to prevent them from representing a real Security 
Vulnerability to the Enterprise Network.  The following MSP system components might be 
distributed and hence might need to be given special consideration: 

 External SQL Server 

If Microsoft SQL Server is installed on a separate Server (or cluster of Servers) from the MSP 
Server, then the SNI and SSRP Interconnection Interfaces will be required to communicate 
between the MSP Server and SQL Server.  This subject is covered in more detail in the 
section on SQL Server Security. 

 External Relay Server 

If one or more external Relay Servers, separate from the MSP Server, are used then the FTP 
and/or FTPS Interconnection Interfaces will be required to communicate between the MSP 
Server and those external Relay Server(s).  This subject is covered in more detail in the 
section on Relay Server Security. 

 



Chapter 4 – MSP Security -- 37 
 

Mitigation Techniques 

Configuring MSP Console UI Access for HTTPS 
The following sections describe how to configure Microsoft Internet Information Services 
(Microsoft IIS) so that the MSP Console UI can be accessed via HTTPS. 

Obtaining a Certificate for the MSP Server 

In order to use HTTPS to access the MSP Console UI, a Digital Certificate is required to be 
installed into Microsoft IIS to identify and Authenticate the Server and to enable encryption of 
sessions. 

Several providers exist that can coordinate and provide, for a fee, trusted Certificates which can 
be installed on the MSP Server to enable access to the MSP Console UI via HTTPS.  The 
following are links to some common providers.  The following list is provided for convenience, is 
not intended to be complete and does not indicate any endorsement by Motorola: 

 www.thawte.com (http://www.thawte.com/) 

 www.verisign.com (http://www.verisign.com/) 

 www.geotrust.com (http://www.geotrust.com/) 

 www.godaddy.com (http://www.godaddy.com/) 

Note: 

Verisign, GoDaddy, GeoTrust, Thawte, and Microsoft are trademarks of their respective 
companies. 

In addition, Microsoft provides the capability to produce self-signed Certificates through the IIS 
6.0 Resource Toolkit which can be obtained from Microsoft.  Additional mechanisms, such as 
OpenSSL, may be used to generate self-sign or privately signed Digital Certificates for use with 
IIS, but it is beyond the scope of this document to explain or describe the use of such tools. 

Self-signed or privately signed Certificates will generally be considered by most Workstations and 
Web Browsers to be untrusted.  Accessing the MSP Console UI using an untrusted Certificate 
generally results in a Security warning.  Eliminating such a Security warning generally requires 
the installation of the self-signed Certificate into the trusted Certificate store of the Workstation 
PC and/or into the trusted Certificate store of the Web Browser. 

Installing a Certificate into Microsoft IIS 

Once you have a suitable Certificate, the following steps can be followed to install it into Microsoft 
IIS. 

1. Click Start > Control Panel >Administrative Tools. 

2. Start Internet Services Manager 

 

http://www.thawte.com/
http://www.verisign.com/
http://www.geotrust.com/
http://www.godaddy.com/
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3. Open the properties window for the Web Site by right clicking on the Default Web Site 
(Figure 1 below) and selecting Properties from the menu. 

 

Figure 1 – IIS Default Web Site 

4. Select the Directory Security tab in Properties (Figure 2 below). 

 

Figure 2 – IIS Directory Security 
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5. Click Server Certificate. The following Wizard (Figure 3 below) will appear: 

 

Figure 3 – IIS Certificate Wizard 

6. Choose to Process the Pending Request and Install the Certificate. Click Next. 

7. Specify the location of your Certificate, and then click Next. 

8. Read the summary screen to be sure that you are processing the correct Certificate, and 
then click Next. 

9. You will see a confirmation screen. When you have read this information, click Next. 

10. Test to verify that the MSP Console UI can now be successfully accessed via HTTPS. 

Disabling Access to the MSP Console UI via HTTP 

Once you have installed a suitable Certificate and verified that the MSP Console UI can 
successfully be accessed via HTTPS using that Certificate, you may elect to disable access to 
the MSP Console UI via HTTP.  This can be accomplished using the following steps: 

1. Click Start > Control Panel >Administrative Tools. 

2. Start Internet Services Manager 
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3. Open the properties window for the Web Site by right clicking on the Default Web Site 
(Figure 4 below) and selecting Properties from the menu. 

 

Figure 4 – IIS Default Web Site 

4. Select the Directory Security tab in Properties. 

5. Select Edit under Secure Communications (Figure 5 below) 

 

Figure 5 – IIS Secure Communications 
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6. Select Require Secure Channel (SSL) as in Figure 6 below. 

 

Figure 6 – IIS Secure Communications 

7. Click OK. 

8. Test to verify that the MSP Console UI can still be successfully accessed via HTTPS but 
can no longer be accessed via HTTP. 

Redirecting HTTP Access to HTTPS 

Once you have successfully limited access to the MSP Console UI to HTTPS, you may elect to 
configure Microsoft IIS to redirect attempted accesses via HTTP to HTTPS.  This will allow Users 
to reference the MSP Console UI via the same URL as when using HTTP.  This can be 
accomplished using the following steps: 

 



42 -- Administering MSP 3.3.1 
 

1. Select the Custom Errors tab in Properties (Figure 7 below). 

 

Figure 7 – IIS Custom Errors 

2. Select HTTP Error 403.4 and choose a file that you create to redirect. (Figure 7 
above and Figure 8 below) 

 

 

Figure 8 – IIS Custom Errors Properties 

The following is an example of the contents of a file that might be created and referenced as 
shown in Figure 8 above. 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 
Transitional//EN"> 
<html> 
<head> 
<title>MMS Demo Server Redirector</title> 
<meta http-equiv="REFRESH"  
Content="1;url=https://www.mmsdemoServer.com/MSP.web"></HEA
D> 
<BODY> 

 



Chapter 4 – MSP Security -- 43 
 

Loading... https://www.mmsdemoServer.com/MSP.web 
</BODY> 
</HTML> 

Configuring MSP Console UI to use Non-Standard Ports 
If it is necessary to reconfigure Microsoft IIS to use non-standard ports for HTTP and/or HTTPS, it 
can be accomplished by the following steps: 

1. Click Start > Control Panel >Administrative Tools. 

2. Start Internet Services Manager 

3. Open the properties window for the Web Site by right clicking on the Default Web 
Site (Figure 9 below) and selecting Properties from the menu. 

 

Figure 9 – IIS Default Web Site 

 

https://www.mmsdemoserver.com/MSP.web
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4. Open Directory Security by right clicking on the Web Site tab (Figure 10 below). 

 

Figure 10 – IIS Directory Security 

5. Change the TCP port to modify the port used for HTTP access. 

6. Change the SSL port to modify the port used for HTTP access. 

7. Click OK. 

8. Test to verify that the MSP Console UI can no longer be accessed via the standard 
ports and now can be accessed via the selected non-standard ports. 

Scanning and Hardening Windows Server 
Many Enterprises have standard policies for scanning and hardening Windows Server Operating 
Systems to identify and mitigate known security vulnerabilities.  Most available security scanning 
tools will provide recommendations for patches or modifications that can be applied as mitigations 
to vulnerabilities they report.  While such mitigations may improve security, they should be 
applied with discretion as they could “secure” the system to the point where interfaces used by 
MSP are blocked, causing some or all MSP functionality to be compromised. 

Best Practices 
 Use caution when hardening Windows Server Operating Systems to ensure that MSP 

functionality is not compromised. 

If hardening is performed on Windows Server Operating Systems, care should be taken to 
ensure that the various requirements defined in this chapter and in the MSP 3.3.1 Software 
Installation Guide continue to be met. 
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 Strongly consider disabling access to the MSP Console UI via HTTP. 

By configuring and requiring the use of HTTPS to access the MSP Console UI, the 
authentication credentials and all displayed and entered data will be secured within the 
encrypted tunnel. 

 Consider automatically redirecting accesses to the MSP Console UI using HTTP to use 
HTTPS. 

This can provide seamless access to Users accustomed to using HTTP. 

 Consider configuring IIS to use non-standard ports for HTTP and/or HTTPS. 

This may be required to comply with Enterprise Security Policy. 

SQL Server Security 
SQL Server Security considers the Security of the SQL Server(s) on which the MSP Database is 
stored and examines approaches to maximize the Security of this Database and the safety of 
data stored within it. 

Security Concerns 
This section considers the most common Security concerns that may be important to consider 
when a SQL Server is deployed into an Enterprise Network as part of an MSP system. 

Integrated vs. External SQL Server 
The decision to install SQL Server on the MSP Server vs. installing SQL Server on an external 
Server can have Security implications.  It is generally simpler to secure an MSP system when all 
components are located on the same Server.  Nonetheless, there are specific reasons why it may 
be desirable or necessary to distribute SQL Server to an external Server, including: 

 MSP can more easily scale to manage a larger number of devices when SQL Server is 
installed on an external Server or cluster of Servers. 

 A High Availability configuration of MSP requires SQL Server to be installed on an external 
Server. 

 A customer may already have and want to leverage SQL Server installed on an existing 
Server or cluster of Servers. 

If it is determined that SQL Server will be installed on an external Server, then the Interconnect 
Interfaces used to communicate between the MSP Server and the SQL Server must be assessed 
to determine if they represent a potential Security Risk. 

Security Implications of an External SQL Server 
As shown in Figure 12, the Interconnection Interfaces used to communicate between the MSP 
Server and an external SQL Server are SNI on TCP Port 1433 and SSRP on UDP Port 1434. 

Numerous Security Vulnerabilities are known to exist in various versions of Microsoft SQL Server 
related to the SNI and SSRP interfaces.  It is generally accepted that all known vulnerabilities 
have been addressed in Microsoft SQL Server 2005 if the latest service packs and Security 
patches are installed.  Of course new vulnerabilities can be discovered at any time, so it is always 
advisable to keep abreast of Security notifications and warnings and apply all new service packs 
and Security patches promptly when they are released. 
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Even if all known vulnerabilities are addressed by installed service packs and Security patches, 
this does not mean that a given system is risk-free with regard to SQL Server and the SNI and 
SSRP interfaces.  Depending on the inherent level of security of the network between the MSP 
Server and the SQL Server, the SNI and SSRP protocols may be a Security Risk that requires 
mitigation. 

For example, a User on the Enterprise Network could use SSRP to locate the services of the SQL 
Server and use SNI to access and/or modify the data.  While access to the MSP Database is 
controlled by authentication credentials, exchange of these credentials may or may not be 
encrypted.  If the authentication credentials are compromised, then the Database contents they 
protect can be compromised. 

Even if it can be determined that the SNI and SSRP interfaces do not represent a meaningful 
Security Risk in a specific implementation, they may nonetheless violate Enterprise Security 
Policy.  As a result, it may be necessary to apply mitigation if a waiver of Enterprise Security 
Policy cannot be obtained. 

Mitigation Techniques 
If the SNI and SSRP interfaces introduced by distributing SQL Server onto an external Server are 
deemed to require mitigation, all viable mitigation techniques ultimately come down to isolating 
the MSP Server and the SQL Server from the rest of the Enterprise Network.  Possible 
approaches are discussed in the following sections. 

Physical Isolation 
A simple and secure way to mitigate the potential Security Risks of the SNI and SSRP interfaces 
is to physically isolate the MSP Server and the SQL Server from the rest of the Enterprise 
Network. 

For example, these two Servers could be co-located in the same rack and could be connected via 
an Ethernet crossover cable.  Most likely, the MSP Server would need dual network adapters, 
one to communicate with the Enterprise Network and one to communicate to the SQL Server. 

This type of mitigation is straight-forward to implement and maintain.  It should befairly easy to 
demonstrate with confidence that the potential Security Risk was successfully mitigated.  Such a 
solution would be most suitable if the SQL Server were dedicated for use by the MSP Server, 
such as in a case where the primary reason for distribution was scalability. 

Logical Isolation 
If it is not desirable or practical to physically isolate the MSP Server and the SQL Server from the 
rest of the Enterprise Network, it may be possible to logically isolate them.  Logical Isolation relies 
on routing technologies to control access to various entities within a network. 

If the SQL Server is dedicated for the use of the MSP Server or a small number of known entities 
including the MSP Server, it may be a relatively simple matter to configure the Access Control 
Lists (ACLs) of the routers in the Enterprise Network to permit traffic to reach the SQL Server only 
from specifically identified entities, which would include the MSP Server. 
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ACLs generally filter traffic based on the MAC Address of the accessing entity.  Traffic from an 
entity whose MAC Address is not on the approved list are not forwarded by the router. 

Note: 

ACLs are not a perfectly secure solution since a malicious entity could “sniff” the network to 
identify the MAC Address of an entity that is authorized to access the SQL Server.  The malicious 
entity might then “spoof” that MAC Address and gain illicit access to the SQL.  Nonetheless, an 
ACL-based solution might be a sufficient mitigation if physical access to the Enterprise Network is 
sufficiently secure that this form of malicious attack is considered very unlikley. 

This type of mitigation can be a bit complex more to implement and maintain than Physical 
Isolation.  But it could be a bit more difficult to demonstrate with confidence that the potential 
Security Risk was successfully mitigated.  Such a solution might be most suitable if the MSP 
Server and the SQL Server were located within the same data center or campus, but not in the 
same rack. 

Virtual Isolation 
If the MSP Server and the SQL Server are located in different geographical areas, then Logical 
Isolation may not be a viable mitigation technique.  To a large extent this depends on the nature 
of the Enterprise Network between the two Servers.  For example, the MSP Server is in a 
Network Operations Center and the SQL Server is in a Data Center halfway around the world.  
Even in such a scenario, if the Enterprise Network is adequately secure, the Logical Isolation 
might be viable.  But there are also likely cases where it would not be. 

Virtual Isolation relies on encryption and tunneling technologies to create a virtual private network 
within a less secure network, thus allowing a secure isolated connection between entities.  Virtual 
Isolation can be implemented using either a point-to-point or a concentrator model.  A point-to-
point model would be sufficient, but a concentrator model might be preferable if it were already 
available within the Enterprise. 

Properly implemented, Virtual Isolation can provide a fully secure mitigation even if the MSP 
Server and SQL Server are widely separated and even if they are connected by less secure 
network segments. 

This type of mitigation can be fairly complex to implement and maintain, although it may be 
possible to leverage a virtual networking infrastructure that is already in place.  Once 
implemented, it should be fairly easy to demonstrate with confidence that the potential Security 
Risk was successfully mitigated.  Such a solution might be most suitable if the MSP Server and 
the SQL Server were located far apart and/or separated by less secure network segments. 

Best Practices 
 Install SQL Server on the MSP Server unless there is a compelling reason not to do so. 

Having the MSP Server and the SQL Server on the same box avoids the potential Security 
Risks introduced by the Interconnect Interfaces, but may limit the scalability of the overall 
MSP system. 

 If SQL Server is installed on the MSP Server, block access to the Interconnect Interfaces 
from outside the MSP Server. 

The Interconnect Interfaces for SQL Server will be used but need not and should not be 
exposed outside of that Server. 
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 If SQL Server is installed on an external Server, assess any Security Risks introduced by the 
Interconnect Interfaces and mitigate them appropriately. 

The Interconnect Interfaces for SQL Server will be used and will be exposed within the 
network path between the two Servers.  The potential Security Risks of these should thus be 
mitigated to ensure that they do not result in actual vulnerabilities to the Enterprise Network. 

Relay Server Security 
Relay Server Security considers the Security of the Relay Server(s) via which the MSP Server 
communicates with devices and examines approaches to maximize the Security of these Servers 
and the data communicated through them. 

Security Concerns 
This section considers the most common Security concerns that may be important to consider 
when a Relay Server is deployed into an Enterprise Network as part of an MSP system. 

Integrated vs. External Relay Server 
The decision to install a Relay Server on the MSP Server vs. installing a Relay Server on an 
external Server can have Security implications.  It is generally simpler to secure an MSP system 
when all components are located on the same Server.  Nonetheless, there are specific reasons 
why it may be desirable or necessary to distribute Relay Servers within the Enterprise Network, 
including: 

 MSP can more easily scale to manage a larger number of devices when multiple external 
Relay Servers are used. 

 A High Availability configuration of MSP will best be achieved by using at least one external 
Relay Server. 

 A customer may already have and want to leverage existing Relay Servers installed within 
the Enterprise Network. 

 Bandwidth and/or contactability issues within the Enterprise Network may make it desirable 
or mandatory to distribute external Relay Servers at various locations within the Enterprise 
Network. 

If it is determined that at least one external Relay Server will be used, then the Interconnect 
Interfaces used to communicate between the MSP Server and the external Relay Server(s) must 
be assessed to determine if they represent a potential Security Risk. 

Security Implications of an External Relay Server 
As shown in Figure 12, the Interconnection Interfaces used to communicate between the MSP 
Server and an external Relay Server is primarily FTP and FTPS on TCP Port 21.  As noted, FTP 
and FTPS actually use additional ports as shown below: 

 Ports used when FTP Server is in Active Mode: 

○ FTP Server's port 21 from anywhere 
(Client initiates connection) 

○ FTP Server's port 21 to ports > 1023 
(Server responds to client's control port) 
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○ FTP Server's port 20 to ports > 1023 
(Server initiates data connection to client's data port) 

○ FTP Server's port 20 from ports > 1023 
(Client sends acknowledgements to Server's data port) 

 Ports used when FTP Server is in Passive Mode: 

○ FTP Server's port 21 from anywhere 
(Client initiates connection) 

○ FTP Server's port 21 to ports > 1023 
(Server responds to client's control port) 

○ FTP Server's ports > 1023 from anywhere 
(Client initiates data connection to random port specified by Server) 

○ FTP Server's ports > 1023 to remote ports > 1023 
(Server sends acknowledgments and data) to client's data port) 

○ The FTP Protocol is defined by approved RFC 959, titled “File Transfer Protocol”, and 
approved RFC 3659, titled “Extensions to FTP”, which together define the current 
accepted standard for the non-secure FTP Protocol. 

○ FTP is generally considered non-secure for the following reasons: 

 No authentication of the identity of the Server is supported, making FTP subject to 
“man in the middle” attacks where a malicious entity pretends to be the FTP Server. 

 Client login credentials are transferred in clear text, making FTP subject to credential 
interception by any entity that is capable of “sniffing” the network connection between 
the client and the Server. 

 File data is transferred unencrypted, making FTP subject to interception of any data 
transferred using this protocol. 

For the above reasons, the FTP protocol is generally considered unsuitable for security-
conscious environments or environments where the underlying network is not “intrinsically 
secure”.  In particular, the FTP protocol is generally not suitable for use in a network where 
compliance to the requirements set forth in the Payment Card Industry (PCI) security standards is 
required. 

The secure FTP over TLS (FTPS) protocol is defined by approved RFC 4217, titled “Securing 
FTP with TLS” and RFC 2228, titled “FTP Security Extensions”, which together define the current 
accepted standard for this protocol. 

FTPS is generally considered secure for the following reasons: 

 Authentication of the identity of the Server is supported, making FTPS defensible against 
“man in the middle” attacks so a malicious entity cannot successfully pretend to be the FTPS 
Server.  Note that this feature is available but is optional, since the client can choose whether 
or not to verify the Server Certificate.  Electing not to use this feature does not prevent the 
remaining features from being used. 

 Client login credentials are transferred over an encrypted Transport Layer Security (TLS) 
tunnel, protecting FTPS against credential interception by any entity that is capable of 
“sniffing” the network connection between the client and the Server. 

 File data is transferred over an encrypted TLS tunnel, protecting FTPS from interception of 
any data transferred using this protocol. 
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For the above reasons, the FTPS protocol is generally considered suitable even for security-
conscious environments and environments where the underlying network is not “intrinsically 
secure”.  In particular, the FTPS protocol is generally suitable for use in a network where 
compliance to the requirements set forth in the Payment Card Industry (PCI) security standards is 
required. 

FTPS is clearly superior with regards to security compared to FTP, but there is an overhead for 
the encryption that can reduce performance and impact battery life.  Nonetheless, in most cases, 
it is likely preferable to use FTPS over FTP.  In some cases, however, a customer may have in 
place and want to use existing FTP Servers that do not support FTPS.  In other cases, FTP may 
be needed for legacy support reasons. 

If FTP must be used, then mitigation may well be required.  In some cases, Enterprise Security 
Policy may even preclude the use of FTPS without some sort of mitigation. 

Mitigation Techniques 
The use of FTP and/or FTPS within an MSP system is not optional.  Every MSP system must 
include at least one Relay Server.  The MSP Server must be able to each every Relay Server and 
every device must be able to reach at least one Relay Server.  This means that FTP or FTPS will 
tend to be used in a highly distributed manner throughout the Enterprise Network. 

If the FTP or FTPS interfaces introduced by distributing Relay Server(s) within are deemed to 
require mitigation, then the options are fairly limited. 

Use FTPS 
Whenever practical, FTPS should be used in preference to FTP.  FTPS is highly secure and in 
the vast majority of cases, the use of FTPS alone should be an adequate mitigation to the 
Security Risks of FTP. 

Details of the FTPS Protocol 

The support for the FTPS (FTP over TLS) protocol in MSP conforms to the AUTH TLS mode 
documented in RFC 2228, titled “FTP Security Extensions” and does not support the deprecated 
AUTH SLL mode or implicit FTPS (port 990) mode.  MSP does not support the SFTP protocol, 
which is part of the SSH (secure shell) suite, and is not actually an FTP protocol. 

In the following discussions of FTPS Support, both the MSP Server and the MSP Client Software 
act as Clients of each FTPS Server used as an MSP Relay Server.  The FTPS protocol supports 
three forms of security: 

Data Encryption 

When using the FTPS protocol, all FTP traffic following the initial AUTH command is encrypted.  
Technically, FTPS can support leaving data in the clear on an FTPS connection, but MSP does 
not support the use of clear data over an FTPS connection. 

Server Verification 

This optional feature tells the Client to verify the identity of an FTPS Server to which it intends to 
communicate.  This feature can defeat man-in-the-middle attacks by preventing a rogue FTPS 
Server from successfully impersonating the actual FTPS Server. 
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This feature is enabled via the Verify Server option when defining an MSP Relay Server Object 
that uses the FTPS protocol.  When the Verify Server option is enabled, the Client will not 
communicate with the Relay Server unless it is able to Verify the identity of the Server against its 
Server Certificate. 

Use of this feature requires that an FTPS Server have a valid Server Certificate that is issued by 
a Certificate Authority (CA) that is trusted by the Client.  For best security, the use of an FTPS 
Server as an MSP Relay Server requires that a customer own or subscribe to a Public Key 
Infrastructure for issuing and managing Digital Certificates. 

For testing purposes, some FTPS Servers, including FileZilla and Microsoft IIS, provide tools for 
generating Self-Signed Server Certificates.  While such tools can be useful for testing, they are 
generally less secure and require more work to implement successfully.  Consequently, such 
Certificates should generally not be used for production deployments. 

Client Authentication 

The FTPS protocol has an optional feature that allows Client Certificates to be used to 
Authenticate the Client to the FTPS Server.  This mode is not supported by MSP.  MSP only 
supports User Name and Password Authentication with an FTPS Server, although the exchange 
of the User Name and Password occur over the secure tunnel, and hence are fully secure. 

Configuring a Relay Server to use FTPS 

When a Relay Server Object is created in MSP, either the FTP protocol or the FTPS (FTP over 
TLS) protocol can be selected for the Public and/or Private Server Details. 

 If the Private Server Details are configured to use the FTPS protocol, then the MSP Client 
Software will use the FTPS protocol exclusively when it communicates to that Relay Server. 

 If the Public Server Details are configured to use the FTPS protocol, then the MSP Server will 
use the FTPS protocol exclusively when it communicates to that Relay Server. 

It is possible to configure the Private and Public Details differently for a single Relay Server, in 
which case the MSP Client and MSP Server will use different protocols to communicate to the 
same Relay Server.  For example the MSP Server might be configured to use FTP because its 
communication is entirely within a secure network; whereas MSP Clients might be configured to 
use FTPS to provide additional security across a WLAN connection. 

Important: 

If the Public and Private Server Details for a Relay Server are configured differently, then care 
must be taken to ensure that the same folder on the Relay Server is accessed by both MSP, via 
the Public Server Details and the MSP Client Software on devices, via the Private Server Details.  
Failure to ensure this will prevent the Relay Server from successfully serving as link between the 
MSP Server and the devices. 

Troubleshooting the Use of FTPS 

Connection Errors 

When the MSP Client Software is unable to connect to a specified FTPS Server, a -1011 error will 
be returned from the connection attempt.  This error will be written to the MSP Client log file, and 
will be displayed by the MSP Client Software UI, if it is running. 
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Common Issues 

There are two common issues that can cause the Client to be unable to connect to an FTPS 
Relay Server: 

 The FTP Server does not support, or is not configured, to support “AUTH TLS” FTPS 
connections. 

 The Verify Server option is enabled and the identity of the FTPS Server cannot be verified 
against the Server Certificate. 

Invalid Server Certificate 

A Server Certificate can be determined to be invalid by the Client for several reasons: 

 The Server Certificate was not issued by a CA that is trusted by the device.  The Certificate 
must be issued by a CA that is trusted by the device (i.e. one for which the Root CA 
Certificate is installed in the Trusted Root Certificate Store on the device). 

 The common name in the Server Certificate does not match the IP Address or network name 
at which the Client is configured to access the Server. 

 The Server Certificate time window is invalid.  Certificates have a Range of Operational 
Validity and the Client verifies that the current date on the device falls within that Range of 
Operational Validity.  This error typically occurs if the Server Certificate has expired or if the 
device clock is not set correctly. 

Diagnostic Steps 

The following steps can be used to determine the issue if the Client cannot connect to an FTPS 
Relay Server. 

 Verify the Client FTPS Settings (Relay Server – Protocol and Verify Server) are set correctly. 

 Use an Ethernet network monitor, or the FTP Server logging to determine whether the Server 
is processing the FTP AUTH command.  If the Client disconnects immediately after the AUTH 
command then it generally indicates there is an issue with the Server Certificate installed on 
the device.  If the Server rejects the AUTH command then generally it means FTPS is not 
enabled on the Server. 

 Verify the device clock is set correctly.  An incorrect device clock setting can cause the 
Server Certificate to be considered invalid. 

 Use tools on the device to verify that any Certificates that are required to establish the trust of 
the issuing CA are installed and look correct. 

 Verify that the Server Certificate was issued by a CA for which the Certificate is installed in 
the Trusted Root Certificate Store of the device.  If a Self-Signed Server Certificate is used, 
then the Server Certificate is also the CA Certificate and must be installed in the Trusted Root 
Certificate Store of the device to establish trust. 

 Verify that the Server Certificate has not expired. 

 Verify that the common name in the Server Certificate matches the IP Address or network 
name defined in the Relay Server. 
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Use Non-Standard Ports 
If FTP is used, it may be advantageous to use non-standard ports to reduce the likelihood of 
casual misuse.  If FTPS is used, using non-standard ports may help comply with Enterprise 
Security Policies. 

Logical Isolation 
If necessary, Logical Isolation can be used to help mitigate the Security Risks of FTP or help to 
comply with Enterprise Security Policies.  A classic use of Logical Isolation is where a remote 
location is isolated from the rest of the Enterprise Network by using a Network Address 
Translation (NAT) Router.  This creates a local private network for the site and controls traffic 
between it and the Enterprise Network. 

A Relay Server is often located within the local private network.  Devices on the local private 
network can contact the Relay Server since they are on the same network.  Access to the Relay 
Server from the MSP Server can be accomplished via NAT Traversal. 

Alternately, a Relay Sever outside the local private network (on the Enterprise Network) may be 
used.  Devices on the local private network can contact the Relay Server since most NATs allow 
outgoing connections.  Access to the Relay Server from The MSP Server is possible because 
both are on the Enterprise Network. 

In such cases, it should be understood that the Relay Server may remain vulnerable from both 
the Enterprise Network and the local private network unless additional control is applied to limit 
access.  Using Access Control Lists (ACLs) is one way to help ensure that a Relay Server can 
only be accessed by authorized entities (typically identified by their MAC Addresses). 

This type of mitigation can be complex to implement and maintain and it could be difficult to 
demonstrate with confidence that the potential Security Risk was successfully mitigated.  Such a 
solution might be most suitable in cases where Logical Isolation was already in use for other 
reasons and needs only minor augmentation to accomplish the desired goals. 

Virtual Isolation 
If necessary, Virtual Isolation can be used to help mitigate the Security Risks of FTP or to help 
comply with Enterprise Security Policies.  Access to a Relay Server can be entirely blocked aside 
from the limited interfaces required to establish a virtual private network between the MSP Server 
and the Relay Server and/or between the devices and the Relay Server. 

Through the use of encryption and tunneling technologies a virtual private network allows FTP or 
FTPS to be encapsulated so it can be used secure manner that is generally compliant with most 
Enterprise Security Policies. 

This type of mitigation can be fairly complex to implement and maintain, although it may be 
possible to leverage a virtual networking infrastructure that is already in place.  Once 
implemented, it should be fairly easy to demonstrate with confidence that the potential Security 
Risk was successfully mitigated.  Such a solution might be most suitable if the MSP Server and 
the Relay Server were located far apart and/or separated by less secure network segments. 

Best Practices 
 Consider using FTP for improved performance if the entire end-to-end network path between 

two components is inherently secure. 
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The FTP protocol, due to its lack of encryption, can improve performance and potentially 
save on battery life, at the expense of reduced Security.  FTP should be used with caution, 
however, since the credentials used to Authenticate with the Relay Server are sent in the 
clear, which could lead to a compromising of the Security of the Relay Server and, hence, the 
MSP Server and the devices. 

If the entire end-to-end network path between the MSP Server and a Relay Server and/or 
between devices and a Relay Server is inherently secure, then use of the FTP protocol may 
be acceptable and possibly advantageous,  This is more often the case on the MSP side of 
the Relay Server than on the device side. 

 Use Secure FTP for enhanced Security if ANY portion of the end-to-end network path 
between two components is not inherently secure. 

If all segments of the network path are not inherently secure, such as when a less-than-
optimal WLAN Security option is used or when the underlying network lacks adequate 
partitioning, NATs, Firewalls, etc., then it may be advisable to use FTPS.  The FTPS protocol 
encrypts all authentication credentials and all data, thus reducing the risk when the 
underlying network is not inherently secure. 

Note: 

Using FTPS may make it easier to achieve PCI (Payment Card Industry) Compliance in 
Enterprises where credit card payments are processed. 

 Consider using a hybrid solution comprised of both FTP and FTPS. 

If the inherent Security of the network path between the MSP Server and the Relay Server 
and the network path between the devices and the Relay Server are very different, it may be 
appropriate to use FTP for one and FTPS for the other.  This can be workable so long as the 
identical file folder is accessed using both interfaces. 

 Use strong Passwords for authentication with Relay Servers and vary them by Relay Server if 
practical. 

Using a default or easy to guess Password will reduce the Security of the Relay Server and 
the MSP system as a whole even if the system would otherwise be reasonably secure. 

 Consider using Logical or Virtual Isolation if additional Security is required. 

If necessary due to Security Risks or Enterprise Security Policy, Logical or Virtual Isolation 
techniques can be applied to achieve an acceptable solution. 

MSP Console UI User Security 
MSP Console UI User Security considers the Security of MSP Console UI Users, how and from 
where they access the MSP Console UI, what activities they are allowed to perform on which 
devices, and examines approaches to minimize the Security Risks associated with poorly trained 
or malicious Users. 

Security Concerns 
This section considers the most common Security concerns that may be important to consider 
when MSP Console UI Users access the MSP Console UI from their Workstation PCs. 
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Variable User Locations 
From a network Security perspective, the locations from which Users will access the MSP 
Console UI is of paramount importance.  Some of the most common possibilities include: 

 From a Workstation PC at a secure location, via the Enterprise Network. 

 From a Workstation PC at a secure location, via a Logically Isolated local private network. 

 From a Workstation PC at a non-secure location, via the Public Internet. 

The specifics of how to configure the MSP Server to provide suitable access to the MSP Console 
UI are covered in the section on MSP Server Security. 

Unconstrained Access 
In the short term, it might seem easiest to give to just give every User the MSP Administrator 
User Password.  But if all Users log-in as the default Administrator User then all Users can 
perform any tasks and manipulate any Object or device.  Every User must wade through 
everything in an attempt to decide what the current status is and what tasks to perform.  A User 
performing a task can interfere with a User performing a different task.  The results of such a 
system will eventually be chaos unless the number of Users is quite small and all Users 
communicate very effectively. 

Mitigation Techniques 
The greatest threat to Security due to MSP Console UI Users is lack of foresight and planning.  
The easiest and least secure approach is to leave the defaults in place and let everyone start 
using MSP.  While this might be fine in a lab or evaluation environment, it is generally a bad idea 
in any production system. 

Define User Roles and User Scopes 
It is important to define the Roles that Users will hold and limit Users to perform only those tasks 
that are applicable to their assigned Roles. It is equally important to define the Scopes within 
which Users will operate and limit the visibility of Users to the domains that match their assigned 
Scopes. This has several key benefits: 

 It reduces Learning Curve since each User is offered only those tasks that are relevant to his 
assigned Role and the entities within his assigned Scope. 

 It increases Productivity since each User won’t be distracted by options that are irrelevant to 
his assigned Role and to more rapidly locate, recognize, and manipulate entities within his 
assigned Scope.. 

 It enhances Security since each User is precluded from performing tasks that are not relevant 
to his assigned Role or to access and manipulate entities outside his Scope. 

Best Practices 
 Choose non-default Passwords for the Initial MSP Users. 

When the MSP Server Software is installed, two Initial MSP Users are automatically created.  
The User Names and Passwords of these Initial MSP Users can be assigned and ideally 
should be set to non-default values to maximize the security of the MSP system. 
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It is also generally a good idea to create additional Users with the Security Role as needed 
and keep the Initial MSP Security User for “emergency” use, such as cases where a User 
with the Security Role forgets his Password. 

By having unique defined Users, each User can be limited in Role and Scope, if desired, and 
each User can set and save their own preferences without impacting other Users. 

 Create new Users with the Operations Role for those who need such capabilities. 

The Administrator Role is designed for Users who need to be able to reconfigure the MSP 
Server by adding, removing, or modifying Sites or Relay Servers.  In most cases, these 
activities should be infrequent and should be limited to highly-trained and trusted Users. 

You could say that Users with the Administrator Role are allowed to manage “How MSP 
Works.”  By contrast, Users with the Operations Role define Settings and Content and create 
and manage Staging Profiles and Provisioning Policies.  You could say that Users with the 
Operations Role control “What MSP Does.” 

 Create new Users with the Staging-Only and Provisioning-Only Roles for those who need 
only these limited capabilities. 

Users with the Operations Role can define what Settings and Content are available and what 
Staging and Provisioning can be performed using them.  Users with the Staging-Only and 
Provisioning-Only Roles are allowed to perform Staging or Provisioning, respectively, but 
cannot define or modify the Staging or Provisioning that they will perform. 

You could say that Users with these Roles are allowed to choose “When to Stage or 
Provision” and “Which devices to Stage or Provision”. 

 Create new Users with the Help Desk Roles for those who need only these limited 
capabilities. 

Users with the Operations Role can have full ability to investigate and perform 
troubleshooting on devices.  User with the Help Desk Role can investigate and initiate 
troubleshooting of devices, but generally hand off to a User with the Operations Role to 
complete troubleshooting. 

 Limit the Scope of all Users via appropriate User Access Prefixes. 

Depending on the nature of the Enterprise being managed, it might not make sense for all 
Users to have the same visibility.  Choosing the right Scope for each User can simplify the life 
of that User by showing them only those objects that apply to their area of responsibility.  It 
also can reduce or limit exposure in the event of accidental or malicious activity.  Security 
concerns also may dictate that certain Content, Policies, etc. should only be accessible by 
certain authorized Users. 

Device Security 
Device Security considers the Security of the devices managed by MSP, how they how they are 
used and managed, and examines approaches to enhance the Security of devices and protect 
the Enterprise Network from accidental or malicious impact from them. 

Security Concerns 
This section considers the most common Security concerns that may be important to consider 
about devices themselves. 
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Device is a Constraint on the Wireless Network 
In some cases, the Wireless Network Infrastructure that supports a Wireless Network may offer 
Security mechanisms that are more advanced than can be supported by some devices.  In such 
cases, in order to utilize the devices on the Wireless Network, it may be necessary to select a 
less secure Security mechanism that is common to both. 

In such cases, the devices can be seen as a constraint on the effective Security of the Wireless 
Network.  And if the Wireless Network is connected to the Enterprise Network, as is usually the 
case, then the non-optimal Security of the Wireless Network can represent a Security Risk to the 
Enterprise Network. 

Device is a Gateway into the Enterprise Network 
If a device is configured to access the Enterprise Network then the device may serve as a 
potential Gateway into the Enterprise Network.  If a malicious entity were to gain control of a 
device, it might be able to “piggy back” on the connection between the device and the Enterprise 
Network and/or it might be able to coerce the device to act as a proxy to perform malicious 
activities on the Enterprise Network. 

Device is a Source of Enterprise Data 
If a device is running an application that extracts Enterprise Data via the Enterprise Network and 
stores that data on the device, then the device could represent a Security Risk to that Enterprise 
Data.  If a malicious entity were to gain control of a device, it might be able to access or even 
modify the Enterprise Data in ways that would represent a Security Risk to the Enterprise. 

Device is a Valuable Asset 
A device is usually considered a valuable asset in its own right.  Not only does the device has an 
intrinsic value based on its cost to purchase, but the device generally has a large investment 
associated with supporting and maintaining it.  If a device is lost or stolen, then the entire 
investment in that device will be lost.  In addition, the application that was being used on the 
device will not be available until a replacement has been deployed. 

Mitigation Techniques 
The following mitigation techniques may be valuable in dealing with Device Security issues. 

Update Devices with Latest Firmware and Software 
When new Operating Systems, drivers, and patches become available for devices, they can 
affect the ability of that device to operate securely on a given Enterprise network.  It is generally 
recommended that device be updated to the latest available versions of available firmware and 
software as soon as practical. 

It is understandable that customers may be reluctant to upgrade immediately since it takes time 
and effort to revalidate their applications on a new platform, following an update to the firmware 
and software of that platform.  MSP provides powerful tools that can help reduce the cost and 
difficulty of doing so, but the cost can still be significant. 

Customers should generally incorporate the latest versions when initially rolling out devices, 
which may include firmware and software upgrades as part of the initial Staging Process.  MSP 
Staging can help reduce the cost and difficulty of this activity.  While it may be tempting to save 
time and cost by using whatever ships in the devices, this is seldom a good long term choice. 
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Once devices are deployed and in service, customers are understandably reluctant to update 
them.  This is a classic “If it’s not broke, don’t fix it” mentality.  This is not unreasonable, but when 
the time comes to roll out application fixes and upgrades, consideration should be given to 
retesting with and rolling out the latest firmware and software upgrades as well.  MSP 
Provisioning can help reduce the cost and difficulty of this activity. 

Apply Appropriate Security Options to Devices 
When choosing the Security options to apply to devices, especially Wireless Network Security, it 
is advisable to choose the most secure option that is common between the Wireless Network 
Infrastructure and the devices.  There is a tie-in with the previous section since having the latest 
firmware and software upgrades applied to a device will often increase the available Security 
options. 

There may be good and valid reasons why a less secure option may be selected when initially 
deploying devices within an Enterprise, including: 

 The limitations of some devices in a mixed population require a “common denominator” 
solution to be selected. 

 The Wireless Network Infrastructure may be old and impractical to replace or upgrade 
immediately. 

 The most secure options may require complex infrastructure support and/or may be complex 
to deploy to devices (e.g. PKI and Client Certificate deployment for EAP/TLS). 

In such cases, it may advisable to revisit the original selection and upgrade when conditions 
change, such as: 

 Some old devices that were limiting available options have been removed from service. 

 Firmware and software upgrades for devices that were limiting available options have 
become available. 

 The Wireless Network Infrastructure has been replaced or upgraded. 

 The necessary infrastructure to support more advanced options is now available. 

When the time comes to roll out new enhanced Security options, MSP Provisioning can help 
reduce the cost and difficulty of this activity. 

Control Access to Devices 
Since a device can be a potential gateway to the Enterprise Network, it is important to control 
access to the device.  If a malicious individual gains physical control of a device, they might be 
able to use that device to access information from or cause harm to the Enterprise Network.  By 
controlling access to devices, the impact of such activities can be minimized, including: 

 Control physical access to devices. 

Most customers try and do this but the very mobility of devices often makes them difficult to 
control easily.  Nonetheless, some common approaches include: 

○ Performing periodic inventory counts of devices, such as when they should be in 
charging stations. 

○ Affixing highly visible labels or asset tracking tags to devices. 

○ Check devices out to Device Users and hold them accountable for returning them. 
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○ Store devices in a secure location when not in use. 

○ Track and manage devices as assets. 

All of the ideas discussed above for physically controlling device may help, but they all rely on 
manual processes that are quite subject to human error.  It is often advisable to augment 
such manual processes with automated systems to make them more efficient.  MSP Asset 
Management can help allow devices to be tracked and can help detect devices that appear to 
be lost or stolen.  This can be used to provide a cross-check and feedback-loop to the 
manual processes to help make them more efficient. 

 Authenticate Device Users to verify that they are trusted. 

If a device is in the hands of an untrusted person, that device becomes a potential Security 
Risk.  By requiring a Device User to Authenticate, it is possible to reduce the likelihood of an 
untrusted person using the device for nefarious purposes.  The UserAuth Control Module can 
help secure devices if a suitable authentication scheme is not already part of the application 
system.  For more information on the UserAuth Control Module, see Understanding MSP 
3.3.1 – Understanding Control Modules. 

Requiring a Device User to remember and enter a User Name and Password, especially a 
strong Password, can have a negative productivity impact.  Additionally the deployment and 
maintenance of an authentication infrastructure can add significant cost.  A balance needs to 
be stuck between the Security benefits of authentication and the costs to implement it. 

 Block access to non-essential activities by Device Users. 

Not all Device Users need access to all activities that might be possible on a device.  For 
example, most Device Users should not need access to the Operating System shell and its 
wealth of tools and utilities.  In most cases, Device Users should be locked into one or more 
line of business applications. 

In some cases, it may be prohibitively difficult to build all desired functionality into a set of 
custom applications.   In other cases, standard off-the-shelf applications or application 
environments may be used that do not enable full customization.  In such cases, it may be 
necessary to permit Device Users some limited access to non-application device services in 
order to enable key use cases. 

It is important to think through as many use cases as possible to get an overall picture of how 
Device Users will need to use devices and what capabilities they will need to access to 
accomplish their intended jobs.  The device should then be configured to enable access to 
the required services and block access to those that are not required and could be harmful if 
misused. 

Device User authentication may be used to augment this process, assigning different roles to 
different Device Users and providing customized access to device services based on the role 
assigned to a Device User. 

MSP currently does not offer a turnkey solution to help with these tasks, although new 
capabilities are under investigation and are expected to become available in future releases 
of MSP.  As such capabilities are developed, either as part of MSP or as part of a custom 
application system, MSP Provisioning can help deploy, manage, and track them. 

Discourage Theft of Devices  
There are many reasons why a device might be stolen.  Device theft for truly malicious reasons 
will require serious countermeasure.  But in some cases, a bit of thought and planning could help 
eliminate many of the reasons for the casual theft of devices.  For example: 
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 Choosing devices that are larger and/or that have less “consumer appeal” can make them 
less desirable. 

 Controlling devices as described in the prior section can make stolen devices effectively 
useless. 

 Tracking devices can discourage theft by focusing unwanted attention on the last known 
Device User. 

Detect and Handling Missing Devices 
Despite all control methods employed, it is likely inevitable that some devices will go “Missing”.  
Whether a device is misplaced, stolen, has quit working, any device that cannot be accounted for 
must generally be considered a potential Security Risk.  A device is generally declared missing 
when no contact from the device has been received for a sustained duration.  MSP Asset 
Management provides a mechanism to identify devices that have gone “Missing”. 

Once a device has been determined to be “Missing”, there is little that can be done remotely, 
since the device is out of contact and its whereabouts are unknown.  Nonetheless, there may be 
some information that is known about the device that can help with an investigation. 

The last known Device User and the last known device location could be invaluable in tracking 
down what may have happened to a device. 

The UserAuth Control Module may help with tracking the last known Device User.  For more 
information on the UserAuth Control Module, see Understanding MSP 3.3.1 – Understanding 
Control Modules. 

MSP Asset Management may help with tracking the last known device location.  For more 
information on the MSP Asset Management, see Using MSP 3.3.1 – Using Asset Management. 

While it is limited what a management system, such as MSP, can do about a device that is 
determined to be “Missing”, there are some ways in which it may help, including: 

 Make it easier to detect when a device is “Missing”. 

MSP Asset Management can help to detect when a device has not been heard from and 
should be considered “Missing”. 

 Allow a device to be automatically locked down if it reappears. 

When a device is detected as being “Missing”, MSP Provisioning can help to automatically 
lock the device down and/or destroy critical data if the device returns. 

 Pre-configure devices with local policies so they can lock themselves down and/or destroy 
critical data locally if they are determined to be “Missing”. 

The MSP LockAndWipe Control Module can help configure devices so they can 
autonomously take action to prevent themselves under conditions where they are 
unmanaged and potentially at risk. 

Protect Data Stored on Devices 
Since a device can potentially hold Enterprise Data, it is important to protect such data while it is 
on a device.  There are various ways to approach this, including: 

 Discourage device theft, as described in a prior section. 

 Control access to the device, as described in a prior section. 
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 Detect and handle “Missing” devices, as described in a prior section. 

 Encrypt data stored on a device. 

If critical Enterprise Data will be stored on a device, it may be advisable to encrypt that data 
so it will not be compromised in the event that the device is stolen.  This might be 
accomplished by encrypting data at the Operating System level or at the application level.  
Third-party solutions are available for some devices to address this need. 

MSP currently does not offer a turnkey solution to help with data encryption, although new 
capabilities are under investigation and are expected to become available in future releases 
of MSP.  As such capabilities are developed, either as part of MSP, as part of a third-party 
solution, or as part of a custom application system, MSP Provisioning can help deploy, 
manage, and track them. 
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Chapter 5 – MSP and AAA 

What is AAA? 
In computer security, AAA commonly stands for “authentication, authorization and accounting.” 
This is a misnomer, and should have been “authentication, access control and accounting”. 

(Wikipedia) 

Even though the term AAA may suffer from some inaccuracy, it nonetheless represents a 
common industry term used to describe a standard requirement for the security aspects of a 
system.  As such, it makes sense to describe MSP in terms of its AAA capabilities. 

What is Authentication? 
Authentication refers to the process where one entity verifies another entity's claim to holding a 
specific digital identity. Commonly one entity is a client (a User, a client computer, etc.) and the 
other entity is a Server (computer). Authentication is accomplished via the claimant's presentation 
of an identifier and its corresponding credentials to the verifier. Examples of types of credentials 
are Passwords, one-time tokens, Digital Certificates, and phone numbers (calling/called) 

(Wikipedia) 

What is Authorization? 
This is a misnomer, and should have been Access Control. "To authorize" means "to specify 
access Policy" which is also an important security function, but which is not explicitly part of AAA. 
The function that the middle "A" in AAA actually refers to is "access control", i.e. the granting or 
refusing of privileges to an entity for accessing specific services. When reading AAA literature, 
"authorization" must be interpreted as "access control". The access control function uses the 
access Policy specified for an entity to determine whether an access requests from the entity 
shall be granted or rejected. Access control may be based on restrictions, for example time-of-
day restrictions, or physical location restrictions, or restrictions against multiple logins by the 
same entity or User. Access privileges normally enable an entity to use a specific service. 
Examples of types of service include, but are not limited to: IP Address filtering, address 
assignment, route assignment, QoS/differential services, bandwidth control/traffic management, 
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compulsory tunneling to a specific endpoint, and encryption. 

(Wikipedia) 

As suggested in the above definition, there is a valid complaint about the use of word 
“Authorization” in the standard industry usage of AAA.  For the purposes of this document, we will 
follow the convention described above and consider that “Authorization” should be interpreted as 
“Access Control” wherever it is used. 

What is Accounting? 
Accounting refers to the tracking of the consumption of network resources by Users. This 
information may be used for management, planning, billing, or other purposes. Real-time 
accounting refers to accounting information that is delivered concurrently with the consumption of 
the resources. Batch accounting refers to accounting information that is saved until it is delivered 
at a later time. Typical information that is gathered in accounting is the identity of the User, the 
nature of the service delivered, when the service began, and when it ended. 

(Wikipedia) 

AAA in MSP 
Within MSP, the term AAA is used in a way that is fairly consistent with the standard definitions 
provided above.  Nonetheless, it is worth explaining each component of AAA as it is used in MSP 
and detailing how it works and is used. 

MSP Authentication 
MSP Authentication is used to refer to method(s) used to verify the identities of MSP Console UI 
Users requesting access to the MSP Console UI.  Authentication is generalized through the use 
of Authentication Sources. 

Pre-defined MSP Users 
The MSP Server installation process creates two Initial MSP Users, one with a User Role of 
Security and one with a User Role of Administrator.  As part of the installation process, the User 
Names and Passwords of these two Initial MSP Users can be assigned.  For more information on 
the MSP Installation process, refer to the MSP 3.3.1 Install Guide. 

The Initial MSP User with the Security User Role will be referred to as the Initial Security User 
and the Initial MSP User with the Administrator User Role will be referred to as the Initial 
Administrator User. 

The Initial Administrator User has a User Name of “admin” and is able perform all MSP 
administration functions, including administering Site and Relay Server Objects. 

The Initial Security User has a User Name of “security” and is able perform all MSP functions 
related to the security of the MSP Server itself.  In particular, the pages of the Security tab of the 
MSP Console UI are available, as is access to the MSP Users in the MSP Authentication 
Database, and the ability to manage Authentication Sources. 

MSP Authentication Sources 
Each MSP Authentication Source defines a specific method that will be used to Authenticate a 
collection of Users that can request access to the MSP Console UI.  The following sections 
describe the available MSP 3.3.1 Authentication Sources. 
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MSP Authentication Database 

The MSP Authentication Database is always installed as part of MSP 3.3.1 as a built-in 
Authentication Source.  There must always be exactly one instance of the MSP Authentication 
Database.  It is therefore not possible to create or delete Authentication Sources of this type.  It 
is, however, possible to Deactivate the single instance of the MSP Authentication Database if it is 
desirable to not use it. 

The MSP Authentication Database is mandatory to use when MSP 3.3.1 is first installed since it 
allows initial login to the MSP Console UI as the built-in User “security” and hence allows 
administration of User in the MSP Authentication Database and the administration of other 
Authentication Sources. 

MSP Console UI Users that are Authenticated using the built-in MSP Authentication Database 
Authentication Source are called MSP Users, since they are Authenticated for use of the MSP 
Console UI directly by MSP.  MSP Console UI Users that are Authenticated using any other 
Authentication Sources are called Non-MSP Users, since they are Authenticated for use of the 
MSP Console UI indirectly by MSP via some external Authentication Server. 

Note: 

Any User with the Security User Role can delete MSP Users and Non-MSP Users, including the 
Initial MSP Users created during installation.  However, the MSP Authentication Database must 
always have at least one User with the Security User Role and one User with the Administrator 
User Role.  This means that it will not be possible to delete the only User of either of these Roles. 

Any User with the Security User Role can also administer other Authentication Sources.  Once 
one more other Authentication Sources have been created and Activated, it may be desirable to 
Deactivate the MSP Authentication Database.  This can enhance the overall security of MSP 
since the MSP Authentication Database does not offer the ability to enforce security policies, 
such as Password length and strength, periodic Password change, etc. 

Important: 

Managing Authentication Sources is limited to MSP Console UI Users with the Security User 
Role.  If the Authentication Source for the MSP Authentication Database is Deactivated and there 
are no Users with the Security User Role that can be Authenticated through any Activated 
Authentication Sources, then it would become impossible to administer Authentication Sources 
thereafter. 

Lightweight Directory Access Protocol (LDAP) 

An LDAP Authentication Source defines the information needed to connect to any LDAP-
compliant Authentication Server (e.g. OpenLDAP, Microsoft Active Directory, etc.).  An LDAP 
Authentication Source is then used to Authenticate credentials for MSP Console UI Users 
seeking access to the MSP Console UI. 

MSP Console UI Users that are Authenticated using the built-in MSP Authentication Database 
Authentication Source are called MSP Users, since they are Authenticated for use of the MSP 
Console UI directly by MSP.  MSP Console UI Users that are Authenticated using any other 
Authentication Sources are called Non-MSP Users, since they are Authenticated for use of the 
MSP Console UI indirectly by MSP via some external Authentication Server. 

Using LDAP Authentication Sources can provide the following security enhancements compared 
to using the internal MSP Authentication Database: 
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 Authentication credentials need be kept only in the existing secure Authentication 
database(s) used within the Enterprise. 

 Backup of Authentication credential database(s) via the existing tools used within the 
Enterprise. 

 New MSP Users can be added or removed via the existing tools used within the Enterprise 
and without requiring login to the MSP Console UI. 

 MSP Users can perform their own Password maintenance via the existing tools used within 
the Enterprise. 

Important: 

Creating an LDAP Authentication Source will require potentially sensitive information about the 
Authentication Server it will be used to access, including the Uniform Resource Locator (URL) of 
the LDAP interface of the Authentication Server and a User Name and Password that can be 
used to Authenticate to that Authentication Server.  In addition, some important, but less sensitive 
information will be required, including the names of key fields in the Directory Tree and filter 
criteria needed to select Users who will be granted access to the MSP Console UI. 

When using the MSP Authentication Database to Authenticate Users for access to the MSP 
Console UI, MSP knows in advance, as part of the definition of each User in the MSP 
Authentication Database, what User Roles and User Access Prefixes to assign.  But when using 
an LDAP Authentication Source, MSP will usually not have prior knowledge of the individual 
Users that will login.  As a result, MSP cannot know in advance what User Role and User Access 
Prefixes to assign to individual Users. See the information on mapping user roles in the section 
below. 

Directory Server Connection Details 

The connection to any Directory Server source is made up of several pieces. The following are 
necessary components for connecting MSP.  

Important: 

To view LDAP configurations that were successfully tested with MSP 3.3.1, see the chart in the 
MSP 3.3.1 Release Notes. 

 

Format Properties for Connection Parameters 

The connection parameters that define how MSP connects to the Directory Server must be 
provided in a specific way. The pieces that make up the connection and the valid format options 
that may be used are defined here. 

Note: 

The various parameters used in connecting to the Directory Server may or may not be case 
sensitive and depends on your Directory Server type and configuration. Testing your particular 
environment will determine the exact format you need to use. 

 Fully Qualified Name variations 

There are two primary variations used in the connection URL for the Directory Server naming 
convention. The acronyms listed here will be referenced in the following format options. 
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a. FQHN – Fully Qualified Host Name (ie. server.domain.com) 

b. FQDN – Fully Qualified Domain Name (ie. domain.com) 

 Required Authentication URL Format 

There are several possible URL formats which may be used when connecting to a Directory 
Server. Depending on your chosen connection type, you may be restricted to use of a 
particular format. Use this list to reference the different possible formats. The specific format 
required depends on your connection options chosen. You may or may not need to designate 
the port number. You also may or may not need to designate the “dc=domain,dc=com” 
identifier. The acronyms listed here will be referenced in Table 3 – Directory Server 
Authentication Type Connection Options. 

c. LDAP://FQHN  or  LDAP://FQHN:port#  or  LDAP://FQDN/dc=domain,dc=com 

Example: LDAP://server.domain.com:636/dc=domain,dc=com 

d. LDAP://FQDN  or  LDAP://FQDN:port#  or  LDAP://FQDN/dc=domain,dc=com 

Example: LDAP://domain.com:636/dc=domain,dc=com 

e. LDAP://ipaddr or  LDAP://ipaddr:port# or LDAP://ipaddr:port#/dc=domain,dc=com 

Example: LDAP://10.0.0.1/dc=domain,dc=com 

 Required Authentication Username Format 

There are three primary variations used for the username format to connect to a Directory 
Server source from MSP. The example formats are listed here. The specific format required 
depends on your connection options chosen. The acronyms listed here will be referenced in 
Table 3 – Directory Server Authentication Type Connection Options. 

f. simple username (ie. username) 

g. fully qualified username (ie. user@FQDN) 

h. distinguished username (ie. cn=username,dc=domain,dc=com) 

 Required Authentication Source “Auth By” Field Format 

There are two primary format options that may be used in the “Auth By” field when creating 
the Authentication Source in the MSP UI. The example formats are listed here. The specific 
format required depends on your connection options chosen. The acronyms listed here will 
be referenced in Table 3 – Directory Server Authentication Type Connection Options. 

i. USER_NAME 

j. USER_NAME@FQDN 

Connection Authentication Options 

The following table describes the different connection options available based on the 
authentication type used to connect to the Directory Server. It references the letter designators for 
the format options listed above. The last column indicates what should be contained in the long 
string value of the Auth By field in the MSP UI. In most cases, the string value that appears in this 
field by default is already correct however you may need to make a slight modification to the 
username based on your selected authentication type. For more details see the Help menu for 
the Authentication Source create page in the MSP UI. 
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Table 3 – Directory Server Authentication Type Connection Options 
 

DS Auth Type 
Authentication 
URL Format 

Authentication 
Username 
Format 

SSL 
Supported? 

Auth By Field 
values in MSP 
UI 

AD Basic (c), (d), (e) (f), (g) yes 

default string 
value containing 
username w/ 
format (i) or (j) 

AD Kerberos (c), (d) (g) only no 

default string 
containing 
username w/ 
format (j) only 

AD Negotiate (c), (d), (e) (f), (g) yes 

default string 
value containing 
username w/ 
format (i) or (j) 

AD NTLM (c), (d), (e) (f), (g) yes 

default string 
value containing 
username w/ 
format (i) or (j) 

AD Digest (c), (d) (g) only yes 

default string 
containing 
username w/ 
format (j) only 

Non-AD Basic (c), (d), (e) (h) only yes 

this could vary 
depending on 
the configured 
properties in 
your non-AD 
LDAP server 

Note: 

The standard LDAP port is 389 for most Directory Servers. The standard default port for SSL is 
636. When using SSL, the port must be specified in the URL using the :port# identifier. 

MSP Authorization 
MSP Authorization is used to refer to types of Access Control that are available to restrict what a 
given User can do within the MSP Console UI once they have successfully Authenticated.  The 
MSP User information that controls MSP Authorization consists of the User Role and the User 
Access Prefixes.  
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User Role 
As discussed in this document in Understanding Objects, the User Role for an MSP Console UI 
User defines the functionality of the MSP Console UI that will be made available to that User once 
they are Authenticated.  A User Role represents a collection of MSP Console UI features that will 
be exposed to a User that is assigned that Role. 

A fixed set of User Roles is pre-defined, but this set can be altered or extended as needed.  This 
allows for a high degree of flexibility and control over what MSP Console UI functionality is 
enabled for use by various Users. 

User Access Prefixes 
As discussed in this document in Understanding Objects, the User Access Prefixes for an MSP 
Console UI User define what Objects will be visible to that User once they are Authenticated. 

MSP Accounting 
MSP Accounting is used to refer to tracking activities performed by Users, including the identity of 
the User (by User Name), the activity performed, when the activity was initiated, the Object 
affected by the activity, and an optional Transaction Code and/or Note entered by the User when 
the activity was initiated. 

Accounting is supported to track activities performed throughout the entire MSP Console UI so 
long as those activities directly or Indirectly result in Content being delivered to devices. 

It was deemed to be unnecessary and likely to negatively impact performance and scalability of 
the system to log all activities performed via the MSP Console UI.  Instead, Accounting is focused 
on those activities that deemed most likely to impact devices. 

Viewing the Audit Log 
MSP Accounting can be viewed in a variety of ways as described in the following subsections.  
More information on viewing the Audit Log can be found in this document in Understanding the 
MSP Console UI. 

Globally 

Viewing the Audit Log Globally shows all tracked activities in the order they occurred, regardless 
of which User(s) performed those activities or which Object(s) were affected by those activities. 

By User 

Viewing the Audit Log By User shows the tracked activities performed by a selected User, in the 
order they occurred, regardless of which Object(s) were affected by those activities. 

By Object 

Viewing the Audit Log By Object shows the tracked activities that affected a selected Object in 
the order they occurred, regardless of which User(s) performed those activities. 
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Chapter 6 – MSP Security Objects 

What are Security Objects? 
Security Objects are used to define what MSP Console UI functionality will be made available 
which User and how potential Users will Authenticate that they are who they say they are and are 
entitled to use MSP functionality. 

Security Objects are often created very early, before Objects of most other categories are created 
and soon after the installation of an MSP Server.  Security Objects can and likely will be created 
over time to keep pace with the changing nature of the Enterprise.  Nonetheless, Security Objects 
are usually amongst the first Objects created. 

Figure 11 below illustrates the various types of Security Objects and identifies which Security 
Objects can reference other Objects and how and when they are most commonly used. 

 

Figure 11 – Security Objects 
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Authentication Source Objects 
When you create an Authentication Source Object in MSP, you provide information to MSP about 
specific methods that will be used to Authenticate collections of MSP Console UI Users for 
access to the MSP Console UI. 

For more information on the purpose and uses of Authentication Source Objects, see Chapter 5 – 
MSP and AAA. 

For more information on creating Authentication Source Objects, see the MSP Online Help – 
Create Authentication Source. 

User Role Objects 
When you create a User Role Object in MSP, you provide information to MSP about the 
categories or classes of Users that will be allowed to Authenticate to the MSP Console UI and the 
functionality that Users assigned to each User Role will be allowed to perform. 

Pre-defined User Roles 
The following User Roles are pre-defined: 

Security User Role 
The Security User Role would typically be assigned to MSP System Administrators that should be 
allowed to perform security-related administration of MSP, including: 

 Creating and Managing Authentication Source Objects. 

For more information on Authentication Source Objects, see earlier in this chapter and see 
Chapter 5 – MSP and AAA. 

 Creating and Managing User Role Objects. 

For more information on User Role Objects, see earlier in this chapter and see Chapter 5 – 
MSP and AAA. 

 Creating and Managing User Objects. 

For more information on User Objects, see earlier in this chapter and see Chapter 5 – MSP 
and AAA. 

 Viewing MSP Audit Logs. 

For more information on the use of Audit Logs, see Chapter 5 – MSP and AAA. 

 Exporting and Importing all Objects. 

For more information on exporting and importing Objects, see Chapter 10 – Object 
Administration. 
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Administrator User Role 
The Administrator User Role would typically be assigned to MSP System Administrators that 
should be allowed to perform non-security-related administration of MSP, including: 

 Creating and Managing Site Objects. 

For more information on Site Objects, see Chapter 7 – MSP Administrative Objects. 

 Creating and Managing Relay Server Objects. 

For more information on Relay Server Objects, see Chapter 7 – MSP Administrative Objects. 

 Creating and Managing Definition Document Objects. 

For more information on Definition Document Objects, see Chapter 7 – MSP Administrative 
Objects. 

 Creating and Managing License Key Objects. 

For more information on License Key Objects, see Chapter 7 – MSP Administrative Objects. 

 Creating and Managing SMS Carrier Objects. 

For more information on SMS Carrier Objects, see Chapter 7 – MSP Administrative Objects. 

 Creating and Managing Relationship Definition Objects. 

For more information on Relationship Definition Objects, see Chapter 7 – MSP Administrative 
Objects. 

 Exporting and Importing non-Security-related Objects. 

For more information on exporting and importing Objects, see Chapter 10 – Object 
Administration. 

Operations User Role 
The Operations User Role would typically be assigned to MSP Console UI Users that should be 
allowed to perform any or all Device Management functions of MSP. 

For more information on the Device Management functions available to MSP Console UI Users 
that are assigned the Operations User Role, see Understanding MSP 3.3.1 – Understanding 
Objects. 

Provisioning User Role 
The Provisioning User Role would typically be assigned to MSP Console UI Users that should be 
allowed to perform any or all Device Provisioning functions of MSP. 

For more information on the Device Provisioning functions available to MSP Console UI Users 
that are assigned the Provisioning User Role, see Understanding MSP 3.3.1 – Understanding 
Objects. 

Staging User Role 
The Staging User Role would typically be assigned to MSP Console UI Users that should be 
allowed to perform any or all Device Staging functions of MSP. 
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For more information on the Device Staging functions available to MSP Console UI Users that 
are assigned the Staging User Role, see Understanding MSP 3.3.1 – Understanding Objects. 

Help Desk User Role 
The Help Desk User Role would typically be assigned to MSP Console UI Users that should be 
allowed to perform any or all Device User Support functions of MSP. 

For more information on the Device User Support functions available to MSP Console UI Users 
that are assigned the Help Desk User Role, see Understanding MSP 3.3.1 – Understanding 
Objects. 

Guest User Role 
The Guest User Role would typically be assigned to MSP Console UI Users that should be 
allowed to perform any or all High-Level Device Status functions of MSP. 

For more information on the High-Level Device Status functions available to MSP Console UI 
Users that are assigned the Guest User Role, see Understanding MSP 3.3.1 – Understanding 
Objects. 

Custom User Roles 
Custom User Roles are typically defined when no Pre-defined User Role exactly captures the set 
of functionality to be assigned to a given MSP Console UI User.  This would most commonly be 
done when there is a need to add or subtract capabilities from an existing Role. 

Notes: 

While it is possible to create a Custom User Role from scratch, it can be quite a lot of work to do 
so since the granularity of function selection is quite fit.  Furthermore, it is easy to create a 
“nonsensical” Custom User Role by assigning a combination of capabilities that do not fit well 
together.  It is recommended that new Custom User Roles be created by using the Copy link in 
the Related Tasks area of the Role Detail page for an existing User Role and then add or 
remove capabilities. 

When Custom User Roles are defined and assigned to MSP Console UI Users, those MSP 
Console UI Users will generally need to be informed in some manner of the unique set of 
functionality granted to them by the assignment of those Custom User Roles. 

For more information on creating User Role Objects, see the MSP Online Help – Create Role. 

User Objects 
When you create a User Object in MSP, you provide information to MSP about User that will be 
allowed to Authenticate to the MSP Console UI, how they will Authenticate, and what Role and 
Scope they will have once they Authenticate.  There are two types of User Objects in MSP, MSP 
User Objects and Non-MSP User Objects. 

For more information on the purpose and use of User Objects, see Chapter 5 – MSP and AAA. 

For more information on creating User Objects, see the MSP Online Help – Create MSP User or 
Create Non-MSP User. 
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Chapter 7 – MSP Administrative Objects 

What are Administrative Objects? 
Administrative Objects are used to define the information about the Enterprise that MSP needs to 
operate properly within the Enterprise.  Administrative Objects are available in all MSP Editions 
and are manageable and usable by MSP Console UI Users with a Role of Administrator or higher 
and usable by all MSP Console UI Users. 

Administrative Objects are often created very early, before Objects of most other categories are 
created and soon after the installation of an MSP Server.  Administrative Objects can and likely 
will be created over time to keep pace with the changing nature of the Enterprise.  Nonetheless, 
Administrative Objects are usually amongst the first Objects created. 

Like all Objects, if an Administrative Object references another Object, the other Object must be 
created first.  For this reason, Administrative Objects are generally created in a common order 
due to the nature of the references that typically exist between them.  The descriptions of 
Administrative Objects will be presented in the order in which they will most commonly be 
created. 

Figure 12 below illustrates the various types of Administrative Objects and identifies which 
Administrative Objects can reference other Objects and how and when they are most commonly 
used. 
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Figure 12 – Administrative Objects 

Relay Server Objects 
When you create a Relay Server Object in MSP, you are providing information to MSP about FTP 
or FTPS Servers that exist on the Enterprise network and that MSP can to communicate with 
devices that will be Directly Managed by MSP. 

A given Relay Server Object can be in one of two states: Activated or Deactivated.  When a 
Relay Server Object is created, it starts out Deactivated and must be Activated explicitly before 
MSP will begin attempting to contact it using the supplied information. 

Notes: 

For more information on creating Relay Server Objects, see the MSP Online Help – Create Relay 
Server. 

For more information on Activating and Deactivating Relay Server Objects, see the MSP Online 
Help – Activate and Deactivate Relay Server. 

It is not unreasonable to create a Relay Server Object that references a given FTP or FTPS 
Server before that server exists and can be contacted.  But it is usually best not to Activate a 
Relay Server Object until the FTP or FTPS Server its references exists and can be contacted.  
This will avoid unnecessary repeated failed attempts by MSP to contact that server. 
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Network Settings Objects 
Network Settings are created from the Settings page of the Library tab of the MSP Console UI.  
When you create a Network Settings Object in MSP, you are providing information to MSP about 
some network within the Enterprise.  MSP will use this information to configure devices to 
communicate via that network.  Since there may be various kinds of network connectivity possible 
for various devices, Network Settings Objects of various Settings Classes may need to be 
created. 

Note: 

For more information on creating Network Settings Objects, see the information on each Settings 
Class in the MSP Online Help – Setting Create. 

For convenience, some of the more common Network Settings Classes are briefly explained in 
the following subsections 

Network.WLAN.FusionPublic 
The Network.WLAN.FusionPublic Settings Class can be used to configure WLAN network 
settings on Motorola and Symbol devices with Fusion WLAN Stacks that support the “Fusion 
Public” API (e.g. devices with Fusion versions of 2.5 or above). 

Note: 

A Network.WLAN.FusionPublic Settings Object can be used to configure WLAN network settings 
on Motorola and Symbol devices with Fusion WLAN Stack versions 3.00 and higher.  While this 
works, it likely will not be able to leverage newer capabilities of such newer Fusion versions.  To 
leverage newer features of newer versions of Fusion, a Network.WLAN.Fusion30Public Settings 
Object may need to be used. 

Network.WLAN.Fusion30Public 
The Network.WLAN.Fusion30Public Settings Class can be used to configure WLAN network 
settings on Motorola and Symbol devices with Fusion WLAN Stacks of version 3.00 or higher. 

Notes: 

Any attempt to use a Network.WLAN.Fusion30Public Settings Object to configure Motorola and 
Symbol devices with Fusion WLAN Stack versions below 3.00 will result in an error. 

A Network.WLAN.FusionPublic Settings Object can be used to configure Motorola and Symbol 
devices with Fusion WLAN Stack versions 3.00 and higher.  While this works, it will likely not be 
able to leverage newer capabilities of such newer Fusion versions.  To leverage newer features 
of newer versions of Fusion, a Network.WLAN.Fusion30Public Settings Object may need to be 
used. 
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Network.WLAN.Legacy 
The Network.WLAN.Legacy Settings Class can be used to configure WLAN network settings on 
Motorola and Symbol devices with Motorola and Symbol Legacy WLAN Stacks.  This includes 
Motorola and Symbol devices with a Motorola Fusion WLAN Stack that does not support the 
“Fusion Public” API (e.g. devices with Fusion versions earlier than 2.5).  This includes Motorola 
and Symbol devices equipped various versions of the Symbol Mobile Companion WLAN Stack. 

Note: 

A Network.WLAN.Legacy Settings Object might be used to configure devices with some 
Motorola and Symbol devices with Fusion versions higher than 2.5, but this cannot be guaranteed 
for any specific Fusion version.  If it works, it will likely not be able to leverage newer capabilities 
of such newer version of Fusion.  To leverage newer features of newer versions of Fusion, a 
Network.WLAN.FusionPublic Settings Object or a Network.WLAN.Fusion30Public Settings Object 
may need to be used. 

The Network.WLAN.Legacy Settings Class can also be used to configure WLAN network settings 
on devices with various versions of the Microsoft Windows Zero Configuration (a.k.a. “Zero 
Config” or “WZC”) WLAN Stack. 

Note: 

A Network.WLAN.Legacy Settings Object can be used to configure devices with Microsoft 
Windows Zero Configuration WLAN Stacks, but the support is limited and may not support all the 
capabilities available with newer versions of Microsoft Windows Zero Configuration.  To leverage 
newer features of newer versions of Microsoft Windows Zero Configuration, a 
Network.WLAN.ZeroConfig Settings Object may need to be used. 

a Network.WLAN.Legacy Settings Object can sometimes be used to allow a mixed population of 
devices with a variety of different WLAN Stacks to be configured using a single common Settings 
Object. 

Notes: 

This type of “least common denominator” approach generally works well only for simple WLAN 
networks where all of the features that are required to configure all devices onto that network fall 
within a common subset of capabilities.  While this may work in some cases, it may also result in 
non-optimal configuration of some devices. 

Beginning with MSP 3.3.1, a more flexible solution to the same problem may be achieved through 
the use of Settings Families.  For more information on Settings Families, see Understanding MSP 
3.3.1 – Understanding Objects. 
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Network.WLAN.ZeroConfig 
The Network.WLAN.ZeroConfig Settings Class can be used to configure WLAN network settings 
on devices with various versions of the Microsoft Windows Zero Configuration (a.k.a. “Zero 
Config” or “WZC”) WLAN Stack. 

Notes: 

A Network.WLAN.Legacy Settings Object can be used to configure devices with Microsoft 
Windows Zero Configuration WLAN Stacks, but the support is limited and may not support all the 
capabilities available with newer versions of Microsoft Windows Zero Configuration. 

Unlike the Network.WLAN.Legacy Settings Class, the Network.WLAN.ZeroConfig Settings Class 
is designed to support newer versions of the Microsoft Windows Zero Configuration WLAN Stack 
and is maintained to keep pace with new additions and changes made by Microsoft over time.  To 
leverage newer features of newer versions of Microsoft Windows Zero Configuration, a 
Network.WLAN.ZeroConfig Settings Object may need to be used. 

Microsoft relies on device manufacturers to implement key portions of the support for the 
Microsoft Windows Zero Configuration WLAN Stack.  The implementation provided by a device 
vendor will determine whether it is fully compatible or not.  Microsoft does not require that a 
device provide API compatibility.  Nor does Microsoft provide or require the execution of any 
compatibility tests to verify API compatibility.  If a device uses the Microsoft Windows Zero 
Configuration WLAN Stack and is fully compliant to the Microsoft-defined API, then the 
Network.WLAN.ZeroConfig Settings Class should be usable to configure it. 

Network.WWAN.GPRS 
The Network.WWAN.GPRS Settings Class can be used to configure WWAN network settings on 
devices with Windows Mobile Phone Edition version 5.0 or hgher and which are equipped with 
GPRS radios (or compatible technologies, such as EGPRS, EDGE, HSDPA, etc.). 

Note: 

The Network.WWAN.GPRS Settings Class only supports devices with WWAN radios based on 
GPRS technologies.  It does not support devices with WWAN radios based on iDEN or CDMA (or 
compatible technologies, such as 1xRTT or EVDO). 

Site Objects (Optional) 
When you create a Site Object in MSP, you are providing information to MSP about locations 
within the Enterprise where devices may be used.  Sites are an optional but valuable feature of 
MSP that allow you to manage devices based on the logical locations within the Enterprise where 
devices are or may be used. 
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A Site can be defined to be a Staging Site (i.e. a location where Staging of devices occurs), a 
Production Site (i.e. a location where devices are in production use), or Both.  When a Site is 
defined to be a Staging Site or Both, the Staging Scope of that Site must also be defined.  The 
possible choices are: 

 Enterprise 

Enterprise Staging Scope indicates that Staging performed at a Staging Site might be for any 
Production Site in the Enterprise.  For example, if devices are Staged at a central Staging 
Site and then physically shipped to various Production Sites, then that Site would make 
sense to define as having Enterprise Staging Scope. 

When a Site is defined to have Enterprise Staging Scope, then Production Site Bundle and 
referenced Packages and Settings for every Production Site will need to be sent to the Relay 
Server referenced by that Site. 

Important: 

If there are many Production Sites, this could result in a fair volume of traffic for a 
single Site with Enterprise Staging Scope.  If there are also many Sites with 
Enterprise Staging Scope, this could result in a very high volume of traffic on the 
Enterprise network. 

 Local 

Local Staging Scope indicates that Staging performed at a Staging Site will only be for use at 
that one local Site.  For example, if a Site is both a Staging Site and a Production Site, and if 
all Staging for use at that Site is done at that Site, then that Site would make sense to define 
as having Local Staging Scope. 

When a Site is defined to have Local Staging Scope, then only the Production Site Bundle 
and referenced Packages and Settings for that one local Site will need to be sent to the Relay 
Server referenced by that Site. 

Important: 

While defining a Site to have Local Staging Scope can significantly reduce traffic, it 
also results in a loss of functionality.  In particular, it will not be possible to pull the 
Production Site Bundle from the Relay Server for any Site except that one local Site.  
This could interfere with the use of the AutoSiteAssign Control Module since it may 
rely on the ability to pull the Production Site Bundle for any Production Site from any 
Relay Server.  For more information on the AutoSiteAssign Control Module, see 
Understanding MSP 3.3.1 – Understanding Control Modules. 

A Site Object can optionally reference the following other types of Objects: 

 Network Settings 

Referencing a Network Settings Object from a Site Object can be useful to define the 
Network Settings that are used at a given location, especially for WLAN networks.  Defining 
Network Settings for a Site makes it easy to assign the right Network Settings to a device 
automatically as part of assigning that device to a Site. 

Prior to MSP 3.3.1, referencing a Network Settings Object from a Site Object was often 
problematic because there might need to be more than one Network Settings Object and only 
one could be specified.  This typically would occur when using a mixed population of devices 
that drove the need to use different Network Settings Classes to configure their varied WLAN 
Stacks. 
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Beginning with MSP 3.3.1, a Network Settings Family can be referenced from a Site Object.  
This allows a collection of Network Settings Objects to be grouped together and treated as a 
group.  This can be very useful to handle situations where a mixed population of devices 
needs a variety of Network Settings Objects of different Settings Classes to configure their 
varied WLAN Stacks. 

 Relay Server 

Referencing a Relay Server Object from a Site Object can be useful to define the Relay 
Server that is used by devices at a given location.  Defining a Relay Server for a Site makes it 
easy to assign the right Relay Server to a device automatically as part of assigning that 
device to a Site. 

The relationship between Sites and Relay Servers can be one-to-one (each Site uses a 
unique Relay Server) and/or many-to-one (multiple Sites share the same Relay Server). 

 Additional Settings 

Referencing Additional Settings Objects from a Site Object can be useful to define other 
Settings Objects that should be applied to devices at a given location.  Defining Additional 
Settings for a Site makes it easy to assign those Settings to a device automatically as part of 
assigning that device to a Site. 

Each Additional Settings referenced by a Site could be applied during Staging, Provisioning 
or Both. 

Note: 

For more information on creating Site Objects, see the MSP Online Help – Create Site. 

SMS Carrier Objects 
SMS Carrier Objects must be defined for each unique WWAN carrier (e.g., AT&T, Verizon, Sprint, 
etc.) over which SMS Staging will be performed to devices using that carrier. 

Note: 

For more information on creating SMS Carrier Objects, see the MSP Online Help – Create SMS 
Carrier. 

Definition Document Objects 
Definition Documents are used to define or update Settings Classes or Condition Classes.  
Updated Definition Documents might occasionally be provided to fix problems or enhance the 
capabilities of existing Settings Classes or Condition Classes.  New Definition Documents might 
be provided as part of new Settings Classes or Condition Classes that are added as part of an 
MSP Add-On Kit. 

Notes: 

Definition Documents Objects are created by uploading Definition Documents into MSP. 

Definition Documents can be individually uploaded.  For more information on working with 
Definition Documents, see the MSP Online Help – Def Docs. 

Definition Documents can also be imported as part of an MSP Add-On Kit .ZIP File.  For more 
information on MSP Add-On Kit .ZIP Files, see Chapter 14 – MSP Add-On Kits. 

 



82 -- Administering MSP 3.3.1 
 

 

License Key Objects 
License Key Objects are created to keep an MSP Server in compliance with the MSP License 
Agreement.  The MSP License Agreement requires that each MSP Server have a sufficient 
number of MSP Licenses of each type (Stage, Provision, or Control) to account for the number of 
devices being managed with that functionality.  Compliance to the MSP License Agreement is 
achieved when the aggregate total number of MSP Licenses of each type is greater than or equal 
to the number of managed devices using that functionality, as indicated by the value of the 
Device Attribute “Agent.Feature” having a value of “Stage”, “Provision”, or “Control”. 

Notes: 

License Key Objects are created by entering MSP License Keys into the MSP Console UI. 

For more information on working with License Key Objects, see the MSP Online Help – 
Licensing. 

For more information on MSP License Keys, see Chapter 10 – Object Administration. 

Relationship Definition Objects 
Prior to MSP 3.3.1, there was no concept of Relationships between managed devices.  There 
could be Relationships between Objects of various types, such as Relationships between Sites 
and Relay Servers or Relationships between Sites and/or Relay Servers and managed devices.  
But all managed devices were considered to be equivalent, with no hierarchy possible between 
managed devices. 

Beginning with MSP 3.3.1, Relationships can now be defined between managed devices of 
different Device Classes.  A Relationship Definition Object is created to define a Parent/Child 
Relationship between managed devices of a Child Device Class and managed devices of one or 
more other Parent Device Classes.  Parent/Child Relationships permit the establishment of a 
hierarchy amongst managed devices of different Device Classes. 

Notes: 

Relationship Definition Objects can only be created as part of an MSP Add-On Kit .ZIP File.  For 
more information on MSP Add-On Kit .ZIP Files, see Chapter 14 – MSP Add-On Kits. 

In MSP 3.3.1, no MSP Add-On Kit .ZIP Files that define Relationship Definitions are provided, but 
such MSP Add-On Kit .ZIP Files may later be provided for use with MSP 3.3.1.  Contact your 
Motorola or partner sales or support representative regarding the availability of any additional 
MSP Add-On Kit .ZIP Files. 

For more information on working with Relationship Definition Objects, see the MSP Online Help – 
Relationship Definitions. 
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Chapter 8 – Relay Server Administration 

Managing Relay Servers 

Why Manage Relay Servers? 
While Relay Servers are separate entities from the MSP Server itself, they nonetheless represent 
a critical component of an overall MSP System and a critical link in the MSP Three-Tier 
Distribution Model.  If a Relay Server goes down, then all devices that are configured to check-in 
via that Relay Server will become unmanageable.  Restoring manageability to those devices will 
depend on correcting the problem with the Relay Server and/or replacing it with a new Relay 
Server.  Since Relay Servers have such a crucial role in an MSP System, careful consideration 
should be given to how they will be managed. 

Distribution Model.  If a Relay Server goes down, then all devices that are configured to check-in 
via that Relay Server will become unmanageable.  Restoring manageability to those devices will 
depend on correcting the problem with the Relay Server and/or replacing it with a new Relay 
Server.  Since Relay Servers have such a crucial role in an MSP System, careful consideration 
should be given to how they will be managed. 

Note: Note: 

The term “unmanageable”, when applied to devices, means that MSP management functionality The term “unmanageable”, when applied to devices, means that MSP management functionality 
cannot be used to manage those devices.  This situation generally results when a Relay Server 
that is used to communicate between the MSP Server and some devices goes down or when 
communication between the MSP Server and the Relay Server and/or between the devices and 
the Relay Server is not possible. 

Both the MSP Server and the various varieties of MSP Client Software are specifically designed 
to gracefully handle situations where the Relay Server becomes temporarily unavailable.  
Although devices will become unmanageable, normal device operation will not be significantly 
impacted.  The urgency with which the Relay Server must be repaired or replaced would then 
depend on the urgency of the need to restore MSP management functionality for the affected 
devices. 

Like any Server, a Relay Server should be managed to ensure that it provides an acceptable 
level of service under production use.  Like any Server, it may be a good idea to periodically 
back-up a Relay Server and to monitor it to ensure that it is performing according to expectations.  
If FTP Servers are used for a variety of purposes, only one of which is for use as MSP Relay 
Servers, then an Enterprise should generally have tools and process in place to manage those 
FTP Servers.  But if FTP Servers are used solely as MSP Relay Servers, then it may not be 
considered cost-effective to deploy a full server management system to manage FTP Servers 
used solely as MSP Relay Servers. 
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Since Relay Servers are critical components of an overall MSP System, it makes sense for MSP 
to take a certain amount of responsibility over the Relay Servers it uses.  While MSP is not 
intended to be and does not attempt to be a management system for Servers, it nonetheless has 
a vested interest in performing certain key management functions related to its own use of FTP 
Servers that are used as MSP Relay Servers. 

MSP and Relay Servers 
The MSP Server is a client of each of the Relay Servers in an MSP System, as are the devices 
that are managed by MSP via these Relay Servers.  As such, MSP can provide some status 
about a Relay Server based on an assessment of whether it is responding as expected. 

When accessing a Relay Server, MSP can detect when it is not responding and hence could be 
concluded to in need of corrective action.  But by that time, the situation may be dire and devices 
will already have become unmanageable.  While the information MSP can provide may be 
invaluable, it may not be adequate as the sole means to manage a Relay Server. 

Note: 

MSP is not a Server management system and does not provide the tools that would be needed to 
proactively monitor a Relay Server and detect and correct problems before they occur.  For a 
truly Enterprise-class system, proactive monitoring of Relay Servers would be required, and that 
is the domain of specialized Server Management Systems. 

As devices check-in via and are discovered via a Relay Server, and as Provisioning Policies and 
Actions require it, MSP will deliver Packages, Bundles, and Jobs to the Relay Server. 

MSP Responsibilities 
MSP is responsible for delivering Content to Relay Servers and for exchanging documents with 
devices via Relay Servers.  As the “master client” of a Relay Server, MSP is responsible for 
ensuring that the right Content is present on any given Relay Server. 

Folder Structure and Staging Content 
To accomplish its intended purpose, MSP acts as the “master client” of each Relay Server.  
When a Relay Server Object is created to define a Relay Server within MSP, MSP connects to 
that Relay Server using the supplied credentials. 

MSP will automatically detect that a new Relay Server is “empty” and will automatically create the 
required folder structure on that Relay Server.  In the event that an existing Relay Server “loses” 
its folder structure, MSP will automatically re-create the required folder structure.  MSP will also 
automatically populate the Relay Server with Packages and Bundles that may be required based 
on defined Staging Profiles that could perform Staging via that Relay Server. 

Prior to MSP 3.3.1, MSP would automatically populate Staging Content to a “new” Relay Server, 
but would not automatically re-populate Staging Content to an existing Relay Server when the 
folder structure was “lost”.  Beginning with MSP 3.3.1, MSP will automatically re-populate all 
Staging Content to a Relay Server when it re-creates the folder structure of that Relay Server. 

In the event of a complete loss of Relay Server Content, MSP will automatically bring that Relay 
Server back into fully operable status.  However, in the event of a partial loss of Relay Server 
Content, MSP may not automatically do so.  This is a design decision made based on the 
likelihood of such failures vs. the impact on scalability, network bandwidth, etc. that would be 
required to check Content at a more detail level.  Additional automatic correction can be enabled 
via Relay Server Optimization, as discussed later in this chapter. 
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Provisioning and Action Content 
MSP will check a Relay Server before deploying Content to see if the Content is already present 
and will avoid unnecessary deployment of Content when possible.  This helps increase the 
scalability of the MSP System by avoiding the unnecessary use of processing power and network 
bandwidth Content that is already present.  This also helps re-deliver Provisioning and Action 
Content if it is “lost”. 

But MSP does not continuously monitor Relay Servers to make sure that they always have all 
the Content that MSP previously sent to them.  MSP uses the Package File that is delivered as 
part of a Package to determine that the Package has previously been sent.  If the Package File is 
present, then the entire Package is considered to be present.  If some component file of a 
Package is lost or corrupted, MSP will continue to consider that the entire Package is still present. 

In the event of a complete loss of Relay Server Content, MSP will automatically bring that Relay 
Server back into fully operable status.  However, in the event of a partial loss of Relay Server 
Content, MSP may not automatically do so.  This is a design decision made based on the 
likelihood of such failures vs. the impact on scalability, network bandwidth, etc. that would be 
required to check Content at a more detail level.  Additional automatic correction can be enabled 
via Relay Server Optimization, as discussed later in this chapter. 

Package Removal 
When a Package is removed from the MSP Server, the MSP Server will automatically attempt to 
remove that Package from all Relay Servers. 

Note: 

MSP does not try to limit itself to removing a Package from only Relay Servers to which it 
previously sent the Package.  If the Package is not on a Relay Server, the cost to attempt (and 
fail) to remove it is small. 

A User-defined Package can be deleted from the MSP Server from the Library->Packages page 
of the MSP Console UI.  Settings Packages that were created automatically by MSP may also be 
automatically deleted from the MSP Server when the Settings Objects for which they were 
created are deleted or modified.  Any time a Package is deleted from the MSP Server, MSP will 
attempt to remove that Package from every Relay Server. 

MSP may be unable to communicate with a Relay Server when trying to remove a Package.  
MSP will continue to keep the queued operation pending as long as it takes to complete it, so 
long as the Relay Server Object  for that Relay Server exists within MSP. 

Relay Server Optimization 
Warning: 

Relay Server Optimization can be processor and network intensive, especially if there are a large 
number of Packages and Relay Servers.  Relay Server Optimization should therefore be 
scheduled to occur at times when it is least likely to impact other systems. 

The MSP server can determine when a Package belongs on a Relay Server, but MSP does not 
maintain a record of what Packages it has previously sent to a Relay Server.  Since the 
Packages required on a Relay Server might be different for every device, maintaining a record of 
all the Packages sent to a Relay Sever on behalf of each device could severely impact the ability 
of MSP to scale to support the desired number of devices. 
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Beginning with MSP 3.3.1, a mechanism is available to optimize the Content of a Relay Server.  
The Relay Server Optimization feature allows periodical scheduled optimization.  Relay Server 
Optimization is not enabled by default for any Relay Servers. 

Since MSP does not have a record of what Packages it has previously sent to a Relay Server, 
Relay Server Optimization is based on a periodic comparison of the current Contents of a Relay 
Server against the Contents that are determined by MSP to belong on the Relay Server.  Relay 
Server Optimization will add Packages that it determines to be missing or remove Packages that 
it determines to be unnecessary. 

Package Files as Sentinels 

The operation of Relay Server Optimization is primarily involved with detecting and correcting 
issues with Content as embodied in Packages.  Relay Server Optimization can identify situations 
where Content belongs on a Relay Service and is not present and therefore is missing.  Relay 
Server Optimization can identify situations where Content is present on a Relay Server and does 
not belong and therefore is unnecessary. 

To increase efficiency, Relay Server Optimization uses Package Files as “sentinels”to determine 
which versions of which Packages are present on which Relay Servers.  A Package File is a file 
whose file name varies based on the Package Name and Package Version of a Package and 
which is delivered to a Relay Server as part of the delivery of that Package.  The key assumption 
about a Package File for a given version of a given named Package is that it will be on a given 
Relay Server if and only if the matching version of the matching Package is on that Relay Server. 

Missing Package Detection 

When Relay Server Optimization determines that a particular version of a particular named 
Package belongs on a Relay Server, it looks for the Package File for that version of that named 
Package on that Relay Server.  If Relay Server Optimization finds the Package File then it 
assumes that the entire Package is present, otherwise it assumes that the entire Package is 
missing.  Missing Packages will be delivered to Relay Servers by Relay Server Optimization. 

Important: 

Relay Server Optimization generally will not, detect missing or corrupt component files of 
Packages.  If the Package File for a Package is present on a Relay Server, then the entire 
Package is assumed to be present and intact and none of the Package component files will be 
delivered.  Hence no recovery of the missing or corrupted component files can take place.  To 
force delivery of a corrupted Package, the Package File would need to be removed. 

Relay Server Optimization does not attempt to optimize to skip delivery of component files that 
might already be present on a Relay Server.  If the Package File for a Package is not present on 
a Relay Server, the entire Package is assumed to be missing and all component files will be re-
delivered.  Any component files that already exist on the Relay Server will simply be overwritten. 

Possible Reasons for Missing Packages 

The following are some reasons why a Package might become missing and would need to be 
delivered by Relay Server Optimization: 

 A Relay Server may have been restored from a backup and a Package may have been 
delivered to that Relay Server after the backup was taken; hence that Package is now 
missing from that restored Relay Server. 

 



Chapter 8 – Relay Server Administration -- 87 
 

 A Relay Server Object may have been deleted and re-created, thus preventing MSP from 
delivering a Package to the Relay Server while the Relay Server Object did not exist; hence 
that Package is now missing from that Relay Server. 

 An out-of-band action may have been taken to manually remove a Package File from a Relay 
Server; hence the Package is now missing from that Relay Server. 

Unnecessary Package Detection 

When Relay Server Optimization determines that the Package File for a particular version of a 
particular named Package is present on a Relay Server, it checks to see if that version of that 
named Package belongs on that Relay Server.  If Relay Server Optimization finds that the 
Package does not belong, then it considers the Package to be unnecessary.  Unnecessary 
Packages will be removed from Relay Servers by Relay Server Optimization. 

Important: 

When removing a Package from a Relay Server, Relay Server Optimization does not use the 
definition of that Package to determine the component files to delete.  Instead it removes the 
Package File and the entire subfolder in which the component files for that Package are stored.  
Any files that may have been erroneously stored in that folder will be deleted along with the 
component files actually delivered as part of the Package. 

Possible Reasons for Unnecessary Packages 

The following are some reasons why a Package might become unnecessary and would need to 
be removed by Relay Server Optimization: 

 A Relay Server may have been restored from a backup and a Package may have been 
removed from that Relay Server after the backup was taken; hence that Package is now 
present on that restored Relay Server but is unnecessary. 

 A Relay Server Object may have been deleted and re-created, thus preventing MSP 
removing a Package from the Relay Server while the Relay Server Object did not exist; 
hence that Package is now present on that Relay Server but is unnecessary. 

 An out-of-band action may have been taken to manually add a Package File to a Relay 
Server; hence the Package is now present on that Relay Server but is unnecessary. 

 A Package previously delivered by MSP to a Relay Server may no longer be needed due to 
changes made to one or more MSP Objects; hence the Package is now present on that 
Relay Server but is unnecessary. 
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Master Client of Relay Server 

When Relay Server Optimization is enabled for a Relay Server, MSP assumes that it is the 
“master client” of that Relay Server and that it has complete discretion to add or remove Content 
within the folder on the FTP Server allocated for that Relay Server. 

Warning: 

If an FTP Server is used as a MSP Relay Server and is also used for other purposes, then MSP 
should be allocated a separate folder on the FTP Server that is exclusively reserved for the use 
of MSP. If exclusivity does not exist, Relay Server Optimization should not be enabled for that 
Relay Server. 

If any other system is “sharing” the folder area that is allocated to MSP, and Relay Server 
Optimization is enabled, then MSP may remove files that are required by that other system. 

Non-MSP Responsibilities 

Proactive Prevention 
Benjamin Franklin said “an ounce of prevention is worth a pound of cure” and this is particularly 
appropriate in the context of Relay Server management.  Many common problems that can 
eventually cause a Relay Server to fail can be detected well in advance and might be prevented 
by proactive monitoring and regular preventive maintenance.  Waiting for a Relay Server to fail is 
usually a poor choice for a management strategy. 

Some of the most common things that should be monitored are hard disk space, CPU usage, bug 
fixes, security updates, etc.  Servers require regular maintenance and need to be monitored to 
detect common situations well before they lead to failure. 

Backup and Restore 
As mentioned earlier, periodic backup of Relay Server Content may not be required.  If MSP is 
suitably configured to perform Relay Server synchronization, then MSP may be counted on to 
restore Relay Server Content as required.  But at least occasional backup of Relay Server 
configuration may be highly desirable.  This is especially true if that configuration changes, such 
as changing account credentials, updating security certificates, etc.  Failure to have a suitable 
backup handy could hamper the installation of a suitable replacement Relay Server in the event 
of a catastrophic failure. 

Relay Server Redundancy 
If MSP functionality is deemed to be mission-critical, then it may be considered desirable to 
implement some form of Relay Server redundancy to maximize the reliability and availability of 
Relay Servers and hence the manageability of devices via those Relay Servers.  MSP provides 
no mechanism to accomplish Relay Server Redundancy, but it does not prevent the use of 
external solutions to do so.  It is beyond the scope of this document to explain all the possible 
ways that Relay Server Redundancy might be implemented external to MSP.  Nonetheless, the 
following example describes one approach that could be followed. 

Consider a situation where the scalability and network organization of an MSP System make it 
reasonable to use a single central Relay Server to support all devices at all locations.  This Relay 
Server then becomes a key point-of-failure that could cause the loss of all MSP functionality if 
that Relay Server fails. 

As described earlier, a periodic backup of that Relay Server is likely of critical necessity to protect 
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against a catastrophic failure.  If the Relay Server fails, it can be replaced by a new, similarly 
configured Relay Server onto which the backup can be restored.  This will provide a means to 
recover from a catastrophic failure in a reasonable amount of time.  Such a solution might be 
termed a “manual replacement” solution, since when a problem occurs, manual action is required 
to prepare and deploy the replacement Relay Server.  This manual process could take a 
significant amount of time, during which the devices remain unmanageable. 

To reduce the recovery time from a catastrophic failure, one might consider implementing a “cold 
standby” solution.  In such a solution, a standby Relay Server is installed which is not in service 
but which receives periodic scheduled restores of backups of data from the Relay Server that is in 
service.  In the event of a failure, the standby Relay Server can be brought into service to take 
over from the failed Relay Server.  Since the Relay Server is already configured and already has 
the data, bringing it into service generally involves just changing the routing so that requests are 
routed to the new Relay Server.  The frequency of backup and restore will determine how close 
the standby system is to the failed system and will also determine the amount of computing and 
network resources expended. 

To further reduce the recovery time from a catastrophic failure, one might consider implementing 
a “warm standby” solution.  In such a solution, a standby Relay Server is installed which is not in 
service but which receives scheduled replication of data from the Relay Server that is in service.  
The primary difference between “warm standby” and “cold standby” is how recent the data on the 
standby Relay Server will be when it is brought into service.  With a “warm standby” system, 
since data is replicated on a scheduled background basis, the standby system should generally 
be very close to identical to the failed system.  The frequency of replication will determine how 
close the standby system is to the failed system and will also determine the amount of computing 
and network resources expended. 

For the ultimate in redundancy, one might consider implementing a “hot standby” solution.  .  In 
such a solution, a standby Relay Server is installed which is not in service but which receives 
continuous real-time replication of data from the Relay Server that is in service.  In the event of a 
failure, the standby system can be brought into service with confidence that it contains data that 
is identical to the failed system.  Of course, the amount of computing and network resources 
expended to achieve this can be quite significant. 

In any of the standby solutions described above: cold, warm, or hot, the mechanism for bringing 
the standby Relay Server into service could be manual or automated.  A manual system would 
require that an administrator become aware that a Relay Server had failed, at which point he 
would perform a manual process to remove the failed Relay Server from service and bring the 
standby Relay Server into service.  An automated system would require that some automatic 
switchover system be run external to the Relay Server that is in service to monitor it and detect 
when it ceases to function.  In such a condition, the automatic switchover system would 
automatically perform the process to remove the failed Relay Server from service and bring the 
standby Relay Server into service.  It is possible that this automatic switchover system could be 
implemented by software running on the standby Relay Server itself.  Alternately, it could be 
implemented by an external redundancy system. 

The above examples all assumed a single central Relay Server, but it should be clear that the 
same approaches could be applied to situations where multiple Relay Servers are used, either 
centrally or distributed, even in an extreme case where a Relay Server is distributed to each Site.  
However, it should be considered that where Relay Servers are highly distributed, redundancy 
might be considered unnecessary.  For example, if each Site has 10 devices that are managed 
via a local Relay Server, a failure of that Relay Server would affect only those 10 devices.  In 
such cases, a “manual replacement” solution might be deemed quite adequate since the impact 
of the failure of any single Relay Server is small and hence the time required to recover from a 
failure may be acceptable. 
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MSP and Certificates for FTPS 
When MSP and/or devices will be used to access a Relay Server using the FTPS protocol, and if 
the Verify Server option is set to True for the Relay Server, then MSP and/or devices will need to 
be able to establish trust of the Server Certificate offered up by the FTPS Server. 

Important: 

When a Relay Server is configured to use the FTPS protocol and the Verify Server option is set to 
True, the IP Address or Network Name specified as the Server Address for the Relay Server 
must exactly match the Common name of the Subject (Issued To) portion of the Server Certificate 
supplied by that FTPS Server.  This avoids man-in-the-middle attacks by preventing another 
Server from masquerading as the target FTPS Server. 

MSP Server vs. Device Access to an FTPS Server 
When a Relay Server is defined, the Public Access Info is used to specify how the MSP Server 
will access the FTP Server and the Private Access Info is used to specify how devices will access 
the FTP Server.  It is possible for the Public Access Info and/or the Private Access Info to specify 
the use of the FTPS protocol. 

In many cases, both the Public Access Info and the Private Access Info will specify the use of the 
FTPS protocol, but this is not mandatory.  In some cases, the security needs of the solution may 
only require one or the other to use the FTPS protocol.  Depending on the definition of the Relay 
Server, one or both of the following subsections may be relevant. 

Configuring the MSP Server to Establish Trust of 
a Server Certificate 
When the Public Access Info of a Relay Server is defined to use the FTPS protocol and the Verify 
Server option is set to True, then the MSP Server must be able to establish trust of the Server 
Certificate of that FTPS Server.  In order for the MSP Server to trust a Server Certificate, it must 
trust the Issuer of that Server Certificate, which means that the Root Certificate of the Issuing 
Authority must be installed into the Root Certificate Store of the Computer account of the MSP 
Server. 

Important: 

Trust is established based on the Issuer of a Certificate, hence the Root Certificate of the Issuer, 
not the Server Certificate itself, must be placed into the Certificate Store.  Placing a Server 
Certificate into the Certificate Store generally will not establish trust of the Certificate.  The one 
exception is Self-Signed Certificates, since the Issuer and the Server are the same. 

 



Chapter 8 – Relay Server Administration -- 91 
 

Installing the Root Certificate of the Issuing Authority into the Root Certificate Store of the 
Computer account of the MSP Server should be done using the Windows Server Certificate 
Manager. 

Warning: 

The Certificate of the Issuing Authority must be installed into the Root Certificate Store of the 
Computer account.  The Certificate must not be installed into the Root Certificate Store of the 
User account.  This is because the MSP Server will generally not be running in the context of 
the User who is installing the Certificate.  This means that the Certificate cannot simply be 
installed by double-clicking it, since that would install it in the Root Certificate Store of the User 
account.  The Windows Server Certificate Manager must be used since it provides control of the 
Certificate Store into which the Certificate will be installed. 

To use the Windows Server Certificate Manager to install a Certificate into the Root Certificate 
Store of the Computer account for the MSP Server, use the following process: 

1. Open the Management Console (MMC) on the MSP Server, using the command: 
 Start -> Run: mmc 

2. Click File -> Add/Remove Snap-in -> Add 

3. Select the Certificates snap-in and click the Add button 

4. Select Computer account, and click the Next button 

5. Select Local Computer and click the Finish button 

6. In the Add/Remove Snap-in window, click the OK button 

7. In the Console Root window, expand the Certificates items, right click on Trusted Root 
Certification Authorities -> All Tasks -> Import 

8. Click the Next button in the Certificate Import wizard, select the .CER file containing the 
Certificate of the Issuing Authority, then click the Next button 

9. Make sure the Certificate is being placed into the Trusted Root Certification Authorities 
store, click the Next button, and the click the Finish button 

10. Close the Management Console 

Configuring Devices to Establish Trust of a Server 
Certificate 
When the Private Access Info of a Relay Server is defined to use the FTPS protocol and the 
Verify Server option is set to True, then devices must be able to establish trust of the Server 
Certificate of that FTPS Server.  In order for a device to trust a Server Certificate, it must trust the 
Issuer of that Server Certificate, which means that the Root Certificate of the Issuing Authority 
must be installed into the Root Certificate Store of the device. 

Important: 

Trust is established based on the Issuer of a Certificate, hence the Root Certificate of the Issuer, 
not the Server Certificate itself, must be placed into the Certificate Store.  Placing a Server 
Certificate into the Certificate Store generally will not establish trust of the Certificate.  The one 
exception is Self-Signed Certificates, since the Issuer and the Server are the same. 

 



92 -- Administering MSP 3.3.1 
 

Installing the Root Certificate of the Issuing Authority into the Root Certificate Store of a device 
can be done using a Certificate Settings Object with a Certificate Type of Server and with Root 
Certificate set to True 

For more information on the use of Certificate Settings Objects, see the MSP Online Help – 
Setting Create. 

FTP Server Reference 
This section provides reference information that may be useful for choosing and configuring 
various FTP Servers for use as an MSP Relay Servers.  This section is by no means 
comprehensive of all the FTP Servers that might be used.  But when using any of the listed FTP 
Servers, the information provided may help to properly configure them. 

Note: 

Motorola does not recommend the use of any specific FTP Server with MSP.  Any Relay Server 
that conforms to the required RFCs, as documented in Understanding MSP 3.3.1 – 
Understanding MSP Security, should be successfully usable with MSP.  The information in this 
section is provided solely as a convenience to convey information that has been useful for certain 
specific Relay Servers that have been used during MSP testing. 

FileZilla 
FileZilla is free open source software distributed free of charge under the terms of the GNU 
General Public License.  While FileZilla is “free”, this also means that there is no guarantee of 
support or warranty of any kind.  Use of FileZilla is therefore at a customer’s own risk. 

Configuring FileZilla as an MSP Relay Server 
To configure FileZilla as an MSP Relay Server: 

1. Go to FileZilla and select Edit > Users > Add. The Add User account window appears: 

a. In the Add User account window, enter the User Name and click OK. The User 
Name that you have entered appears in the User pane. 

b. From the Account Setting pane, enable the Enable Password check box. 

c. In the Password field, enter a Password. 

d. Go to the Shared folders pane and click Add. 

e. Select a folder from your system and click OK. The selected folder appears under the 
Shared folders pane. All the Contents (Packages, Bundles, and network Settings) 
from MSP will be delivered to this folder. 

f. Enable the following options under Files and Directories pane: 

Files 

○ Read 

○ Write 

○ Delete 

○ Append 

Directories 
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○ Create 

○ Delete 

○ List 

○ Subdirs 

2. Click OK. 

3. Refer to the FileZilla documentation for more information. 

4. Once you have configured FileZilla for use as an MSP Relay Server, you must create a 
Relay Server Object in MSP with the details pertaining to the FTP Server. 

5. If you wish to use the FTPS protocol in conjunction with FileZilla, see Chapter 4 – MSP 
Security and the next section in this chapter. 

Using FileZilla with the FTPS Protocol 
This section describes how to configure a FileZilla FTP Server so it can be used as a Relay 
Server with the FTPS protocol and with Verify Server set to True. 

Important: 

The process defined in this section is only required if the FTPS Protocol is selected for a Relay 
Server and if the Verify Server option is set to True for that Relay Server.  Otherwise a valid 
FileZilla Server Certificate will not be required. 

There are two ways to provide a FileZilla FTP Server with a valid Server Certificate: generating a 
Self-Signed Certificate from within FileZilla, or issuing a Certificate to a FileZilla FTP Server via a 
Certificate Authority external to FileZilla. 

Notes: 

It is beyond the scope of this document to describe how to implement or utilize a Certificate 
Authority to issue Server Certificates for use by a FileZilla (or any other) FTP Server.  The 
process provided in this chapter only defines how to generate and use a FileZilla Self-Signed 
Certificate. 

For information on using a particular Certificate Authority to issue Server Certificates, see the 
documentation for the specific Certificate Authority being used. 

For information on configuring FileZilla to use Certificates issued by an external Certificate 
Authority, see the FileZilla documentation. 

The FileZilla Server interface provides a method to generate a Self-Signed Certificate and to 
export that Certificate for delivery to any clients that will need to establish trust with that FileZilla 
FTP Server when using the FTPS protocol. 

Important: 

There is a known issue with the FileZilla FTP Server that prevents the use of the FTPS protocol 
from other processes running within the same VMWare Virtual Machine (VM) as the FileZilla 
Server. 

If both the MSP Server and the FileZilla FTP Server will be located within the same VM, then it 
will not be possible for MSP to use the FTPS protocol when communicating to that FileZilla FTP 
Server as a Relay Server. 
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This issue does not occur if only the FTP Protocol is used. 

This issue does not occur if the MSP Server and the FileZilla FTP Server are in different VMs. 

This issue only prevents the MSP Server from accessing the FileZilla FTP Server using the 
FTPS protocol, it does not prevent devices from accessing the FileZilla FTP Server using the 
FTPS protocol. 

Generating a Self-Signed Certificate 

The first step in using a Self-Signed Certificate to enable the use of the FTPS protocol with 
FileZilla as a Relay Server is to cause FileZilla to generate and use a Self-Signed Certificate.  To 
do this, from the FileZilla main menu, select Edit -> Settings -> SSL/TLS Settings.  The SSL/TLS 
Settings Dialog will be displayed, as shown inFigure 13 below. 

 

Figure 13 – FileZilla SSL/TLS Settings 

The Enable SSL/TLS checkbox should be checked to enable SSL/TLS (FTPS) support.  Further, 
the following fields can/should be set: 

 The Allow explicit SSL/TLS on normal conditions checkbox should be checked to enable 
explicit SSL/TLS (AUTH TLS) support. 

 The Force explicit SSL/TLS checkbox can optionally be checked to disable FTP and 
allow only FTPS connections. 

 The Force PROT P to encrypt data channel in SSL/TLS mode checkbox should be 
unchecked. 

 The Listen for SSL/TLS-only connections on the following ports field should be 
cleared in order to disable implicit FTPS (which is not supported by MSP).  The default 
port of 990 must not be used. 
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To generate a Self-Signed Server Certificate, click the Generate new certificate button.  The 
FileZilla Self-Signed Certificate Dialog will then be displayed, as show in Figure 14. 

 

Figure 14 – FileZilla Self-Signed Certificate Dialog 

To generate a Self-Signed Server Certificate, the FileZilla Self-Signed Certificate Dialog should 
be filled-in as follows: 

 The Key size field should generally be set to 1024. 

 The 2-Digit country code field should be set to the country code of the country where 
the Server is located (e.g. US). 

 The Full state or province field should be set to the full name of the state or province 
where the Server is located (e.g. Texas). 

 The Locality (City) field should be set to the full name of the city where the Server is 
located (e.g. Houston), 

 The Organization field should be set to the name of the organization associated with the 
Server (e.g. Motorola). 

 The Organization unit field should be set to the name of the organization unit associated 
with the Server (e.g. Engineering). 

 The Contact E-Mail field should be set to the Email address of the administrator of the 
Server (e.g. Server.Admin@motorola.com). 
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 The Common name (Server address) field should be set to the IP Address or network 
name (e.g. DNS name) of the Server (e.g. 192.168.0.1). 

Note:  

The value specified for the Common name field must exactly match the IP Address 
or Network Name that is/will be configured in the Relay Server to access the FTPS 
Server. 

 The Save key and Certificate to this file field should be set to the name and location 
where the generated Server Certificate file will be stored. 

When the Generate certificate button is clicked, a new Self-Signed Certificate, which 
incorporates the entered information, will be generated, the FileZilla Self-Signed Certificate Dialog 
will close, and the following information will automatically be entered into the SSL/TLS Settings 
Dialog. 

 The Private key file field will be automatically filled in with the information for the 
generated Self-Signed Certificate. 

 The Certificate file field will be automatically filled in with information for the generated 
Self-Signed Certificate 

To complete the configuration of FileZilla for SSL/TLS using the generated Self-Signed 
Certificate, click the OK button. 

Converting the Self-Signed Certificate for MSP and Device Use 

A Self-Signed Server Certificate generated by Filezilla is in PEM format.  Server Certificates used 
by MSP must be in DER format, typically stored as a .CER file.  There are various tools and 
utilities that can be used to convert a PEM format Certificate to DER format. 

Important: 

The FileZilla FTP Server does not provide any method to export Self-Signed Certificates it 
creates in the format required by MSP.  In order for MSP to use such a Certificate, the Certificate 
must be exported from FileZilla and then externally converted for use by MSP. 

The free Openssl.exe utility that is part of the Openssl toolkit can be used to perform the 
necessary conversion.  Openssl is an open-source implementation of SSL that can be 
downloaded from the following link: 

http://www.slproweb.com/products/Win32OpenSSL.html 

After installing the Openssl toolkit, a PEM format Certificate (in a .CRT file), as exported from 
FileZilla, can be converted to a DER format Certificate (in a .CER file) by using the following 
command line: 

.\openssl x509 -inform PEM -in filezilla.crt -outform DER -out filezilla.cer 

where: filezilla.crt is the name of the file containing the PEM format Certificate 

and: filezilla.cer is the name of the file containing the DER format Certificate 

 

http://www.slproweb.com/products/Win32OpenSSL.html
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Configuring the MSP Server to Establish Trust of a Converted 
Certificate 

Once a FileZilla Self-Signed Certificate has been converted into a DER format Certificate 
(in a .CER file), the Certificate will need to be used to establish trust by the MSP Server.  
This can be accomplished as described in the section Important: 

When a Relay Server is configured to use the FTPS protocol and the Verify Server option is set to 
True, the IP Address or Network Name specified as the Server Address for the Relay Server 
must exactly match the Common name of the Subject (Issued To) portion of the Server Certificate 
supplied by that FTPS Server.  This avoids man-in-the-middle attacks by preventing another 
Server from masquerading as the target FTPS Server. 

MSP Server vs. Device Access to an FTPS Server 
When a Relay Server is defined, the Public Access Info is used to specify how the MSP Server 
will access the FTP Server and the Private Access Info is used to specify how devices will access 
the FTP Server.  It is possible for the Public Access Info and/or the Private Access Info to specify 
the use of the FTPS protocol. 

In many cases, both the Public Access Info and the Private Access Info will specify the use of the 
FTPS protocol, but this is not mandatory.  In some cases, the security needs of the solution may 
only require one or the other to use the FTPS protocol.  Depending on the definition of the Relay 
Server, one or both of the following subsections may be relevant. 

Configuring the MSP Server to Establish Trust of a Server Certificate, earlier in this chapter. 

Configuring Devices to use a Converted FileZilla Certificate 

Once a FileZilla Self-Signed Certificate has been converted into a DER format Certificate (in a 
.CER file), the Certificate will need to be used to establish trust by devices.  This can be 
accomplished as described in the section To use the Windows Server Certificate Manager to 
install a Certificate into the Root Certificate Store of the Computer account for the MSP Server, 
use the following process: 

11. Open the Management Console (MMC) on the MSP Server, using the command: 
 Start -> Run: mmc 

12. Click File -> Add/Remove Snap-in -> Add 

13. Select the Certificates snap-in and click the Add button 

14. Select Computer account, and click the Next button 

15. Select Local Computer and click the Finish button 

16. In the Add/Remove Snap-in window, click the OK button 

17. In the Console Root window, expand the Certificates items, right click on Trusted Root 
Certification Authorities -> All Tasks -> Import 

18. Click the Next button in the Certificate Import wizard, select the .CER file containing the 
Certificate of the Issuing Authority, then click the Next button 

19. Make sure the Certificate is being placed into the Trusted Root Certification Authorities 
store, click the Next button, and the click the Finish button 

20. Close the Management Console 
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Configuring Devices to Establish Trust of a Server Certificate, earlier in this chapter. 

Microsoft IIS in Windows Server 2003 
Microsoft IIS is provided with Windows Server 2003 and there is no additional license fee for 
using it. 

Note:  

Microsoft IIS that is provided with Windows Server 2003 does not support the FTPS protocol. 

Setting up the FTP Server in Microsoft IIS 
1. The Windows FTP Server is not installed by default.  Put the Windows CD in and use the 

following steps to install it. 

2. From the System Start menu, select Control Panel > Add/Remove Windows 
Components. 

3. Select Application Server and click Details. 

4. Select IIS and click Details. 

5. Select the FTP Service check box and click OK to close the IIS window. 

6. Click OK to close the Application Server window. 

7. Click Next to continue and complete the Windows Components Wizard. 

Configuring Microsoft IIS as an MSP Relay Server 
1. From the System Start menu, select Administrative Tools > Internet Information Services 

(IIS) Manager. 

2. Under the Computer pane, double-click the local computer and select FTP Sites. 

3. Select Default FTP Site > Properties. 

4. In the Default FTP Site Properties window: 

a. Under FTP Site tab, set the IP Address of the Server and the desired port 
number. 

b. Under Security Accounts tab, set desired FTP User Name and Password 

c. Under Home Directory tab, set desired local path and make sure it has both 
Read AND Write access. 

5. Click OK and make sure the service is running. 

6. Verify that you can access the FTP directory from a different computer. 

7. Make sure you can access the FTP directory from another PC. 

8. Once you have configured IIS for use as an MSP Relay Server, you must create a Relay 
Server Object in MSP with the details pertaining to the FTP Server. 

Microsoft IIS 7 in Windows Server 2008 
Microsoft IIS 7 is provided with Windows Server 2008. 

Important:  

If an FTP Site implemented by Microsoft IIS 7 is to be used as a Relay Server with MSP, both the 
IIS top level configuration and the FTP Site level configuration must have the "Directory Listing 
Style" set to UNIX.  This can be found in the "FTP Directory Browsing" section. 
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FTP 7 or FTP 7.5 in IIS 7 in Window Server 2008 
Microsoft FTP 7 and FTP 7.5 are FTP Publishing Services that are available to be installed into 
Microsoft IIS 7.0 for use with Windows Server 2008. 

Important:  

Either Microsoft FTP 7 or FTP 7.5, when installed and configured onto IIS 7.0 and Windows 
Server 2008, can enable the use of the FTPS protocol as an MSP Relay Server. 

Information on where to obtain and how to install and set up the FTP 7 FTP Publishing Service 
and/or the FTP 7.5 FTP Publishing Service in Microsoft IIS 7.0 can be obtained from the following 
link: 

http://learn.iis.net/page.aspx/304/using-ftp-over-ssl/ 

Microsoft IIS 7.5 in Windows Server 2008 R2 
Microsoft IIS 7.5 is provided with Windows Server 2008 R2. 

Important:  

If an FTP or FTPS Site implemented by Microsoft IIS 7.5 is to be used as a Relay Server with 
MSP, both the IIS top level configuration and the FTP Site level configuration must have the 
"Directory Listing Style" set to UNIX.  This can be found in the "FTP Directory Browsing" section. 

Microsoft IIS 7.5 comes with the FTP 7.5 FTP Publishing Service pre-integrated. 

Important:  

Since it integrates the FTP 7.5 FTP Publishing Service, Microsoft IIS 7.5 can enable the use of 
the FTPS protocol as an MSP Relay Server. 

Creating and Configuring an FTP Site Manually 
By default MSP Installation program does not create/configure default FTP site, therefore it needs 
to be created/configured manually: 

 
1. Open Internet Information Services (IIS) Manager (Figure 15 below), expand <This 

Server>, Sites in the left pane: 
 

 
Figure 15 – IIS Manager 

 

http://learn.iis.net/page.aspx/304/using-ftp-over-ssl/
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2. Right click Sites and click Add FTP Site…  to display the FTP Site Information dialog 
box (Figure 16 below ). Provide the site name (Default FTP Site), Content directory 
(C:\INETPUB\FTPROOT) and click “Next”: 
 

 

Figure 16 – Site Information Dialog Box 
 

3. Provide all the configuration settings as shown in Figure 17 and Figure 18 below: 

 

 

Figure 17 

 

Figure 18 
 

4. Click Finish; the new Default FTP Site will appear at the left pane. All tools and icons for 
further configuration settings will be in the middle pane (Figure 19 below). 
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Figure 19 

 

Following table shows configuration settings for different configuration scenarios of FTP Service 
and FTP Relay Agent: 

Table 4 
 

Configuration 
Scenario 

FTP 
Authentication 

FTP 
Authorization 

FTP 
Directory 
Browsing 

FTP SSL Inbound Firewall 
Rules 

FTP Passive 
Mode;  

FTP 

Everyone 
Disable;  Basic 
Enable 

All Users: 
Read, Write 

UNIX; 
Virtual 
Directories 
checked 

Not 
selected, 
Allow 
SSL 

Allow Incoming 
traffic:  

1. Ports 1024-65535      
2. Ports 20,21 

FTP Active 
Mode; 

FTP 

Everyone 
Disable;  Basic 
Enable 

All Users: 
Read, Write 

UNIX; 
Virtual 
Directories 
checked 

Not 
selected, 
Allow 
SSL 

Allow Incoming 
traffic: 

1. Ports 5500-5550 

2. Ports 20,22 

FTP Passive 
Mode; 

FTPS 

Everyone 
Disable;  Basic 
Enable 

All Users: 
Read, Write 

UNIX; 
Virtual 
Directories 
checked 

Default 
Cert, 
Allow 
SSL 

Allow Incoming 
traffic: 

1. Ports 1024-65535 

2. Ports 20,23 

FTP Active 
Mode;  

FTPS 

Everyone 
Disable;  Basic 
Enable 

All Users: 
Read, Write 

UNIX; 
Virtual 
Directories 
checked 

Default 
Cert, 
Allow 
SSL 

Allow Incoming 
traffic: 

1. Ports 5500-5550 

2. Ports 20,24 
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Motorola WS-2000 Wireless Switch 
The Motorola WS-2000 Wireless Switch contains a built-in FTP Server that can be used as an 
MSP Relay Server if a suitable Compact Flash card with adequate space available is inserted into 
the slot provided. 

Note: 

The Motorola WS-2000 does not support the FTPS protocol. 

Using a WS-2000 as an MSP Relay Server 
A Motorola WS-2000 Wireless Switch, running firmware version 2.0 or higher, and equipped with 
a Compact Flash (CF) card, implements an FTP Server. This FTP Server can be used to 
implement an MSP Relay Server, if desired. This can allow the benefits of having a local Relay 
Server without the expense or complexity of installing and managing a separate FTP Server.  

Note: 

Motorola recommends keeping the time updated on the WS-2000.  It will help avoid possible 
timeout problems during Provisioning. 

The WS-2000 includes a single built-in FTP User account with a User Name of AirBEAM (User 
Name is case sensitive).  You can configure the Password for this account as part of the WS-
2000 configuration.    It is generally a good practice to use a password other than the default 
password provided in the WS-2000. 

When defining an MSP Relay Server Object to reference a WS-2000 FTP Server, the following 
rules should be followed: 

 Specify the AirBEAM Username of “airbeam” as the User in both the Public and Private 
Access Info sections of the Relay Server definition. 

 Specify the AirBEAM Password configured in the WS-2000 as the Password in both the 
Public and Private Access Info sections of the Relay Server definition. 

 Specify the IP Address from which MSP can access the FTP Server of the WS-2000 in the 
Public Access Info section of the Relay Server definition. 

Note:  

The exact IP Address required may depend on how the WS-2000 is configured (e.g., 
LAN, WAN, NAT). 

 Specify the IP Address from which devices can access the FTP Server of the WS-2000 in the 
Private Access Info section of the Relay Server definition. 

Note:  

The exact IP Address required may depend on where/how the WS-2000 is deployed 
within the Enterprise. 

 Specify the same path for both the Public and Private Access Info sections of the Relay 
Server definition.  The path used must be prefixed with “/compactflash” (e.g. 
/compactflash/MSP) to ensure correct operation of the Relay Server. 
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Important: 

Before a CF card can be used in the WS-2000 FTP Server, you must configure the WS-2000 to 
enable CF Card Access (via LAN and/or WAN as appropriate). 

You must also format the CF card using the following commands issued via the CLI (command 
line interface) of the WS-2000, where the text in bold represents the CLI prompts presented by 
the WS-2000. 

admin >system 
admin(system) >exec cformat 

 

 

Other FTP Servers 
Any other FTP Servers should be usable with MSP as long as they are compliant to required 
RFCs, as described in Understanding MSP 3.3.1 – Understanding MSP Security. 
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Chapter 9 – Device Attribute 
Administration 

Manually Creating Device Attributes 
Some possible reasons why Device Attribute might be manually created include: 

 A Device Attribute needs to be referenced (e.g. to define an Applicability Rule) before any 
value for it has been defined. 

 A Device Attribute needs to be created with non-default flags (e.g. to change whether it is 
stored or whether it is included in the MSP Asset Reporting Tables). 

 A Device Attribute needs to be created with a pre-defined list of potential values. 

When a Device Attribute is manually created, it must be assigned a new unique name and ideally 
should be assigned a meaningful description.  In addition, values may be specified for the 
following flags: 

 Store With Device 

This flag indicates whether the values assigned to this Device Attribute for various devices 
should be stored with those devices in the MSP Database. 

If the “Store With Device” flag for a Device Attribute is set to False, then no values assigned 
to that Device Attribute for any device will be stored in the MSP Database, regardless of how 
the values are Originated.  If the “Store With Device” flag for a Device Attribute is set to True, 
then the value assigned to that Device Attribute for each device will be stored with that device 
in the MSP Database, regardless of how the value is Originated. 

Even when a Device Attribute is created automatically, the “Store With Device” flag for that 
Device Attribute would most commonly be set to True to ensure that the values assigned to 
devices for that Device Attribute will be stored with those devices in the MSP Database.  In 
some cases, it may be beneficial to manually create a Device Attribute and set the “Store 
With Device” flag for that Device Attribute to False or to change the “Store With Device” flag 
to False for an existing Device Attribute. 
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For example, if there were a Device Originated Device Attribute that was infrequently used for 
debugging purposes, it might be desirable to manually create that Device Attribute and pre-
define that Device Attribute with the “Store With Device” flag set to False.  Doing so would 
reduce the load on MSP by preventing any values from being stored in the MSP Database 
for that Device Attribute for any devices. 

Notes: 

If the “Store With Device” flag for a Device Attribute is set to False, and if values for 
the Device Attribute are later needed, such as for troubleshooting, the “Store With 
Device” flag could be changed to True.  That would cause future values of that 
Device Attribute to be stored as they become available. 

Once such values are no longer needed, the “Store With Device” flag could be 
changed back to False so subsequent values will no longer be stored in the MSP 
Database. 

When the “Store With Device” flag is changed to False, new values will not be stored 
in the MSP Database as they become available.  But values that were previously 
stored in the MSP Database will not be deleted.  If it is important to delete 
previously stored values, the Device Attribute would need to be deleted and re-
created with the “Store With Device” flag set to False of the Device Attribute could 
be deleted for individual devices to remove just the values stored for those devices. 

 Should be Unique 

This flag indicates whether this Device Attribute is expected to have a unique value for each 
device.  When defining a Parent/Child Device Relationship based on Device Attributes, 
Device Attributes selected for the Child must have this flag set to True.  This ensures that the 
Device Relationship can be computed reasonably. 

 Use in Asset Reporting 

This flag indicates whether this Device Attribute will be included in the MSP Asset Reporting 
Tables 

Note: 

A value of True is meaningful only if Asset Reporting is enabled.  For more 
information on Asset Reporting, see Chapter 15 – Asset Reporting. 

The “Use in Asset Reporting” flag for a Device Attribute will be set to True by default 
whenever a Device Attribute is automatically created due to the assignment of a value to the 
first device for a previously unknown Device Attribute.  The “Use in Asset Reporting” flag for a 
Device Attribute can be set to True or False if a Device Attribute is created manually. 

If the “Use in Asset Reporting” flag for a Device Attribute is set to False, then MSP will not 
include values for that Device Attribute in the MSP Asset Reporting Tables for any devices.  
If the “Use in Asset Reporting” flag for a Device Attribute is set to True, then MSP will include 
subsequent values for that Device Attribute in the MSP Asset Reporting Tables for all 
devices. 
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Once a Device Attribute exists, the value of the “Use in Asset Reporting” flag can be changed 
by editing the Device Attribute.  Changing the value of the “Use in Asset Reporting” flag for 
an existing Device Attribute will cause MSP to update the schema of the MSP Asset 
Reporting Tables. 

Notes: 

While other flags may be changed at any time, the “Use in Asset Reporting” flag for 
a Device Attribute can be changed for an existing Device Attribute only while Asset 
Reporting is disabled.  For more information on Asset Reporting, see Chapter 15 – 
Asset Reporting. 

When the value of the “Use in Asset Reporting” flag for a Device Attribute is 
changed from False to True, the schema for the MSP Asset Reporting Tables will be 
updated to reflect the addition of a new column for that Device Attribute. 

When the value of the “Use in Asset Reporting” flag for a Device Attribute is 
changed from True to False, the schema for the MSP Asset Reporting Tables will be 
updated to reflect the removal of the column for that Device Attribute.  All values in 
the removed column of the MSP Asset Reporting Tables will be immediately 
deleted. 

When Asset Reporting is enabled after making changes to the “Use in Asset 
Reporting” flags for one or more Device Attributes, the updated schema for the MSO 
Asset Reporting Tables, that reflects the changes made, will be available for use in 
Asset Reporting.  

 Show On Rule Creator 

This flag indicates whether this Device Attribute should be shown in the drop-down list 
presented by the Rule Creator used to create and edit Applicability Rules for Policies, 
Actions, Collection Requests, and Device Saved Filters. 

If the “Show On Rule Creator” flag for a Device Attribute is set to False, then that Device 
Attribute will not be shown in the drop-down list and hence cannot be used in Applicability 
Rules.  If the “Show On Rule Creator” flag for a Device Attribute is set to True, then that 
Device Attribute will be shown in the drop-down list and hence can be used in Applicability 
Rules. 

The “Show On Rule Creator” flag for a Device Attribute will be set to True by default 
whenever a Device Attribute is automatically created due to the assignment of a value to the 
first device for a previously unknown Device Attribute.  The “Show On Rule Creator” flag can 
be set to True or False if a Device Attribute is created manually.  Once a Device Attribute 
exists, the value of the “Show On Rule Creator” flag can be changed by editing the Device 
Attribute. 

 Store Values for Rule Creator 

This flag indicates whether all values ever seen at any time from any device for the Device 
Attribute should be kept track of in the MSP Database. 

Note: 

The “Store Values for Rule Creator” flag for a Device Attribute can only be specified 
when the “Show On Rule Creator” flag for that Device Attribute is set to True. 
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If the “Store Values for Rule Creator” flag for a Device Attribute is set to False, then MSP 
does not keep any historical record of the values that have been seen over time for that 
Device Attribute.  If the “Store Values for Rule Creator” flag for a Device Attribute is set to 
True, then MSP maintains a history of all values of that Device Attribute that have ever been 
seen from any device.  This includes values of that Device Attribute that are not currently 
assigned to any device. 

When values are stored for a Device Attribute, those values can be used within the Rule 
Creator to select values to compare the Device Attribute against.  Keeping a list of values can 
save time and reduce errors from mistaken entry, if the list is of manageable size.  If the list of 
values is becomes long, keeping the list of values may become impractical and lose its 
benefit. 

The “Store Values for Rule Creator” flag for a Device Attribute will be set to False by default 
whenever a Device Attribute is automatically created to avoid storing a list of values that may 
be quite long.  The “Store Values for Rule Creator” flag can be set to True or False if a 
Device Attribute is created manually.  Once a Device Attribute exists, the value of the “Store 
Values for Rule Creator” flag can be changed by editing the Device Attribute. 

When the ”Store Values for Rule Creator” flag for a Device Attribute is set to True, the list of 
values stored for that Device Attribute can be viewed or edited.  Creating a list of “common 
values” can be especially useful when manually creating a Device Attribute.  This can make it 
easy for a User to select and appropriate value from within the Rule Creator. 

Editing Device Attributes 
In some cases, a Device Attribute may be created manually, but may need to be changed, either 
because a mistake was made or because circumstances have changed.  In other cases, a Device 
Attribute may have been created automatically, causing it to be assigned default flag values, as 
described above.  In such cases, it may make sense to edit the Device Attribute.  It may be 
desirable to edit a Device Attribute to supply a meaningful description for a Device Attribute that 
was automatically created. 

To edit a Device Attribute, click the Edit link in the Related Tasks area of the Attributes Detail 
page for that Device Attribute. 

Clearing Device Attribute Values 
Prior to MSP 3.3.1, it was not possible to delete a Device Attribute completely from the MSP 
Database once it became known.  Instead, a mechanism was provided to clear all the values 
assigned to a Device Attribute for all devices.  But even once all values were cleared, once a 
Device Attribute was known by MSP, it would always appear on the Attributes page of the 
Library tab of the MSP Console UI. 

Beginning with MSP 3.3.1, there is now a way to delete a Device Attribute completely from the 
MSP Database.  Consequently, there is no longer a way to clear all the values assigned to a 
Device Attribute for all devices without also deleting the Device Attribute 

Note: 

To produce the prior effect of only clearing all values for a Device Attribute, a Device Attribute 
would need to be deleted and then re-created with identical flags. 
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Deleting Device Attributes 
In some cases, a Device Attribute may have been created, automatically or manually, and it may 
be desirable to delete that Device Attribute.  This might be done if the Device Attribute was used 
for some purpose that is no longer relevant.  Deleting a Device Attribute in such a situation can 
help keep “clean up” the MSP System and keep it less cluttered and easier to use.   

Prior to MSP 3.3.1, it was not possible to delete a Device Attribute completely from the MSP 
Database once it became known.  Beginning with MSP 3.3.1, it is now possible to delete a Device 
Attribute completely from the MSP Database.  Once a Device Attribute is deleted, it will no longer 
appear on the Attributes page of the Library tab of the MSP Console UI. 

Notes: 

Deleting a Device Attribute, will also clear all values assigned to the Device Attribute for all 
devices. 

To delete a Device Attribute, click the Delete link in the Related Tasks area of the Attributes 
Detail page for that Device Attribute. 
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Chapter 10 – Object Administration 

Exporting and Importing Objects 
As discussed earlier, a complete backup of the MSP Database is very important to perform 
periodically to ensure continuity in the event of a catastrophic failure. 

Note: 

Backing up and restoring the MSP Database is an all-or-nothing proposition.  If changes have 
been made since the last backup, they will be lost in that event that a restore is performed, since 
MSP will revert to the exact state it was in when that backup was taken. 

In some cases there is value in saving some or all of the Objects that have been created within 
an MSP system, instead of or in addition to backing up the entire MSP Database.  This is 
accomplished from the XML Export page of the Transfer tab of the MSP Console UI. 

When MSP installs, it creates the \\Program Files\ Motorola MSP\Transfer folder and several 
subfolders which will hold all the Objects, Add-On Kits, and other items included with MSP. When 
you import any of these items, the Administration Program will look for them in this folder by 
default. When you export any items, MSP will by default export them to this folder. 

Before you import items appropriate for use in MSP from outside MSP. It is recommended that 
you place them in the appropriate subfolder of the \\Program Files\ Motorola MSP\Transfer folder. 
A shortcut to the Transfer folder can be activated by clicking Start > All Programs > Motorola 
MSP > Transfer Folder on the MSP Server. 

Note: 

While there are definitely times when using the MSP Export as XML feature is useful, it should 
not be treated as a viable substitute for periodic backups.  Unlike a backup of the MSP Database, 
not everything about a running MSP system can be saved by exporting.  Rebuilding a working 
MSP system solely from exported information could require a significant amount of work. 

Why Export Objects? 
There are many reasons why you might want to export some or all of your MSP Objects, 
including: 
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 Saving important changes made since the last backup as a protection in cases of 
catastrophic failure between backups.  Following a restore of a backup, a .XML file containing 
saved Objects could be imported to save re-entry of those Objects. 

 Saving copies of “test” Objects that are used only occasionally.  Once exported, such Objects 
could be deleted from MSP and then later could be restored by importing them back. 

 As a time saver when more than one MSP Server needs to be configured with the same set 
of Objects.  The Objects can be defined in one MSP Server, exported, then imported into the 
other MSP Server. 

 In the event that it is ever necessary or desirable to reinstall MSP without keeping the data 
and without restoring a backup, an MSP system could be installed and saved Objects could 
be imported.  This would not result in an identical MSP system, since it would not have any of 
the historical data.  But it would have all the same Objects and would eventually rediscover 
and resynchronize with all active devices. 

How to Export Objects 
Objects can be exported to a .XML file from the XML Export page of the Transfer tab of the MSP 
Console UI.  When exporting Objects from an MSP Server, you can choose to export all Objects 
of all types as a single .XML file or to export all Objects of only a single type (e.g. all Bundles) to a 
single .XML file.  No mechanism is provided to upload only some of the Objects of a given type. 

In addition to exporting as XML, certain types of Objects can be exported as .CSV Files.  This is 
intended to enable creation of these types of MSP Objects in bulk, as discussed in the following 
section. 

For the Object types that support exporting as .CSV Files, this method also be used to export and 
import individual Objects.  Objects that support this method can be exported to a .CSV File using 
the Export CSV link in the Related Tasks area of the Detail page for the Object.  This can be an 
advantage over exporting as XML since there is no way to export individual Objects using XML. 

Important: 

When importing large numbers of Objects, especially Administrative Objects, such as Sites and 
Relay Servers, it may be helpful to stop all the MSP Services except the MSP Web Application 
before importing Objects.  This can help reduce contention where MSP Services process Objects 
in the background as they are being created, thus slowing down the import process.  Be sure to 
start the MSP Services again after importing the Objects. 

In some cases, importing very large numbers of Objects from the MSP Console UI may simply be 
impractical because the time required is too long and the Web Browser times out waiting for the 
import to complete.  For such cases, the import can be performed from the MSP Administration 
Program instead of from the MSP Console UI.  When importing from the MSP Administration 
Program, it is usually advisable to stop all the MSP Services before importing the Objects and 
then restart the services after importing the Objects. 

Creating MSP Objects in Bulk 
To create MSP Objects in bulk, you need to create and then upload a suitable .CSV File 
containing the information needed to create the Objects.  To create a starter .CSV File of the 
proper format, create a single Object of the desired type and export it to a .CSV File via the 
Export CSV link in the Related Tasks area of the Detail page for the Object. 

 



Chapter 10 – Object Administration -- 113 

Note: 

Not all types of MSP Objects can be exported as a .CSV File.  Any Object where an Export CSV 
link is present in the Related Tasks area of its Detail page supports the ability to be created in 
bulk.  This is supported for those types of Objects that are most commonly needed to be created 
in bulk, including Security Objects, such as Authentication Source Objects and User Objects, and 
Administrative Objects, such as Network Settings Objects, Relay Server Objects, and Site 
Objects. 

Once a starter .CSV File has been exported, it can be modified with a text editor to add more 
Objects.  The first row of the .CSV File contains the name of the Settings Class for the Object and 
should not be modified.  The second row contains the names of fields of information that will 
define the Object and should never be modified.  The third row contains the information about the 
fields for the single MSP Object that was exported, in the order they were listed in the second 
row.  The third row can be altered or removed as desired.  Additional rows with the same format 
as the third row can be added to define additional Objects. 

In cases where fields in the .CSV represent items that are normally encrypted, they will be 
exported encrypted into the starter .CSV File.  An encrypted field will be preceded by a lower-
case “e” character.  When editing an encrypted field in a .CSV File or creating additional rows, 
there is no way to externally generate encrypted values to enter into the .CSV File.  But 
unencrypted values can be entered by preceding the value by a lower-case “p” character. 

Important: 

When information that would normally be encrypted is entered unencrypted into a .CSV File, it 
could represent a security risk.  Once the .CSV File is imported into MSP, it will be encrypted 
within MSP and can only be exported encrypted.  But the original .CSV File should be carefully 
protected, such as by encrypting and Password protecting it, or by deleting it and replacing it with 
an exported file containing the encrypted version of the same information. 

The following example may help to illustrate this concept.  Consider that a Relay Server Object is 
created with a name of “test” and that has an FTP Server User Name of “User” and Password of 
“pass”.  Exporting a .CSV File might result in the following: 

RelayServer 

name,privateprotocol,privateServerip,privateport,privateUser 
Name,privatePassword,privatepath,privatepassivemode,publicsameasprivatemode,pu
blicprotocol,publicServerip,publicport,publicUser 
Name,publicPassword,publicpath,publicpassivemode,publictimezone,publicwindowst
art,publicwindowend,controlstart,controlend,maxcollectionfiles 

"test","0","10.10.10.10","21","User",eRFVf+LckngJfhRL+LbwfsA==,"/","1","0","0"
,"10.10.10.10","21","User",eRFVf+LckngJfhRL+LbwfsA==,"/","1","13","00:00","00:
00","00:00","00:00","24" 

 

The exported.CSV File, shown above, contain three rows even though they are long rows and 
appear to wrap onto multiple lines. 

 



114 -- Administering MSP 3.3.1 
 

The value “eRFVf+LckngJfhRL+LbwfsA==” represents the encrypted value of the FTP Password 
“pass”.  It appears in two places since the same Password was specified for both the Public and 
Private parts of the Relay Server.  To edit the .CSV File to change the Password to “newpass” for 
just the Private part of the Relay Server, the value “eRFVf+LckngJfhRL+LbwfsA==” would be 
replaced by the value “pnewpass”.  If the modified .CSV File was imported and then exported 
again, the result would look like: 

RelayServer 

name,privateprotocol,privateServerip,privateport,privateUser 
Name,privatePassword,privatepath,privatepassivemode,publicsameasprivatemode,pu
blicprotocol,publicServerip,publicport,publicUser 
Name,publicPassword,publicpath,publicpassivemode,publictimezone,publicwindowst
art,publicwindowend,controlstart,controlend,maxcollectionfiles 

"test","0","10.10.10.10","21","User",e3lBAxm1QToW50EGEvXMFTA==,"/","1","0","0"
,"10.10.10.10","21","User",eRFVf+LckngJfhRL+LbwfsA==,"/","1","13","00:00","00:
00","00:00","00:00","24" 

 

As can be seen above, the value “e3lBAxm1QToW50EGEvXMFTA==” represents the encrypted value 
of the new FTP Password “newpass”. 

How to Import Objects 
Objects can be imported from a .XML file from the XML Import page of the Transfer tab of the 
MSP Console UI.  When importing Objects to an MSP Server from a .XML file, MSP always 
imports all Objects in the file.  If one or more errors occur, MSP continues trying to import 
additional Objects.  This can cause “cascading errors” where a failure to import one Object could 
cause a failure to import later Objects in the same file. 

As mentioned above, in addition to importing as XML, certain types of Objects can be imported as 
.CSV Files.  Objects that support this method can be exported from a .CSV File using the CSV 
Import page of the Transfer tab of the MSP Console UI. 

Export/Import and Object References 
When exporting and importing MSP Objects via .XML files, it is important to understand that 
Objects can have references to other Objects.  For example, a Bundle Object often references 
one or more Package Objects. 

If you export all Objects of all types, MSP will ensure that when the Objects are re-imported from 
the single .XML file containing all Objects, that they are processed in an order that avoids forward 
references.  For example, if a Policy references a Bundle, the Bundle will be processed before 
the Policy.  This ensures that no errors result from referencing an Object before it exists. 

If you export Objects of only a single type (e.g. all Bundles) as a single .XML file, you must 
ensure that you also export Objects of any referenced types.  And when importing .XML files, you 
must ensure that .XML files containing Objects of referenced types are imported before .XML files 
containing Objects of referencing types.   Failure to do this can result in import failures do to 
unresolved Object references. 

Object Types that cannot be Exported/Imported 
Most important types of MSP Objects can be exported as .XML files, but certain Object Types 
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cannot.  Some of these Object Types may be referenced by, or may influence the use or 
operation of Objects Types that can be exported.  It may be necessary or desirable to re-create 
referenced Object Types before importing Object Types that reference them. 

In cases where the original Objects were uploaded into MSP from an external file, re-uploading 
them from the original external file may be the best choice, assuming the original external files 
are still available.  In other cases, there may be no viable substitute for re-entering the information 
via the MSP Console UI.  The following list identifies the types of Objects that cannot be exported 
and the ways in which such Objects might need to be reproduced: 

Bookmark Objects 
Bookmark Objects can be created by MSP Console UI Users to keep track of useful Analysis or 
Troubleshooting pages they have visited and may later wish to return to. 

Important: 

There is no way to export or import Bookmark Objects from the MSP Console UI. 

If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then all Bookmark Objects will be restored to 
what was known at the time the backup was taken.  If a new MSP Server is being commissioned 
to replace an existing MSP Server, then no Bookmark Objects will be known.  If a new (non-
replacement) MSP Server is being commissioned, then no Bookmark Objects will be known. 

When a replacement MSP Server is commissioned using a backup, it is possible that new 
Bookmark Objects may have been created since the backup was taken.  In such cases, any 
required Bookmark Objects would need to be re-created manually by the MSP Console UI Users 
that originally created them.    When a replacement MSP Server is commissioned without using a 
backup, then any required Bookmark Objects would need to be re-created manually by the MSP 
Console UI Users that originally created them.  When a new (non-replacement) MSP Server is 
being commissioned, any required Bookmark Objects would need to be re-created manually by 
the MSP Console UI Users that originally created them. 

Definition Document Objects 
Definition Documents are uploaded to MSP to define or update Settings Classes or Condition 
Classes.  When a Definition Document is uploaded into MSP, it results in a new or replaced 
Definition Document Object in the MSP Database. 

Important: 

There is no way to export Definition Documents from the MSP Console UI. 

Whenever Definition Documents are uploaded into an MSP Server, copes of them are stored in 
the folder “temp\xmldefdocs” relative to the install directory (e.g. C:\Program Files\Motorola 
MSP\temp\xmldefdocs).  In the event that the original uploaded copies cannot be found, they 
could be recovered from this folder. 

This folder should not be treated as a “master repository” of Definition Documents. 

If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then all Definition Documents will be restored to 
what was known at the time the backup was taken.  When a new MSP Server is being 
commissioned, only the default Definition Documents installed as part of MSP will be known. 
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When a replacement MSP Server is commissioned using a backup, it is possible that Definition 
Documents may have been uploaded since the backup was taken.  In such cases, any required 
non-default Definition Documents would need to be uploaded.    When a replacement MSP 
Server is commissioned without using a backup, then any required non-default Definition 
Documents would need to be uploaded. 

It is possible that some Settings Objects or Conditions Objects to be imported may depend on 
new or updated Definition Document Objects that are not present.  Attempting to import Objects 
that reference Definition Document Objects that are not present will result in an import failure.  
Attempting to import Objects that reference Definition Document Objects that do not match the 
Definition Documents used to create those Objects may cause unpredictable results.  To ensure 
proper operation, all required non-default Definition Documents should be uploaded before 
Objects that reference them are imported. 

Important: 

The MSP Database should not be treated as a “master repository” of Definition Documents.  It is 
highly advisable to maintain external copies of all Definition Documents that are uploaded into an 
MSP Server.  This allows these Definition Documents to be uploaded into the same or a different 
MSP Server whenever they might be required. 

New Definition Documents are typically distributed as part of MSP Add-On Kit .ZIP Files and will 
generally be uploaded as part of the installation those Add-On Kit ZIP Files.  In most cases, the 
best way to upload such Definition Documents would be to install the Add-On Kit(s) that were 
originally used to install them.  For more information on MSP Add-On Kit .ZIP Files, see Chapter 
14 – MSP Add-On Kits. 

Devices 
Device Objects are created automatically by MSP as managed devices are discovered via 
Discovery Documents sent to Relay Servers by devices and pulled from those Relay Servers by 
MSP.  MSP maintains a history of information about and operations performed for and by devices 
over their managed lifetime with that MSP Server. 

Important: 

There is no way to create, export, or import devices from the MSP Console UI. 

There is no way to create, export, or import device history information from the MSP Console UI. 

If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then the list of known devices and all history 
information about those devices will be restored to what was known at the time the backup was 
taken.  If a new MSP Server is being commissioned to replace an existing MSP Server, without 
using a backup, then no devices will initially be known.  If a new (non-replacement) MSP Server 
is being commissioned, then no devices will initially be known. 
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When a replacement MSP Server is commissioned, without using a backup, once Relay Servers 
have been defined and activated the new MSP Server can begin re-discovering devices that are 
checking-in with those Relay Servers.  When a new (non-replacement) MSP Server is being 
commissioned, once some Relay Servers are defined the MSP Server can begin initially 
discovering devices that are checking-in with those Relay Servers. 

Important: 

If a new (non-replacement) MSP Server is being commissioned to take over the management of 
the devices on some Relay Servers, it should not be configured to use any Relay Servers that 
are still being used by the existing MSP Server.  Any “transferred” Relay Servers should be 
deactivated and deleted from the existing MSP Server before they are imported into and 
activated on the new MSP Server. 

Depending on how frequently devices are set to check-in, how often devices are configured to 
upload Discovery Documents, and the number of active Relay Servers, the time required to 
(re)discover devices will vary. 

Notes: 

When devices are initially discovered by a given MSP Server, they will have no history 
information within that MSP Server.  The history of any managed device, on a given MSP Server, 
begins with its initial discovery by that MSP Server. 

Devices that were previously known might have become “Missing” because they stopped 
checking-in with their assigned Relay Server.  Or they might have become “Orphaned” because 
their assigned Relay Server was deleted.  If such situations still exist, then those devices might 
not be (re)discovered by a new MSP Server until the situation is corrected.  Lists of such devices 
could be obtained from the existing MSP Server by using the Filter function on the Device 
Status page of the Status tab of the MSP Console UI to get a list of “Missing” or “Orphaned” 
devices.  Having as list of such devices could by invaluable when trying to determine and correct 
the reasons why they are not discovered. 

Device Attributes 
Device Attributes can be created manually from the Attributes page of the Library tab or can be 
created automatically the first time a value is assigned to a Device Attribute for any device. 

Important: 

There is no way to export or import Device Attributes from the MSP Console UI. 

It is possible to use the View as Excel button to view a list of all the Device Attributes known by 
MSP and some information about each.  This information is not in a format that can be imported 
back into MSP.  Nonetheless, this information might use useful later if Device Attributes need to 
be re-created or edited manually. 

If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then Device Attributes will be restored to what 
was known at the time the backup was taken.  If a new MSP Server is being commissioned to 
replace an existing MSP Server, without using a backup, then no Device Attributes will be known 
except those that are defined by default as part of MSP.  If a new (non-replacement) MSP Server 
is being commissioned, then no Device Attributes will be known except those that are defined by 
default as part of MSP. 
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When a replacement MSP Server is commissioned using a backup, it is possible that Device 
Attributes may have become known since the backup was taken.  In such cases, any required 
non-default Device Attributes might need to be re-created.  When a replacement MSP Server is 
commissioned without using a backup, any required non-default Device Attributes might need to 
be re-created.  When a new (non-replacement) MSP Server is being commissioned, any required 
non-default Device Attributes might need to be re-created. 

The MSP Server will automatically re-create any Device Attributes that is not known at the time 
they is referenced by another Object or the first time value is assigned to that Device Attribute for 
any device.  Such Device Attributes will be created using default characteristics that might or 
might not match the original characteristics.  If the default characteristics of such a Device 
Attribute are not suitable, they can be changed from the Attribute Detail page of the Library tab 
of the MSP Console UI. 

Device Attribute Values 
Device Attribute values can be defined for one or more devices by importing .CSV Files.  Device 
Attribute values can also be defined for devices in a variety of other ways, including by having 
them be Device Originated, as described in Understanding MSP 3.3.1 – Understanding Device 
Attributes. 

Important: 

There is no way to export the values of Device Attributes for devices from the MSP Console UI. 

If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then the values of all Device Attributes for all 
devices will be restored to what was known at the time the backup was taken.  If a new MSP 
Server is being commissioned to replace an existing MSP Server, then no Device Attributes 
values will be known because no devices will be known.  If a new (non-replacement) MSP Server 
is being commissioned, then no Device Attributes values will be known because no devices will 
be known. 

When a replacement MSP Server is commissioned using a backup, it is possible that Device 
Attribute values may have become known since the backup was taken.  In such cases, Device 
Originated Device Attribute values would likely be discovered automatically, but any other 
required Device Attribute values might need to be defined manually.  When a replacement MSP 
Server is commissioned without using a backup, any required non-default Device Attributes might 
need to be defined manually.  When a new (non-replacement) MSP Server is being 
commissioned, any required non-default Device Attributes might need to be defined manually. 

It is possible that some Objects to be imported may depend on the Device Attribute values 
defined for some devices.  This is frequently the case when Dynamic Deployment is used, since it 
relies on Device Attribute values to provide device-specific information.  An imported Dynamic 
Object might work differently, or not at all, for a device for which a critical Device Attribute value 
was not known.  In such a case, any required non-default Device Attributes might need to be 
defined manually. 

File Set Objects 
File Set Objects are created by uploading a File Set .ZIP File from the Upload button on the File 
Sets page of the Library tab of the MSP Console UI. 

Important: 

There is no way to export or import File Set Objects in bulk from the MSP Console UI. 
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Individual File Set Objects can be saved to the File System of a Workstation PC as File Set .ZIP 
Files using the Get ZIP link in the Related Tasks area of the File Set Detail page of the Library 
tab of the MSP Console UI. 

Note: 

When a File Set Object is saved to a File Set .ZIP File, the resulting file reflects the state of that 
File Set Object at the time it was exported, no matter how it got that way.  Exported File Set .ZIP 
Files may therefore be very different from the file(s) that were originally used to create and modify 
them.  For example, a single File Set Object might be created and modified by importing several 
File Set .ZIP Files and/or several Staging Batch .ZIP Files.  An exported File Set .ZIP File for 
such a File Set Object would reflect the final accumulated result of all those uploads. 

If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then all File Set Objects will be restored to what 
was known at the time the backup was taken.  If a new MSP Server is being commissioned to 
replace an existing MSP Server, then no File Set Objects will be known.  If a new (non-
replacement) MSP Server is being commissioned, then no File Set Objects will be known. 

When a replacement MSP Server is commissioned using a backup, it is possible that new File 
Set Objects may have been uploaded or that previously existing File Set Objects may have been 
modified since the backup was taken.  In such cases, any required File Set Objects would need 
to be uploaded.    When a replacement MSP Server is commissioned without using a backup, 
then any required File Set Objects would need to be uploaded.  When a new (non-replacement) 
MSP Server is being commissioned, then any required File Set Objects would need to be 
uploaded. 

Important: 

The MSP Database should not be treated as a “master repository” of File Set Objects.  It is highly 
advisable to export File Set .ZIP Files for all File Set Objects in an MSP Server when they are 
created or modified.  This allows these File Set Objects to be recreated by uploading the .ZIP files 
into the same or a different MSP Server, whenever it might be required. 

Since File Set Objects can be created or modified by uploading one or more File Set .ZIP Files 
and/or Staging Batch .ZIP Files, it is generally a good idea to import all Staging Batch .ZIP Files 
followed by all File Set .ZIP Files.  This ensures that the final state of each File Set Object will be 
determined by the File Set .ZIP File for that File Set Object even if that File Set is also affected by 
the upload of one or more Staging Batch .ZIP Files. 

License Key Objects 
License Key Objects are created when MSP License Keys are entered into the Licensing page 
of the Admin tab of the MSP Console UI.  License Key Objects remain in the MSP Database until 
they are explicitly deleted, although they can expire and no longer be usable. 

Important: 

There is no way to export or import License Key Objects from the MSP Console UI. 

Individual MSP License Keys can be copied (as text, to the Workstation PC clipboard) from the 
Licensing page of the Admin tab of the MSP Console UI. 
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If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then all License Key Objects will be restored to 
what was known at the time the backup was taken.  If a new MSP Server is being commissioned 
to replace an existing MSP Server, then the same MSP License Keys will need to be re-entered.  
If a new (non-replacement) MSP Server is being commissioned, then new MSP License Keys will 
need to be entered. 

When a replacement MSP Server is commissioned using a backup, it is possible that new MSP 
License Keys may have been entered since the backup was taken.  In such cases, any required 
new MSP License Keys would need to be re-entered.    When a replacement MSP Server is 
commissioned without using a backup, then all required MSP License Keys would need to be re-
entered.  When a new (non-replacement) MSP Server is being commissioned, all required new 
MSP License Keys would need to be entered. 

Important: 

MSP License Keys are provided for use on only one MSP Server at a time.  Using the same MSP 
License Keys on multiple MSP Servers is a violation of the MSP License agreement under which 
those MSP License Keys were provided. 

If a new MSP Server is being commissioned for the sole purpose of replacing an existing MSP 
Server then the same MSP License Keys may be used, for a brief duration, to commission the 
new MSP Server, so long as the old MSP Server is decommissioned in a timely manner. 

If a new MSP Server is being commissioned that will be used in parallel with an existing MSP 
Server, then new MSP License Keys must be obtained for the new MSP Server. 

Package Objects 
Packages can be built externally, using the stand-alone MSP Package Builder, and can then be 
uploaded into the MSP Server.  Alternately, Packages can be created from the Create Package 
page of the Builder tab of the MSP Console UI.  In either case, Packages are stored in the MSP 
Database as Package Objects. 

Package Objects can be individually extracted from the MSP Database and stored as Package 
Files by using the Save Package to Disk link in the Related Tasks area of the Package Detail 
page for a Package Object. 

Important: 

There is no way to export or import Packages in bulk from the MSP Console UI. 

Whenever Package Files are uploaded into an MSP Server, copies of them are stored in the 
folder “Archives\Packages” relative to the install directory (e.g. C:\Program Files\Motorola 
MSP\Archives\Packages).  In the event that the original uploaded files cannot be found, they 
could be recovered from this folder. 

This folder should not be treated as a “master repository” of Package Files. 

Except during upload and extraction, MSP operates on Package Objects, not on Package Files.  
MSP therefore does not guarantee or require that any particular Package Files be present in the 
file system of the MSP Server at any other time. 
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If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then Package Objects will be restored to what 
was known at the time the backup was taken.  If a new MSP Server is being commissioned to 
replace an existing MSP Server, without using a backup, then no Package Objects other than 
default Packages installed as part of MSP will initially be known.  If a new (non-replacement) 
MSP Server is being commissioned, then no Package Objects other than default Packages 
installed as part of MSP will initially be known. 

When a replacement MSP Server is commissioned using a backup, it is possible that some 
Package Objects might have been uploaded or deleted since the backup was taken.  In such 
cases, any required new Package Objects would need to be uploaded from Package Files.  
When a replacement MSP Server is commissioned without using a backup, all required non-
default Packages would need to be uploaded from Package Files.  When a new (non-
replacement) MSP Server is being commissioned, all required non-default Packages would need 
to be uploaded from Package Files. 

Important: 

The MSP Database should not be treated as a “master repository” of Packages.  It is highly 
advisable to maintain external copies of all Package Files that are uploaded into an MSP Server.  
This allows these Package Files to be uploaded into the same or a different MSP Server 
whenever they might be required. 

New Package Files are sometimes distributed as part of MSP Add-On Kit .ZIP Files and will 
generally be uploaded as part of the installation those Add-On Kit ZIP Files.  In such cases, the 
best way to upload such Package Files would be to install the Add-On Kit that was originally used 
to upload them.  For more information on MSP Add-On Kit .ZIP Files, see Chapter 14 – MSP 
Add-On Kits. 

For Package Files that are not distributed as part of an MSP Add-On Kit .ZIP File, it is advisable 
to keep the original Package File so it can be used to upload it again if needed. 

Frequently, Bundle Objects reference Package Objects.  If a Bundle Object references a Package 
Object that is not in the MSP Database, then an import failure will occur.  To prevent such a 
failure, any Package Objects that are referenced by Bundle Objects should be made present in 
the MSP Database (by uploading them from Package Files if necessary) before those Bundle 
Objects are imported. 

Important: 

Each Bundle Object references a specific version of a Package.  If the identical version of the 
Package referenced by a Bundle Object is not available on the MSP Server when the Bundle is 
imported, then an import failure will occur. 

SMS Staging Jobs 
SMS Staging Jobs are created from the SMS Staging Jobs page of the Staging tab of the MSP 
Console UI.  SMS Staging Jobs are maintained within the MSP Database and tracked to 
completion. 

Important: 

There is no way to export or import SMS Staging Jobs from the MSP Console UI. 
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If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then SMS Staging Jobs will be restored to what 
was known at the time the backup was taken.  If a new MSP Server is being commissioned to 
replace an existing MSP Server, without using a backup, then no SMS Staging Jobs will initially 
be known.  If a new (non-replacement) MSP Server is being commissioned, then no SMS Staging 
Jobs will initially be known. 

When a replacement MSP Server is commissioned using a backup, it is possible that some 
devices might have completed the SMS Staging Job after the backup was taken.  In such cases, 
SMS messages might be sent to those devices even through they already performed that 
Staging.  When a replacement MSP Server is commissioned without using a backup, SMS 
Staging Jobs would need to be manually recreated before any new SMS messages would be 
sent to Stage devices.  If such SMS Staging Jobs has previously partially completed, then SMS 
messages might be sent to some devices even through they already performed that Staging. 

Resending SMS messages to devices that have already performed the Staging defined in those 
SMS messages should be relatively benign since SMS Staging cannot actually occur on a device 
unless it is approved by the Device User.  The Device User can therefore know that the Staging 
has already be performed and ignore the Staging offered by the SMS messages. 

Staging Batch Objects 
Staging Batch Objects are created by uploading a Staging Batch .ZIP File from the Upload button 
on the Staging Batches page of the Stage tab of the MSP Console UI.  A single Staging Batch 
.ZIP File can create and/or modify one or more File Set Objects.  A single File Set Object can be 
modified by multiple Staging Batch .ZIP Files and/or File Set .ZIP Files. 

Important: 

There is no way to export or import Staging Batch Objects in bulk from the MSP Console UI. 

Individual Staging Batch Objects can be saved to the File System of a Workstation PC as Staging 
Batch .ZIP Files using the Get ZIP link in the Related Tasks area of the Staging Batch Detail 
page of the Library tab of the MSP Console UI.  Individual Staging Batch Objects can be saved 
to the File System of a Workstation PC as Staging Batch Manifest .CSV Files using the Get 
Manifest link in the Related Tasks area of the Staging Batch Detail page of the Library tab of 
the MSP Console UI. 

If an MSP Server is being commissioned to replace an existing MSP Server, using a backup of 
the MSP Database of the existing MSP Server, then all Staging Batch Objects will be restored to 
what was known at the time the backup was taken.  If a new MSP Server is being commissioned 
to replace an existing MSP Server, then no Staging Batch Objects will be known.  If a new (non-
replacement) MSP Server is being commissioned, then no Staging Batch Objects will be known. 
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When a replacement MSP Server is commissioned using a backup, it is possible that new 
Staging Batch Objects may have been uploaded or that previously existing Staging Batch Objects 
may have been modified since the backup was taken.  In such cases, any required Staging Batch 
Objects would need to be uploaded.    When a replacement MSP Server is commissioned without 
using a backup, then any required Staging Batch Objects would need to be uploaded.  When a 
new (non-replacement) MSP Server is being commissioned, then any required Staging Batch 
Objects would need to be uploaded. 

Note: 

Several Staging Batch .ZIP Files and/or File Set .ZIP files could all impact one or more File Set 
Objects.  In such a case, the end state of the File Set Objects could depend on which files are 
uploaded and in what order.  To address such situations, see the recommendation provided in 
the section above on File Set Objects. 

Object Types that can be Exported/Imported 
As described above, most important types of MSP Objects can be exported.  But due to potential 
interactions with types of Objects that cannot be exported, some cautions should be observed 
when exporting these Objects and/or when later importing previously exported Objects.  The 
following types of Objects can be exported and imported: 

Action Objects 
The Applicability Rules for one or more Action Objects that are being imported may reference one 
or more Device Attributes that are not yet known or for which one or more Device Attribute values 
that are not yet known for some or all devices.  This should be handled as described earlier for 
Device Attributes and Device Attribute values. 

The Deployment Steps for one or more Action Objects that are being imported may reference one 
or more Bundle Objects that are not yet known.  This should be handled by importing the required 
Bundle Objects. 

The Readiness Conditions or Detached Conditions for one or more Action Objects that are being 
imported may reference one or more Condition Objects that are not yet known.  This should be 
handled by importing the required Condition Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 

Authentication Source Objects 
No special cautions need to be observed when importing Authentication Source Objects. 

Bundle Objects 
The Deployment Steps for one or more Bundle Objects being imported may reference one or 
more Package Objects that are not yet known.  This should be handled as described earlier for 
Package Objects. 
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The Deployment Steps for one or more Bundle Objects being imported may reference one or 
more Settings Objects that are not yet known.  This should be handled by importing the required 
Settings Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 

Collection Category Object 
One or more Collection Category Objects being imported may reference one or more Collection 
Metric Objects that are not yet known.  This should be handled by importing the required 
Collection Metric Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 

Collection Metric Objects 
No special cautions need be observed when importing Collection Metric Objects. 

Collection Request Objects 
The Applicability Rules for one or more Collection Request Objects that are being imported may 
reference one or more Device Attributes that are not yet known or for which one or more Device 
Attribute values that are not yet known for some or all devices.  This should be handled as 
described earlier for Device Attributes and Device Attribute values. 

One or more Collection Request Objects that are being imported may reference one or more 
Collection Metric or Collection Category Objects that are not yet known.  This should be handled 
by importing the required Collection Metric Objects and/or Collection Category Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 
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Condition Objects 
One or more Condition Objects that are being imported may reference one or more Definition 
Document Objects that are not yet known.  This should be handled as described above for 
Definition Documents. 

Custom/Global Views 
Custom Views allows individual MSP Console UI Users to configure aspects of how the MSP 
Console UI will be displayed to them.  Global Views allows MSP Console UI Users with the 
Security User Role to configure aspects of how the MSP Console UI will be displayed to Users of 
various User Roles who do not elect to define their own Custom Views. 

Prior to MSP 3.3.1 there was no way to export or import Custom/Global Views.  Beginning with 
MSP 3.3.1, Custom/Global Views can now be exported and imported.  Since Custom/Global 
Views information are specific to Device Users and User Roles, exporting and importing of 
Custom/Global Views is permitted only for MSP Console UI Users with the Security User Role. 

One or more Custom/Global Views that are being imported may reference one or more User 
Objects or User Role Objects that are not yet known.  This should be handled by importing the 
required User Objects and/or User Role Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 

Device Saved Filter Objects 
No special cautions need be observed when importing Device Saved Objects. 

Message Set Objects 
No special cautions need to be observed when importing Message Set Objects. 

Provisioning Policy Object 
The Applicability Rules for one or more Provisioning Policy Objects that are being imported may 
reference one or more Device Attributes that are not yet known or for which one or more Device 
Attribute values that are not yet known for some or all devices.  This should be handled as 
described earlier for Device Attributes and Device Attribute values. 

The Deployment Steps for one or more Provisioning Policy Objects that are being imported may 
reference one or more Bundle Objects that are not yet known.  This should be handled by 
importing the required Bundle Objects. 

The Deployment Steps for one or more Provisioning Policy Objects that are being imported may 
reference one or more Site Objects that are not yet known.  This should be handled by importing 
the required Site Objects. 
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The Readiness Conditions or Detached Conditions for one or more Provisioning Policy Objects 
that are being imported may reference one or more Condition Objects that are not yet known.  
This should be handled by importing the required Condition Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 

Relationship Definition Objects 
No special cautions need to be observed when importing Relationship Definition Objects. 

Relay Server Objects 
No special cautions need to be observed when importing Relay Server Objects. 

Settings Objects and Settings Family Objects 
One or more Settings Objects that are being imported may reference one or more Condition 
Objects that are not yet known.  This should be handled by importing the required Condition 
Objects. 

One or more Settings Family Objects that are being imported may reference one or more Settings 
Objects that are not yet known.  This should be handled by importing the required Settings 
Objects. 

Notes: 

Settings Objects and Settings Family Objects are exported together, to the same .XML file, by 
selecting an Export Type of “Settings”.  When imported, this means that all Settings Objects and 
the Settings Family Objects that reference them will be imported together in an order that ensures 
that referenced Settings Objects are created before the Settings Family Objects that reference 
them. 

Site Objects 
One or more Site Objects that are being imported may reference one or more Settings Objects 
that are not yet known.  This should be handled by importing the required Settings Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 
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SMS Carrier Objects 
No special cautions need to be observed when importing SMS Carrier Objects. 

SMS Device Objects 
One or more SMS Device Objects that are being imported may reference one or more SMS 
Carrier Objects that are not yet known.  This should be handled by importing the required SMS 
Carrier Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 

Staging Profile Objects 
One or more Staging Profile Objects that are being imported may reference one or more Settings 
Objects that are not yet known.  This should be handled by importing the required Settings 
Objects. 

One or more Staging Profile Objects that are being imported may reference one or more Relay 
Server Objects that are not yet known.  This should be handled by importing the required Relay 
Server Objects. 

One or more Staging Profile Objects that are being imported may reference one or more Site 
Objects that are not yet known.  This should be handled by importing the required Site Objects. 

The Deployment Steps for one or more Staging Profile Objects that are being imported may 
reference one or more Bundle Objects that are not yet known.  This should be handled by 
importing the required Bundle Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 

User Objects 
One or more User Objects that are being imported may reference one or more User Role Objects 
that are not yet known.  This should be handled by importing the required User Role Objects. 

User Role Objects 
No special cautions need to be observed when importing User Role Objects. 
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Widgets Configuration 
Widgets Configuration allows the configuration of the Widgets that will be displayed on the Start 
page of the MSP Console UI for various Users.  Custom Widgets Configuration allows MSP 
Console UI Users to configure the Widgets that will be displayed on their Start page of the MSP 
Console UI.  Global Widgets Configuration allows MSP Console UI Users with the Security User 
Role to configure the Widgets that will be displayed on the Start page for Users of various User 
Roles who do not elect to define their own Custom Widgets Configuration. 

Prior to MSP 3.3.1 there was no way to export or import the information defined for 
Custom/Global Widgets Configuration.  Beginning with MSP 3.3.1, Custom/Global Widgets 
Configuration can now be exported and imported.  Since this information is specific to Device 
Users, exporting and importing of Widgets Configuration is permitted only for MSP Console UI 
Users with the Security User Role. 

Custom/Global Widgets Configuration that is being imported may reference one or more User 
Objects or User Role Objects that are not yet known.  This should be handled by importing the 
required User Objects and/or User Role Objects. 

Notes: 

When more than one type of Object is being imported from the same .XML file, the MSP Server 
will automatically process Objects being imported in an order that ensures that import failures do 
not occur due to “forward references” to Objects defined in the same .XML file. 

If multiple .XML files are being imported, then .XML files that contain referenced Objects must be 
imported before .XML files that contain referencing Objects. 
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Chapter 11 – The MSP Administration 
Program 

Introduction 
The MSP Administration Program is installed on the MSP Server when MSP is installed. It 
provides an interface through which you can administer MSP Services, enable/disable MSP 
functionality, and import/export MSP Objects and data. 

Operational Context and Accounts 
This section discusses the context in which various operations are performed and the various 
accounts that may have a bearing on the operation of the MSP Administration Program. 

Windows Server User Account 
As mentioned earlier, a User must have access to the Windows Server Console in order to use 
the MSP Administration Program.  This means that the User must have a Windows Server User 
Account, and suitable credentials to login to that account.  While logged into the Windows Server 
Console, a User will have direct access to resources on that Server (e.g. to its File System, etc.) 
as granted by that account.  Some of those resources will generally be shared and some may be 
private. 

The MSP_SERVICE_ACCOUNT 
The MSP Administration Program is designed to administer and access information that is 
internal to the MSP Server itself.  The MSP Administration Program operates within the context of 
a special Windows Server User Account called the MSP_SERVICE_ACCOUNT.  The 
MSP_SERVICE_ACCOUNT allows the MSP Administration Program to access certain important 
internal information related to MSP. 

Since the MSP Administration Program does not operate within the context of an individual 
User’s account, the MSP Administration Program might not have access to some Server 
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resources that the User could access directly from outside the MSP Administration Program.  For 
example, the MSP Administration Program might not be able to access certain folders that are 
private to that User. 

Launching the MSP Administration Program 
In order to launch and utilize the MSP Administration Program a User should be logged in under 
a Windows Server User Account which belongs to the group “Administrators”.  To launch the 
MSP Administration Program, Click Start->Programs->Motorola MSP->MSP Admin. 

MSP Administration Program Authentication 
To prevent use by unauthorized users, the MSP Administration Program requires the User to 
authenticate. 

Notes: 

It is not possible to use LDAP Authentication Sources to authenticate with the MSP 
Administration Program - only authentication against the MSP Authentication Database is 
supported. 

The MSP Administration Program will continue to authenticate against the MSP Authentication 
Database even if the use of the MSP Authentication Database for authentication during login to 
the MSP Console UI is disabled. 

When the MSP Administration Program is launched, the user is prompted to authenticate, as 
shown in Figure 20 below. 

 

Figure 20 –MSP Administration Program Login Screen 
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Access to the MSP Administration Program, is restricted to MSP System Administrators.  This 
means that a User must enter the User Name and a Password of an MSP Console UI User that 
is assigned either a User Role of either Security or Administrator.  Once the credentials are 
entered, click the Sign In button. 

Notes: 

The MSP Administration Program offers the same functionality when logged in as an MSP 
Console UI User with a User Role of Security or Administrator. 

The Access Scope assigned to an MSP Console UI User is relevant, just as it is when logged into 
the MSP Console UI.  This means that the User Access Prefixes assigned to a User may limit the 
set of Objects they can import and export using the MSP Administration Program. 

Transfer Subfolders 
To simply the use of various functions of the MSP Administration Program, subfolders under 
“Transfer” relative to the install directory (e.g. C:\Program Files\Motorola MSP\Transfer) are 
created during MSP installation.  These subfolders can be used to transfer information into and 
out of MSP and simplify dealing with the fact the context between the 
MSP_SERVICE_ACCOUNT and the User’s account may be different. 

When using MSP Administration Program functions that require files to be read from the Windows 
Server File System, the files should first be placed in an appropriate transfer subfolder by the 
User from outside the MSP Administration Program.  The files can then be accessed from that 
transfer subfolder using the MSP Administration Program. 

When using MSP Administration Program functions that require files to be written to the Windows 
Server File System, the files should be directed to a suitable transfer subfolder using the MSP 
Administration Program.  The files can then be accessed from that transfer subfolder by the User 
from outside the MSP Administration Program. 

The various transfer subfolders, and the MSP Administration Program functions from which thety 
are used are shown in Table 5 below. 

Subfolder Used By 

Transfer\Xml  Import .XML Files 

Export .XML Files 

Transfer\Csv Import .CSV Files 

Transfer\Addons Import Add-On Kit .ZIP Files 

Transfer\DiagnosticFiles Export Diagnostic .ZIP Files 

Transfer\ServiceLogs Save Service Log to File 
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Table 5 – Transfer Subfolders 

Interface Overview 
The MSP Administration Program has a Navigation pane on the left and an Activity pane on the 
right. The program opens to show the Services page, as shown in Figure 21 below. 

 

Figure 21 –MSP Administration Program Main Screen 

Menu Bar Options 
These Menu bar options are available from all MSP Administration Program views 

 File - You can Exit the MSP Administration Program. 

 View – You can select the offered choices to go to the Services or Configuration views. You 
can select Start/Stop Services to open a new window where you can Start/Stop all Services 
or individual Services. 

 Utilities – You can select links to take you to pages where you can Import XML, CSV files, 
or Add-On Kits. You can select links to take you to pages where you can Export XML and a 
Diagnostic file. 

Services View Functionality 

Service Icon Meanings 
A Green Status icon ( ) next to a listed services means the Service is installed and running.  A 

Red Status icon ( ) means the Service is installed but stopped.  A Yellow Status icon ( ) 

means the Service is installed but in the process of starting/stopping.  A Black Status icon ( ) 
means the Service is not installed. 
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Start/Stop All Services 
Right-click MSP Services in the Navigation pane and select Start or Stop All Services. 

OR 

Click View in the Menu bar and select Start/Stop Services. A Manage Services window will 
open where you can click Start All or Stop All, as appropriate. 

Stop/Start Individual Services 
Right-click the appropriate Service in the Navigation pane and select Start Service or Stop 
Service. 

OR 

Click the appropriate Service link in the Activity pane. When the Service Control page displays, 
click Start or Stop. 

OR 

Click View in the Menu bar and select Start/Stop Services. A Manage Services window will 
open where you can click Start or Stop, as appropriate, for individual Services. 

Service Information and Service Logging 

Service Information 
If you click on an individual Service in the right or left pane of the Services view, a Control page 
for that Service will display in the right pane. If the Service is installed, you will see the Version of 
the Service that is installed, the directory in which the Service is installed, the UUID of the 
Service, and the Logon Account of the Service, if applicable. If the Service is not installed, you 
will see a message to that effect. 

Service Logging 
Not only can you Start and Stop an individual Service from its Control page, but also you can 
access Service Logs of DEBUG, INFO, and WARNING level messages for the MSP Service. 
From the Control page, click the Logging tab. When the logging information displays (this may 
take up to several seconds), the information will display from the most recent (top of page) to the 
oldest (bottom of page). 

You can Save the log information by clicking Save to File and designating the name and location 
of the file. 

Configuration View Functionality 
Click View > Configuration to get to the Configuration view. This view displays with a navigation 
pane on the left and a list of Services on the right. MSP Services is expanded in the left pane. 

Notes: 

Although the MSP Services Configuration pane looks similar to the MSP Services pane, the 
links take you to pages from which you can configure individual settings for the MSP Services 
and Features listed rather than to pages from which you can stop and start MSP Services. 
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There are two methods of opening the Configuration Control pages listed in the left pane. You 
can expand the topics on the left and click the appropriate sub-topic, or you can select a main 
topic on the left and click the appropriate link in the right pane. Either method gets you to the 
same place. Any how-to information in this section will only mention the first method. 

Retention Settings 
Important: 

Stop all Services before making changes to the Data Retention and Relay Server File Retention 
settings. Don’t forget to restart the Services when you are finished. 

Database Record Retention 
To change the numbers of days the MSP Database will retain records pertaining to the Staging 
Log History, Job History, Action Batches, Metric Data, GPS Metric Data, and Audit Record Data: 

1. Click View > Configuration. Expand Retention and click Data. The Database Record 
Retention page will display, as shown in Figure 22 below. 

 

Figure 22 – Database Record Retention 

2. Stop all Services. 

3. Make the appropriate changes and click Apply. 

4. Restart all Services. 

Caution: 

While the maximum age of Collected Data can be increased from the Configuration view, this 
should be done with caution.  Increasing this value can substantially increase the size of the 
Collected Data Tables.  As the size of the Collected Data Tables grows, the time required to 
perform Long Term Analysis Processing can increase substantially.  Collecting too much data, 
too frequently, from too many devices, and then keeping that data for too long and/or evaluating it 
too frequently, could lead to unacceptable performance of MSP. This goes for Retention settings 
and all the other Configuration settings in this section 
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Relay Server File Retention 
To change the numbers of days the File Servers will retain records pertaining to Discovery 
Documents, Jobs, and, Metric Data: 

1. Click View > Configuration. Expand Retention and click Relay Server. The Relay 
Server File Retention page will display, as shown in Figure 23 below. 

 

Figure 23 – Relay Server File Retention 

2. Stop all Services. 

3. Make the appropriate changes and click Apply. 

4. Restart all Services. 

Analysis and Troubleshooting Settings 
Important: 

Stop all Services before making changes to the Cubing and Metric Data settings. Don’t forget to 
restart the Services when you are finished. 

Cubing Settings 
This page allows you to enable/disable the Complete Data Option and to set the Interval Mode for 
the collection of data samples. 

In Long-Term Analysis Processing a “cube” is constructed to contain the statistical distributions of 
degrees of deviation of all Collection Metric values. The “cube” is basically a multi-dimensional 
“grid” of data where each dimension is represented by one key index into the data.  The 
dimensions of interest include Collection Metric, device, Collection Request, Time Period, Time 
Scale, etc.  The “cube” is loaded with all the aggregated data for all Time Scales and then 
processed to determined the degrees of deviation from established Baselines, based on Unit 
Deviations, for every Collection Metric for every device for every Collection Request, and for 
every Time Scale and Time Period.  

On the Cubing Settings page, as shown in Figure 24 below, Complete Data refers to data 
samples that span at least 80% of the Time Period indicated for collection. If you choose to Use 
Complete Data, only data samples that “span” at least 80% of the Time Period are used for 
Cubing.  This filtering helps prevents statistical errors due to devices that have not yet reported 
complete data.  If such incomplete data were included, it would “drag down the average”, causing 
the appearance of inaccuracies. The default setting is No. 
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Figure 24 – Cubing Settings 

Enable/Disable Complete Data Option 

To enable/disable the Complete Data Option: 

1. Click View > Configuration. Expand Troubleshooting & Analysis and clickCubing. 
The Cubing Settings page will display (Figure 24). 

2. Select the Enable/Disable check box. 

3. When you are finished, click Apply and remember to Start all Services. 

Set the Interval Mode of Data Collection 

To set the Interval Mode: 

1. Click View > Configuration > Troubleshooting & Analysis > Cubing. The Cubing 
Settings page will display (Figure 24). 

2. Click the Time of Day or Frequency radio button. 

3. Set the Time of Day Setting or the Day of Week Setting. 

4. When you are finished, click Apply and remember to Start all Services. 
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Metric Data – Adding a New Metric Column 
Important: 
 

 

Stop all Services before making changes on this page. 
 

 

 
A Collection Metric is a definition of a unit of data that can be collected from one or more devices. 
MSP has a set of pre-defined Collection Metrics and supports the ability to define new Collection 
Metrics by adding columns to the Collected Data Tables. 

The Collected Data Tables support Metric Types of Float and String, and the columns in the 
Collected Data Table are managed separately for each Metric Type.  A new Collection Metric of a 
given Metric Type cannot be created unless there is an unused column in the Collected Data 
Tables of that Metric Type. 

To add columns to the Collected Data Tables: 

1. Click View > Configuration. Expand Analysis & Troubleshooting and click Metric 
Data to display the Metric Data page. 

2. Select the Metric Type to add. 

3. In the # of Metrics field on the Metric Data tab of the Advanced module, select the 
number of Metrics of the specified Metric Type to add. 

4. Click Modify Collection Structure, wait for the confirmation message, and restart all 
services. 

Warning: 

Adding a column to the Collected Data Tables can take a long time to complete since it must 
restructure the Collected Data Tables.  The more Collected Data is present in the Collected Data 
Tables, the longer the restructuring will likely take.  If more than one column needs to be added, it 
is more efficient to add multiple columns at once than to repeatedly add one column at a time.  
The maximum number of columns that can be added at once is 5. 

MSP Services Configuration Settings 
The Work Queue Service Settings page, as shown in Figure 25 below, is representative of the 
pages in this part of the application.  Each page in this section has the same options, except the 
Task Scheduler Service Settings.  You can navigate to these pages by clicking View > 
Configuration, expanding MSP Services, and then the appropriate link. 
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Figure 25 – Work Queue Service Settings Page 

Thread Count 
A Thread Count means slightly different things for the MSP Services listed in this section of the 
application. For the: 

 Content Delivery, Upload, Control Collection, Work Queue, and Relay Server Optimizer 
services, Thread Count refers to the number of Relay Servers that the individual services can 
communicate with at one time.  

 Policy service, Thread Count refers to the number of devices to which Policies may 
communicate at one time.  

 Control Mapping Engine service, Thread Count refers to the number of Data Collection 
Requests that can be processed at one time. 

 SMS service, Thread count refers to the number of separate SMS messages that can be sent 
to the STMP or SMPP gateway at one time. 

 Task Scheduler service, Thread Count refers to the number of tasks that can be processed at 
one time. 

Polling Only? 
MSP services “wake up” and process pending tasks in two ways. First, each service “wakes up” 
at regular, predetermined intervals and checks to see if there are pending tasks. Second, 
services also can wake up whenever a task is pending. The default setting is for both types of 
wake-up calls to be in effect so that the most tasks can be processed in the quickest amount of 
time. 

If the Polling Only? question is offered on a page in this part of the application and you answer 
Yes, MSP services will “wake up” only at predetermined intervals. All Services, except the Task 
Scheduler, ask the Polling Only question. 
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Wake-up Interval 
All Services, except the Task Scheduler, offer the option of setting the wake up interval in 
minutes. 
 

Network Connections Settings 
Important: 

Stop all Services before making Network Connection changes. 

The Network Connections topic allows you to set connection retries and timing issues for both 
Relay Servers and SMS connections. 

Relay Server Connections Settings 
From this page, you can set: 

FTP Command Retries - There can be temporary disruptions of FTP communication with Relay 
Servers. This setting allows you to set the number of retries 

The Base Reconnect Delay, the Reconnect Delay Multiple, and the Maximum Reconnect 
Time all taken together allow you to create a "formula" for reconnection attempts: 

Base Reconnect Delay x Reconnect Delay Multiple = how often to try 

Maximum Reconnect Time = how long to try to reconnect 

When you are finished, click Apply and remember to Start all Services. For more information on 
Relay Servers see Relay Server Administration in this document. 

SMS Connections Settings 
From this page, you can set the SMS Session Retries, the Staging Message Identifier, and the 
SMS Packet Size. The minimum packet size is 40 bytes; the maximum packet size is determined 
by your Carrier. 

When you are finished, click Apply and remember to Start all Services. For more information 
about Relay Servers, see  

Features 
Important: 

Stop all Services before making Feature changes. 

To navigate to the appropriate pages, click View > Configuration, expand Features, and click 
the appropriate link. From this topic, you can Enable/Disable Features and edit other settings for 
the following Features: 

Reporting 
By default, the MSP Asset Reporting mechanism is not active.  Once activated, the Asset 
Reporting table is maintained automatically.  As new devices get discovered or existing devices 
get changed, the corresponding information is copied in real-time to the Asset Reporting tables.   
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To activate Asset Reporting, select the Enable check box and click Apply. For more information 
on Asset Reporting, see the Asset Reporting chapter in this document. 

Click Refresh Report to record the latest information to the Asset Reporting tables. 

When you are finished, remember to Start all Services. 

Analysis 
You can Enable/Disable Data Analysis on this page. 
 
To Enable/Disable Data Analysis, select or deselect the Enable check box and click Apply. 
 
When you are finished, remember to Start all Services. 

Authentication 
The MSP Authentication Database is always installed as a built-in Authentication Source.  There 
must always be exactly one instance of the MSP Authentication Database.  It is therefore not 
possible to create or delete Authentication Sources of this type.  It is, however, possible to 
Disable the single instance of the MSP Authentication Database if that is desirable. 

The MSP Authentication Database is mandatory to use when MSP is first installed since it allows 
initial login to the MSP Console UI as the built-in User “security” and hence allows administration 
of User in the MSP Authentication Database and the administration of other Authentication 
Sources. 

Once one other Authentication Sources have been created and Activated, it may be desirable to 
Disable the MSP Authentication Database on this page. This can enhance the overall security of 
MSP since the MSP Authentication Database does not offer the ability to enforce security 
policies, such as Password length and strength, periodic Password change, etc. 

To disable the MSP Authentication Database, deselect the Enable check box and click Apply. 
When you are finished, remember to Start all Services. 

Audit 
This page allows you to enable/disable Auditing and to set other auditing factors, including the 
Audit Record Retention duration. 

MSP Audit is used to refer to tracking activities performed by Users, including the identity of the 
User (by User Name), the activity performed, when the activity was initiated, the Object affected 
by the activity, and an optional Transaction Code and/or Note entered by the User when the 
activity is initiated. 

Click Enable to activate this feature. 

If you select the Enable Note check box, an area for making notes about changes in the MSP 
Console UI will be presented to MSP Console UI users. You can add header text for the Note 
area (for example, "Why are you making this change?"). 

If you select the Enable Code check box,  an area for typing an authorization code will be 
presented to MSP Console UI users. You can add header text for the Code area (for example, 
"Enter your Department Authorization Code."). Selecting this check box does not require a code 
be entered. 
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If you select the Code Required check box, MSP Console UI will have to enter something in the 
area presented for typing an authorization code. The MSP Administration Program DOES NOT 
validate codes, it only checks for an entry in the field. 

When you are finished, remember to Start all Services. 

Dynamic Content 
Dynamic Content is explained in great detail in the Understanding Dynamic Development chapter 
in Understanding MSP 3.3.1. 

To enable/disable Dynamic Content, select/deselect the Enable check box and click Apply. 

When you are finished, remember to Start all Services. 

GPS Data 
This Feature is available only with MSP Control Edition. When MSP is installed this Feature is 
Disabled by default. 

To enable the collection of GPS data; 

1. Select the Enable check box. 

2. Set the GPS Record Retention Duration. 

3. When you are finished, remember to Start all Services. 

Web Settings 
To get to these Settings, click View > Configuration, expand Web Settings, and click the 
appropriate link. From this topic,you can set the prefix for device names to Sites or Relay 
Servers, and “tell” MSP the location of your MSP Web Server. 

Important: 

Stop all Services before making changes to the Web Settings. 

Device Filter Options 
This page allows you to set the prefix for device names for Sites or Relay Servers.  

If you want MSP to determine the visibility of devices based on the visibility of Sites, select the 
Site radio button. The following process will be followed to determine the devices that are visible 
to an MSP Console User: 

 If no Site User Access Prefix is defined for a User when they are created in the Console UI, 
then that User will have visibility to all devices managed by MSP. 

 If a Site User Access Prefix is defined for a User when they are created in the Console UI, 
then that User will only have visibility to devices managed by MSP that are assigned to Sites 
whose names start with the Site User Access Prefix defined for that User. 

If you want MSP to determine the visibility of devices based on the visibility of Relay Servers, 
select the Relay Server radio button. The following process will be followed to determine the 
devices that are visible to an MSP Console User: 

 If no Relay Server Access Prefix is defined for a User when they are created in the Console 
UI, then that User will have visibility to all devices managed by MSP. 
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 If a Relay Server Access Prefix is defined for a User when they are created in the Console 
UI, then that User will only have visibility to devices managed by MSP that are assigned to 
Sites whose names start with the Site User Access Prefix defined for that User. 

When you are finished, remember to Start all Services. 

Change MSP Web Server IP Address 
This page allows you to “tell” MSP the location of your MSP Web Server IP. Type the address 
and click Apply. To return to the previous address, click Restore. 

When you are finished, remember to Start all Services. 

Utilities 
To get to the Utilities, click View > Configuration > Utilities, and click on the appropriate link. 
From this topic, you can Import XML files, CSV files, and Add-On Kits. You also can Export XML 
files and the Diagnostic Report. 

Important: 

Items that come with your installation of MSP (i.e., Add-on Kits, DefDocs) are located in the 
appropriate folder in the \\Program Files\ Motorola MSP\Transfer folder. 
 
Motorola recommends that appropriate items from outside your installation of MSP be moved to 
the appropriate folder in the \\Program Files\ Motorola MSP\Transfer folder and then imported into 
MSP from this folder. 

Items can be moved into the Transfer folder even without the Administration Program being open 
by clicking Start > Program Files > Motorola MSP > Transfer Folder. 

Import XML 
You can import individual MSP Objects (.xml) files by clicking Browse, selecting the appropriate 
.xml file, and clicking Import. The Import Status window will display messages confirming the 
success and/or failure of the import action. 

Import CSV 
You can import .csv files by clicking Browse, selecting the appropriate file, and clicking Import. 
The Import Status window will display messages confirming the success and/or failure of the 
import action. 

Import Add-On 
You can import .zip files of MSP Add-ons by clicking Browse, selecting the appropriate file, and 
clicking Import. When MSP is installed, the Add-on .zip files that came with your installation can 
be found in Start > Program Files > Motorola MSP > Transfer Folder > Add-on, or they can be 
downloaded from Support Central. Multiple Add-ons must be imported one-at-a-time. The Import 
Status window will display messages confirming the success and/or failure of the import action. 

Important: 

Stop all Services before importing an Add-On kit that contains DefDocs. Restart all Services once 
the Add-On has been imported. 
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Export XML 
On this page, select one or more MSP Objects Export Type, click Export, and name and save 
the resulting .xml file. The Export Status window will display messages confirming the success 
and/or failure of the export action. 

Important: 

The default location for exported items (i.e., Add-on Kits, DefDocs) is the appropriate folder in the 
\\Program Files\ Motorola MSP\Transfer folder.  

Motorola recommends that you export items to the appropriate folder in the \\Program Files\ 
Motorola MSP\Transfer folder before moving them elsewhere. 

Export Diagnostic 
You can export a .zip file containing several files that can be used to diagnose problems with your 
installation. Motorola recommends you select both check boxes before you click Export. When 
the file is exported successfully, you will see the message: 

Finished! File Location C:\Program Files\Motorola MSP\temp\Diagnostic Files\MSPDiagnostic.zip 

It is recommended that you rename the file because the file will be over written if the Diagnostic 
File is re-exported. 

When you are finished, remember to Start all Services. 
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Chapter 12 – MSP Server 
Troubleshooting 

Performance Monitoring 
The Windows Performance Utility can be used to monitor MSP performance, including memory 
usage. 

Start the Performance Monitor utility by going to the Start menu and select Control 
Panel>Administrative Tools>Performance.  The System Monitor portion of the Performance 
tool gives a real-time graphical display of various performance counters.  This part of the 
Performance tool can be used for a quick monitoring of the system.  Performance Counters can 
be used to track performance data over a longer period of time. 

To access the Performance Counters, double click Performance Logs and Alerts tree and click 
Counter Logs.  You can create a new “log Settings” (right-click in the Performance Window and 
select New Log Settings ...).  

You can include the Counters you need to track, the format of the log, and the time interval for 
capturing the counters in the new log definition.  Many of the same counters can be used in both 
System Monitor and Counter Logs.  Refer to the Microsoft Management Console Help Topics for 
details. 

Using the Windows Event Log 
MSP adds entries to the Windows Event log to aid in the trouble shooting process.  To view these 
MSP entries go to the Start menu and select Control Panel>Administrative Tools>Event 
Viewer.  Click the Application page in the Event Viewer window.  All events recorded for all 
applications will be displayed.  The events recorded for MSP begin with Motorola.MSP.  Click a 
specific event in order to view a detailed description of the event.  

The Event log may be exported to a .txt file or a .evt file (preferred format) for later reference.  To 
export the event log click the Export List button at the top of the Event Viewer window. 
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Using Staging Logs from MSP Console UI 
Staging Logs are a good source of information when troubleshooting Staging.  Under normal 
operation Staging Logs are automatically uploaded from devices to their Relay Server and then 
sent to the MSP Server.  The information contained in these logs is stored in the MSP database.  
The information is then made available through the MSP Console UI. 

View the Staging Status of a device by clicking the Staging tab and then “Staged Devices”.  The 
Staged Devices page displays the IDs of the devices that have been Staged.  Click on the link 
for a device in the first column to get to the Device Detail page for the device. 

Using Staging Logs on Devices 
In the case where a device is unable to communicate with a Relay Server, the Staging Logs will 
not be uploaded and therefore the information will not be made available through the MSP 
Console UI.  In this situation it is necessary to look at the Staging Logs on the device.   

To view the device logs select “Log Menu” from the Main Menu of the UI of the MSP Client 
Software.  Selecting “View Log” displays a log of activities involving the execution of the MSP 
Client Software.  A date/time stamp is followed by specific MSP Client Software actions such as 
“MSP 3.0 Agent starting”, “agent inf Log file Opened”, etc.  Selecting “View Job Log” displays a 
log MSP tasks.  A date/time stamp is followed by a specific task such as “inf Loading Bundle …” , 
“inf Installing Package …”, “inf Package installed…”, etc.  Setting the log level will affect what 
information is contained in the logs.  Available log levels are Critical, Error, Warning, Info and 
Verbose. 

 

 



Administering MSP 3.3.1 -- 147 
 

 
 

 

Chapter 13 – MSP Server Maintenance 

Backing up the MSP Database 

Introduction 
This section describes a simple method you can use to backup the MSP database. The backup 
can be designed to be performed daily at specified times using Microsoft SQL Server 
Management Studio Express and Windows Task Manager. While there are other effective ways 
to back up the MSP Database using SQL scripts and third party tools, this section describes a 
fairly simple solution for backing up the database and files. The method of backup is left to the 
discretion of the individual organization. 

Management Studio Express and Windows Task Manager. While there are other effective ways 
to back up the MSP Database using SQL scripts and third party tools, this section describes a 
fairly simple solution for backing up the database and files. The method of backup is left to the 
discretion of the individual organization. 

Motorola recommends that the MSP Database be backed up every 24 hours. In this version of 
MSP, all necessary data and files are stored in the MSP database. There are no longer 
corresponding files that need to be backed up in conjunction with the MSP database. The 
following process describes how to backup the MSP database only. These instructions assume 
that the User creating and testing the backup script and the task scheduler event has 
Administrative rights.  

Motorola recommends that the MSP Database be backed up every 24 hours. In this version of 
MSP, all necessary data and files are stored in the MSP database. There are no longer 
corresponding files that need to be backed up in conjunction with the MSP database. The 
following process describes how to backup the MSP database only. These instructions assume 
that the User creating and testing the backup script and the task scheduler event has 
Administrative rights.  

Using Microsoft SQL Server Management Studio 
to Back Up the MSP Database 
The following instructions provide a method to back up and restore the MSP Database by using 
the Microsoft SQL Server Management Studio Express application and the Windows Task 
Scheduler. 

Warning: 

A database backup from one version of MSP IS NOT COMPATIBLE with any other version of 
MSP. A database backup that has been saved from one particular version of MSP can be 
restored ONLY to that same version of MSP (i.e., 3.0 to 3.0, 3.1 to 3.1, or 3.2.1 to 3.2.1).  

Performing a Manual or Unscheduled Backup 
Use Microsoft SQL Server Management Studio Express to back up the database at any time. 
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1. Start the Microsoft SQL Server Management Studio Express tool and connect to the 
database instance containing the MSP Database. 

2. Expand Databases. 

3. Right click on the MSP Database and select Tasks and then Backup to display the 
Back Up Database dialogue box. 

4. Click the General tab and specify the appropriate backup options for your organization. 

5. After configuring the General tab, click the Options tab and specify the appropriate 
options for your organization. 

6. After configuring the backup options, click OK to perform the backup. 

7. Check to make sure that the backup file is created in the specified directory. 

Create a Database Backup Script 
Use Microsoft SQL Server Management Studio Express to create a script to back up the 
database. Microsoft SQL Server Management Studio Express can be downloaded for free from 
the following link: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=c243a5ae-4bd1-4e3d-
94b8-5a0f62bf7796&displaylang=en 

Create the script according to the following instructions: 

1. Start the Microsoft SQL Server Management Studio Express tool and connect to the 
database instance containing the MSP database. 

2. Expand Databases. 

3. Right click on the MSP Database and select Tasks and then Backup to display the 
Back Up Database dialogue box. 

4. Click the General tab and specify the appropriate backup options for your organization. 

5. After configuring the General tab, click the Options tab and specify the appropriate 
options for your organization. 

6. After configuring the backup options, click Script and then Actions to File. Specify the 
directory path and the appropriate file name for the backup. This creates an SQL script 
that backs up the database. 

Test the Backup Script 
Test the script to make sure it is creating the backup and placing it in the correct location 
according to the following steps. 

1. Open a command prompt and enter the following command: sqlcmd –S 
[computername\instancename] –i “C:\[Path]\[filename]”. 

2. Check to make sure that the backup file is created in the specified directory. 

Schedule the Backup with Windows Task Scheduler 
Use the Windows Task Scheduler to schedule backups according to the following steps. 

1. Go to Start>All Programs>Accessories>Scheduled Tasks. 

2. Double-click Scheduled to invoke the Scheduled Task wizard. 

3. Select the Command Prompt as the program you want Windows to run and give it an 
appropriate name. 

 

http://www.microsoft.com/downloads/details.aspx?FamilyID=c243a5ae-4bd1-4e3d-94b8-5a0f62bf7796&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=c243a5ae-4bd1-4e3d-94b8-5a0f62bf7796&displaylang=en
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4. Complete the remainder of the wizard with the appropriate information for your 
deployment.  

5. After creating the task, edit the task properties to enter the following in the Run 
command line field: 

“C:\Program files\Microsoft SQL Server\90\Tools\Binn\sqlcmd.exe” –S 
[Computername\InstanceName] –i “C:\[Path]\[filename]” 

Restoring a Database Backup 
Important: 

Remember, a database backup from one version of MSP IS NOT COMPATIBLE with any other 
version of MSP. SQL will allow you to restore a database from one version of MSP to a different 
version of MSP, BUT MSP will not function properly if a database from one version of MSP is 
restored to a different version of MSP. 

Use the Microsoft SQL Server Management Studio Express to restore a backup according to the 
following steps. 

1. Stop the MSP services before restoring a backup.  Use the MSP Administration Program 
to stop the services.  For more information on the MSP Administration Program, see 
Administering MSP 3.3.1. 

2. To restore a backup, right-click on the MSP database and select Tasks and then 
Restore and then Database. 

3. Select the From database radio button and select MSP Database from the drop down 
window.  

4. Restore options are in the Options tab on the left side of the page. Select the appropriate 
options for your restore. 

5. On the General tab, select the Restore check box for the appropriate Database and click 
OK. You will be prompted when the restore is successful.  

Test the Database Backup and the Database Restore 
Test the backup and the restore on a test system according to the following steps.  

1. Create the backup script and the scheduled task.  

2. Make sure the backup is created and placed in the correct directory. 

3. Start up the MSP application. Delete various objects within the MSP application (Staging 
Profiles, Staged Devices, SMS Staging Jobs, SMS Devices, Provisioning Policies, 
Packages, Settings, Bundles, Conditions, Message Sets, Users, Site, Relay Servers, 
SMS Carriers). 

4. Stop the MSP services and restore the Database.  Use the MSP Administration Program 
to stop the services.  For more information on the MSP Administration Program, see the 
Administering MSP 3.3.1. 

5. Open MSP and verify that the objects were restored and that they are functional. 
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Chapter 14 – MSP Add-On Kits 

What is an MSP Add-On Kit? 
An MSP Add-On Kit is a mechanism for extending or adding functionality to MSP.  In MSP 3.3.1, 
MSP Add-On Kits are delivered as MSP Add-On Kit .ZIP Files.   A given MSP Add-On Kit .ZIP 
File generally adds a single feature (or an aspect of a single feature) to a running MSP System.  
For example, the Motorola Data Collection Solution is delivered as an MSP Add-On Kit .ZIP File. 

What MSP Add-On Kits are included with 
MSP? 
A number of MSP Add-On Kits are included with MSP.  When MSP is installed, all the MSP Add-
On Kits that are provided with that version of MSP are copied into a transfer folder as described 
in Chapter 11 – The MSP Administration Program.  Consult the transfer folder for a list of the 
available MSP Add-On Kits. 

How to Import an MSP Add-On Kit 
MSP Add-On Kit .ZIP Files must be imported into an MSP System using the MSP Administration 
Program.  For information on importing MSP Add-On Kit .ZIP Files, using the MSP Administration 
Program, see the MSP Administration Program Online Help – Import Add-on. 

Important: 

Stop all Services before importing an Add-On kit that contains DefDocs. Restart all Services once 
the Add-On has been imported. 
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Chapter 15 – Asset Reporting 

What is Asset Reporting? 
Asset Reporting is a generic term used to refer to any use of Asset Inventory information 
collected and maintained by MSP from outside the MSP Console UI.  While MSP currently 
provides no mechanisms to push Asset Inventory information to other tools, MSP does support 
Asset Reporting which can allow such tools to pull Asset Inventory information for their own 
purposes. 

This could be used to enable a variety of diverse activities, including: 

 Manually or automatically creating and distributing reports based on MSP Asset Inventory 
information. 

 Performing queries against MSP Asset Inventory information and taking automatic actions, 
such as sending alerts or notifications. 

 Extracting MSP Asset Inventory information and sending it to other tools, such as Managers 
of Managers (MoMs), Trouble Ticketing Systems, etc. 

MSP Asset Reporting Tables 
The implementation of Asset Reporting in MSP centers around the MSP Asset Reporting Tables 
which are created and maintained by MSP as changes are made to the MSP Database.   

Limitations 
Limitations in the capabilities of the various versions and editions of Microsoft SQL Server impose 
limits on the MSP Asset Reporting Tables.  In particular: 

 Each Device Attribute that is stored in the MSP Asset Reporting Tables requires a column in 
that table.  Consequently, the maximum number of columns supported in a single table row 
will limit the number of Device Attributes that can be stored in the MSP Asset Reporting 
Tables. 
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 The values of all the selected Device Attributes that are stored in the MSP Asset Reporting 
Tables for any one device are stored in a single table row.  Consequently, the maximum size 
of a table row will limit the total amount of Device Attribute data that can be stored in the MSP 
Asset Reporting Tables for any one device. 

If either or both of the above limits are exceeded, some or all Device Attribute values for some or 
all devices will not be stored in the MSP Asset Reporting Tables. 

Note: 

Such a situation can be detected by entries added to the Windows Event log.  To correct such a 
situation, reduce the number of Device Attributes stored in the MSP Asset Reporting Tables 
and/or select Device Attributes with smaller values. 

Schemas 
As mentioned in Chapter 1 – Understanding MSP, the schema for the MSP Database is not 
published and any access to the MSP Database from outside MSP is completely unsupported.  
The one exception is the MSP Asset Reporting Tables, which are intended to be accessed from 
outside MSP.  The schemas for MSP Asset Reporting Tables are fully documented and 
supported and will remain backward compatible in future versions of MSP. 

Device Table Schemas 

tDeviceAssetsReport 

This table contains a separate record for each of the known devices being managed by MSP.  In 
general, there is a column for each known device attribute defined.  If a device doesn’t have a 
specific attribute, the value will be null. 

Field Name Data Type Description 

devID Varchar Primary key, the uuID of the device.  It is the 
key that is used to related devices to 
collection and compliance data. 

rsID Varchar Relay Server ID 

siteID Varchar Site ID 

Model Varchar Device Model 

OS Varchar Device OS 

firstDiscovered Datetime Date the device was first discovered in 
universal time. 

lastDiscovered Datetime Date the device was last discovered in 
universal time. 

devClass Datetime Device Class 

[agent.*] Varchar There will be a separate column for all 
defined agent attributes. 

[identity.*] Varchar There will be a separate column for all 
defined identity attributes except for the ones 
defined above (uuid, rsID, siteID, model, os 
and devClass.) 
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Field Name Data Type Description 

[status.*] Varchar There will be a separate column for all 
defined status attributes. 

[UserAttribute.*] Varchar There will be a separate column for all 
defined User attributes. 

Table 6 – tDeviceAssetsReport 

tFacts 

This table contains the Collected Data stored for the devices.  Each row contains a set of 
sampled data points for a given device and time stamp/slice. 

Field Name Data Type Description 

devID Varchar Foreign key, the uuID of the device 

smID Int External ID used within MSP. 

timeID bigInt External ID used within MSP. 

timestamp Datetime Recorded time of collection reading in device 
local time. 

timeDuration Int Duration of reading (15 or 60 minutes) 

Float001 – Float040 Float Actual collection reading.  Each column 
represents a specific DCM.  Please refer to 
the bDCM table for mapping of DCMs to 
tFacts columns. 

Table 7 – tFacts 

tComplianceMatrix 

This table contains the information pertaining to Policy Device Compliance.  Each row contains 
the compliance information pertaining to a device and Policy combination. 

Field Name Data Type Description 

devID Varchar Foreign key, the uuID of the device 

PolicyID Varchar Name of Policy 

complStatusID Char Foreign key, Policy status, please refer or 
join to sComplianceStatus for descriptions of 
compliance status. 

subStatusID Char Foreign key, non-compliant sub status, 
please refer or join to sComplianceSubStatus  
for descriptions of non-compliant sub status. 

dateModified Datetime Date last modified. 

 



156 -- Administering MSP 3.3.1 
 

Table 8 – tComplianceMatrix 

Device Look-up Table Schemas 

bDcm 

This table contains the defined DCMS in the MSP system.  It contains the basic definition of the 
DCMS.  It also contains the information on where in the tFacts table the specific DCM is stored. 

Field Name Data Type Description 

dcmID Varchar Name or ID of DCM 

dcmVersion Varchar Version of DCM definition 

dcmCollectionString Varchar String used by a Data Collection Solution to 
determine how to collect samples for a 
Collection Metric from a device. 

dcmDescription Varchar Description of DCM 

collectionDataTypeID Varchar 1 = Float 

dcmUOM Varchar Unit of Measure 

dcmIsCalculated Bit Not Used 

dcmAssemblyInfo Varchar Not Used 

metricTypeID Smallint 1 = Quantity, 2 = Reading 

colField Varchar This column contains the corresponding 
column name in the tFacts table where the 
DCM data is stored. 

dcmStatus Char [A]ctive or [I]nActive 

Table 9 – bDcm 

sComplianceStatus 

This look up table contains the valid compliance statuses.  It can be joined to the 
tComplianceMatrix table to describe the different statuses in the report. 

Field Name Data Type Description 

complStatusID Varchar Primary key, ID of compliance status. 

complStatusDesc Varchar Description of status. 

Table 10 – sComplianceStatus 

sComplianceSubStatus 

This look up table contains the valid non-compliance sub-statuses.  It can be joined to the 
tComplianceMatrix table to describe the different statuses in the report. 

Field Name Data Type Description 

subStatusID Varchar Primary key, Id of non-compliance sub-
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Field Name Data Type Description 

status. 

subStatusDesc Varchar Description of status. 

Table 11 – sComplianceSubStatus 

Configuration and Setup 
This section will describe the configuration and setup that is required to permit the successful use 
of Asset Reporting. 

Enabling and Disabling Asset Reporting 
By default, Asset Reporting is not enabled.  Once Asset Reporting is not enabled, MSP will begin 
create the MSP Asset Reporting Tables, if they don’t already exist, and maintain their contents 
automatically, as the Asset Inventory information in the MSP Database changes. 

For information on enabling and disabling Asset Reporting, see the MSP Administration Program 
Online Help – Reporting. 

Creating an SQL Login for Asset Reporting 
Once Asset Reporting is enabled, Users who will be extracting data from the MSP Asset 
Reporting Tables will need access to those tables in SQL Server order to successfully perform 
Asset Reporting.  A SQL login must be created with the appropriate rights and permissions to 
grant such access. 

To create a suitable SQL Login for use in Asset Reporting, do the following: 

1. Launch Microsoft SQL Server Management Studio 

2. Connect to the Microsoft SQL Server Instance that is hosting the MSP database.  

Note: 

An IT Administrator would normally perform these tasks and would need the 
proper rights and permissions. 

3. Once connected, click on the Security node in the tree view. 
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4. Click on the Logins node in the tree view (Figure 26 below). 

 

Figure 26 – Logins Node 

5. Create a SQL login () for the end-User who will be creating the custom reports. 

 

Figure 27 – New Login Dialog 

 

6. Once the general page is complete, click User Mapping.   
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7. On the User Mapping dialog box (Figure 28 below) , in the Users Mapped to this 
Login pane, select the check box for the MSP database.  In the Database role 
membership for MSP pane, make sure both msp_reporter_role and public roles 
are selected.   

 

Figure 28 - User Mapping Dialog 

Note: 

The msp_reporter_role grants SELECT access to a specific set of MSP 
tables. 

8. Click OK. 

Performing Asset Reporting 
This section will provide information on using Asset Reporting.  As described earlier in this 
chapter, Asset Reporting could encompass a wide variety of diverse activities.  It is beyond the 
scope of this document to explain how to perform such activities.  Instead, this section will focus 
on extracting MSP Asset Inventory information from the MSP Asset Reporting Tables.  How that 
data might then be used is left to the developer of a given Asset Reporting solution. 
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Using Microsoft Excel™ 2003 
Disclaimer: 

Motorola does not recommend or certify any version of Microsoft Excel™ for use with MSP.  The 
information in this section is provided solely as an example, for the convenience of MSP System 
Administrators.  This example is intended only as an illustration of the concepts involved in 
extracting data from the MSP Asset Reporting Tables.  No warranty of usability of any solution 
based on the use of MSP and Microsoft Excel™ is implied or offered. 

Microsoft Excel™ 2003 provides a generic mechanism to acquire data from an external Microsoft 
SQL Server Data Source.  Since the MSP Asset Reporting Tables are hosted in Microsoft SQL 
Server, Microsoft Excel™ 2003 can be used to acquire data from these tables.  This can be 
accomplished as follows: 

6. Select a cell in a worksheet to which external data will be placed when it is imported 

7. Click Data->Import External Data->Import Data 

8. Click the New Source button 

9. Select Microsoft SQL Server 

10. Click the Next button 

11. Enter the Network Name or IP Address of the SQL Server instance in which the MSP 
Database is hosted 

12. Select Use the following User Name and Password 

13. Enter the User Name and Password created according to the Creating SQL Login for 
Asset Reporting process described earlier in this chapter 

14. Click the Next button 

15. Select the MSP database name (usually MSP) 

16. Select the tDeviceAssetsReport table 

17. Click the Finish button 

18. Data will be extracted and placed beginning at the selected cell 

Using Microsoft SQL Server 2008 Report Builder 
2.0 
Disclaimer: 

Motorola does not recommend or certify any version of Microsoft Report Builder for use with 
MSP.  The information in this section is provided solely as an example, for the convenience of 
MSP System Administrators.  This example is intended only as an illustration of the concepts 
involved in extracting data from the MSP Asset Reporting Tables.  No warranty of usability of any 
solution based on the use of MSP and Microsoft Report Builder is implied or offered. 

Microsoft SQL Server 2008 Report Builder 2.0 provides a generic mechanism to generate reports 
from a variety of data sources, including Microsoft SQL Server.  Since the MSP Asset Reporting 
Tables are hosted in Microsoft SQL Server, Microsoft Report Builder can be used to acquire data 
from these tables and generate reports.  This can be accomplished as follows: 

1. Install and launch Microsoft SQL Server 2008 Report Builder 2.0  
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2. From the Report Window, as shown in Figure 29 below, under Click to add data, double 
click Table or Matrix. 

 

Figure 29 – Add Table or Matrix 

3. From the New Table or Matrix dialog, as shown in Figure 30 below,click the New… 
button. 

 

Figure 30 – New Table or Matrix Dialog 
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4. From the Data Source Properties dialog, as shown in Figure 31 below, enter a name for 
the Data Source (e.g. MSP), select Microsoft SQL Server for the Connection Type, and 
click the Build button to construct a Connection String. 

 

Figure 31 – Data Source Properties Dialog 

5. From the Connection Properties dialog, as shown in Figure 32 below, enter the IP 
Address or Network Name of the SQL Server for Server Name, select Use SQL Server 
Authentication, enter the User Name and Password created according to the Creating 
SQL Login for Asset Reporting process described earlier in this chapter, select the 
database MSP, the click the Test Connection button.  If the connection tests OK, then 
click the OK button for the Connection Properties dialog. 

 

Figure 32 – Connection Properties Dialog 

6. Click the OK button for the Data Source Properties dialog. 

7. Click the Next button for the New Table or Matrix dialog. 
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8. Open the Tables node under Database view in the New Table or Matrix dialog, as 
shown in Figure 33 below, select the tDeviceAssetsReport table, and click the Next 
button. 

 

Figure 33 – Database View 

9. The fields from the tDeviceAssetsReport table can now be used to construct the desired 
report via the under Arrange fields in the New Table or Matrix dialog. 

Using Crystal Report Writer™ 2008 
Disclaimer: 

Motorola does not recommend or certify any version of Crystal Report Writer™ for use with MSP.  
The information in this section is provided solely as an example, for the convenience of MSP 
System Administrators.  This example is intended only as an illustration of the concepts involved 
in extracting data from the MSP Asset Reporting Tables.  No warranty of usability of any solution 
based on the use of MSP and Crystal Report Writer™ is implied or offered. 
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Crystal Report Writer™ 2008 provides a generic mechanism to acquire data from external Data 
Sources.  Since the MSP Asset Reporting Tables are hosted in Microsoft SQL Server, Crystal 
Report Writer™ 2008 can be used to acquire data from these tables.  This can be accomplished 
as follows: 

1. Invoke the Standard Report Creation Wizard, as shown in Figure 34 below. 

 

Figure 34 – Create New Connection 

2. Select Create a New Connection, as shown in Figure 34 above. 

3. Select OLE DB (ADO) as the Data to report on, as shown in Figure 35 below. 

 

Figure 35 – Data to Report on 
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4. Select Microsoft OLE DB Provider for SQL Server as the Data Link File, as shown in 
Figure 36 below. 

 

Figure 36 – Microsoft OLE DB Provider for SQL Server 

5. Enter the Network Name or IP Address of the SQL Server instance in which the MSP 
Database is hosted, the User Name and Password created according to the Creating 
SQL Login for Asset Reporting process described earlier in this chapter, andthe MSP 
database name (usually MSP), as shown in Figure 37 below. 

 

Figure 37 – Connection Information 

6. MSP Asset Inventory information can then be selected and included into a Report. 
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